
EM 1002
Hydrography multibeam echo sounder
Base version

 Operator manual





EM 1002
Multibeam echo sounder

Operator manual -- Base version

850--160977 / AA000 / 2--52



Note

Kongsberg Maritime AS makes every effort to ensure that the information contained within
this document is correct. However, our equipment is continuously being improved and
updated, so we cannot assume liability for any errors which may occur.

Warning

The equipment to which this manual applies must only be used for the purpose for which
it was designed. Improper use or maintenance may cause damage to the equipment or injury
to personnel. The user must be familiar with the contents of the appropriate manuals before
attempting to install, operate or maintain the equipment.

Kongsberg Maritime AS disclaims any responsibility for damage or injury caused by
improper installation, use or maintenance of the equipment.

Copyright

E 2002 Kongsberg Maritime AS

The information contained within this document remains the sole property of Kongsberg
Maritime AS. No part of this document may be copied or reproduced in any form or by any
means, and the information contained within is not to be communicated to a third party,
without the prior written consent of Kongsberg Maritime AS.

Contact information

Support: hydrographic.support@kongsberg.com

Sales: subsea@kongsberg.com

24 hrs support telephone: +47 99 20 38 01

Strandpromenaden 50
P.O.Box 111
N-3191 Horten,
Norway
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Remarks

References
Further information about the EM 1002 system may be found in the following manuals:

• EM 1002 Installation manual

• EM 1002 Maintenance manual

• Hull Unit Instruction manual

The reader
This operator manual is intended to be used by the system operator. He/she should be
experienced in the operation of positioning systems, or should have attended a Kongsberg 
Maritime training course.
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1 SYSTEM DESCRIPTION

1.1 Overview

The Kongsberg Simrad EM 1002 multibeam echo sounder is
designed for high resolution seabed mapping from the shoreline
and down to a depth of approximately 1000 m. The system is easy
to install, even on small vessels. The EM 1002 has an accuracy
surpassing the IHO standard, including the most stringent of the
latest version, 4th edition.

The EM 1002 uses the same transducer as the previous EM 1000,
but new and more compact electronics and new software allows a
higher pingrate, almost twice the number of beams per ping with
narrower beamwidth, higher accuracy, and a much improved
operator interface.

The EM 1002 system has a maximum ping rate of more than
10 Hz, a large number of measurements per ping with 111 beams,
2° beamwidth, and electronic roll stabilization. Mechanical pitch
compensation is available with an optional hull unit. Acrosstrack
coverage is up to about 1200 m in deeper waters, and in shallow
waters up to 10 times depth beneath the transducer. The angular
coverage is fully adjustable, and for surveying to the water surface
along shorelines, river banks and man-made structures, the angular
coverage to one or both sides may be increased to 5° above the
horizontal.

The standard EM 1002 system has three different pulselengths
(0.2, 0.7 and 2 ms) to maximize coverage in deeper waters, say
more than 200 m. A shallow water version, the EM 1002S, which
is identical to the standard system except for having only the
shortest pulselength, is a cost-effective alternative to users who do
not need the deep water capability. The EM 1002S is usable to
more than 600 m water depth, but acrosstrack coverage is limited
to about 1000 m and will typically be less than half that of the
standard EM 1002 for depths larger than 300 m. The EM 1002S
may be upgraded to an EM 1002 if required.

The system’s nominal sonar frequency is 95 kHz. This frequency
allows for small dimensions, good range capability and high
tolerance to turbid waters. Integrated seabed acoustical imaging
capability (sidescan) is included as standard. A combination of
phase and amplitude detection is used, resulting in a measurement
accuracy practically independent of beam pointing angle.
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The EM 1002 is a complete system with all necessary sensor
interfaces, real-time compensation for vessel motion and
raybending, data displays for quality control including sensor
calibration, and data logging included as standard.

Postprocessing software is available for both for bathymetry and
seabed classification. A worldwide marketing and service
organization having many years of multibeam experience is
available for supporting the EM 1002
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Figure 1 - EM 1002 system diagram
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1.2 System units

Overview
The Kongsberg Simrad EM 1002 multibeam echo sounder consists
of these main units:
• Transducer Array
• Transceiver Unit
• Operator Station
• Hull Unit (optional)
→ The EM 1002 system units are shown on page 3.
→ The EM 1002 hull unit system units are shown on page 4.

Transducer array
The EM 1002 Transducer Array is used both for transmit and
receive. It is semicircular with a radius of 45 cm and 160° angular
extent and its weight in water is about 90 kg. Eight 20 m long
underwater cables connect the transducer to the Transceiver Unit.
The cables are fitted with connectors on the dry-end side, these
plug in on the Transceiver Unit.

Transceiver Unit
The EM 1002 Transceiver Unit contains the transmit and receive
electronics and processors for beamforming, bottom detection,
and control of all parameters with respect to gain, ping rate and
transmit angles. It has serial interfaces for all time-critical external
sensors such as vessel attitude (roll, pitch, heading and heave),
vessel position, and external clock. The Transceiver Unit is a wall
mounted cabinet with integrated shock and vibration absorbers.
An Ethernet cable connects the Transceiver Unit to the Operator
Station.

Operator Station
The Operator Station is a high-performance workstation. It
contains the operator interface, displays the collected data, and
logs them to disk and tape.

Hull Unit
The EM 1002 Hull Unit is a electromechanical device designed to
physically lower the transducer array from a safe storage position
down into the water. The array may be lowered to a maximum
depth of 82 centimeters under its storage position within the hull.
The Hull Unit will also mechanically stabilize the transducer array
to compensate for the vessel’s pitch movements during the survey.
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2 OPERATIONAL PROCEDURES

2.1 Introduction
This chapter presents the most important operational procedures
required to operate the Kongsberg Simrad EM 1002 multibeam
echo sounder.

The EM 1002 is operated in on-line or off-line mode.

• The on-line mode is used during the survey. The applications
are then used to control the multibeam echo sounder, to store the
data, and to present various views of the data for quality
assurance. The on-line applications are started from the EM
1002 Launchpad.

• The off-line mode is used after the survey has been completed,
and the data is stored on disk or tape. The applications are then
used to view the results of the survey.

The standard EM 1002 applications will generate a full
documentation of the survey results, and will provide output for
survey statistics, contour charts, illuminated plots etc. For some
purposes this may be sufficient, but normally the post-processing
packages available are used for data cleaning, image processing
and final chart production.

The following main operational functions are described in this
chapter:

→ Starting the EM 1002 system: page 8

→ Preparing the system for use: page 9

→ Running a survey: page 18

→ Closing down the EM 1002 system: page 22

This chapter also presents a general description of the desktop
operational environment, and - in addition - the following special
subjects are described:

→ Main Survey Display functions: page 55

→ System selftest: page 62

Operational procedures for the various additional utilities are not
found in this chapter. Refer to the applicable utility descriptions
further back in the book.
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2.2 Operational summary
To start the EM 1002 system, follow this procedure:

1 Power up the system.

→ Refer to page 8.

2 Log in.

→ Refer to page 8.

3 Start the EM 1002 application.

→ Refer to page 9.

4 Check the installation parameters.

→ Refer to page 11 for clock adjustment and/or
synchronization.

→ Refer to page 11 to check the water level setting.

5 Check the runtime parameters.

→ Refer to page 12 for sound speed profile selection.

→ Refer to page 116 to check and/or define maximum and
minimum depth.

6 Start pinging.

→ Refer to page 14.

7 Check the sensor functions and data.

→ Refer to page 14.

8 Check the local depth and the main echo sounder functions
using the Ping and Survey Displays.

→ Refer to page 14.

9 Enter the survey parameters.

→ Refer to page 15.

10 Optionally; perform a system calibration.

11 Optionally; define or retrieve the planned job.

→ Refer to page 18.

12 Measure sound speed profile at appropriate position in
survey area.

13 Move the vessel to the start of the first survey line.

14 Start logging.

→ Refer to page 18.

15 Run the survey.

16 Save the collected data.

17 Power down.
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2.3 Starting the EM 1002

Power on
To switch power on, follow this procedure:

1 Switch on the power on the EM 1002 Processing Unit.
- It has an on/off switch on the front panel.
- The load process takes a few minutes, and will not be

terminated until approximately two minutes after you
have powered up the Operator Station. When finished, the
unit presents an audible “beep”.

2 Power up the Operator Station peripherals.
- Your system includes a number of peripheral devices.

Consult the applicable manufacturer’s documentation.
3 Power up the EM 1002 Operator Station.

Software initialization
The operating system in the EM 1002 Operator Station loads
automatically. When the boot process is finished, the display
presents the log-in dialogue box:

Welcome to [host name]

1 Enter your user name: em1002

2 Press <Enter>.

When this log-in is completed, the system presents the EM 1002
log-in dialogue box:

Welcome em1002

3 Enter your password: simrad0

4 Press <Enter>.
- The system initiates the Common Desktop

Environment (CDE), and the following information is
presented:
• Icon dialogue box

• Common Desktop Environment (CDE) dialogue box
- These dialogue boxes are all standard applications

provided with the Unix operating system.
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- You are now ready to start the EM 1002 software.
5 Place the cursor in the background part of the display image.

6 Press the middle mouse button.
- A small menu is displayed on the screen. This menu

allows you to start the on-line applications (EM 1002)
and/or the off-line applications, such as Merlin or
Neptune.

7 Select Start Operator Interface on the menu.
- The following applications and dialogue boxes are

automatically started:
• Launchpad

• Ping Display

• Runtime Menu

• Survey Display
- Note that the dialogue boxes appear in different

workspaces. You can select either one of these on the
Launchpad, or in the CDE dialogue box.

Launchpad introduction
The EM 1002 Launchpad is the control dialogue box for the EM
1002 on-line operations. This utility provides realtime monitoring
of the storage capacity, sounder parameters and sensor status. It
also contains buttons to start and stop the echo sounder and the
logging, as well as controls to select the active workspace. The
icons are used to activate the other applications provided for the
EM 1002 on-line operations, while the bottom field identifies the
operator and the current survey.

→ The EM 1002 Launchpad is described in detail on page 65.

2.4 Planning and calibration

Survey plan
As a general rule, the survey should be properly planned. The plan
can be based upon a chart where the planned survey lines are
plotted. General knowledge about the bottom conditions may be
useful.

→ Survey planning is described in more detail on page 60.

When the EM 1002 system was installed, the physical locations of
sensors and peripherals were defined, and the appropriate settings
were made to the EM 1002. These settings include:



EM 1002 / Base version

10 850-160977/E

Figure 3 - EM 1002 Launchpad overview
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Figure 4 - The EM1200 Launchpad overview

• Physical location of the transducer array and the sensors

• Serial lines set-up

• Offset definitions

If any of these settings have changed, the system parameters must
be adjusted accordingly before the survey starts.

→ This hardware set-up is described on page 24.

Calibration

To ensure maximum reliability and accuracy from the system, the
EM 1002 and externally connected sensors should be calibrated
before the start of a new survey.

→ A calibration procedure is described on page 254.
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2.5 Installation and runtime parameters
This section discusses parameters that may need changes from
survey to survey. It is recommended that the installation
parameters are always checked. A list of these parameters and
settings should be kept in a safe and accessible place.

Installation parameters
→ A description of how to access installation parameters is on page

24.

Adjustment and synchronization
The system clock can be adjusted to show the same time and date
as an external clock, or the clock from the positioning system. This
is done automatically at the start of the new survey. You can
synchronize the internal system clock with a one pulse per second
(1PPS) signal, normally available from a GPS receiver. This
eliminates any drift of the system clock.

→ See Survey Setup on page 15.

You may - before the survey is identified in the Survey Setup
dialogue box - select the source for the clock adjustment.

1 Locate the Clock field in the installation menu, and select
synchronization from any of these sources:

• External clock

• Operator Station (for manual setting)

• Active Pos. System

2 Select clock offset if required.

3 Press 1 pps Sync to switch on the 1 pulse per second external
clock synchronization.

→ The Clock field on the Installation Menu and the parameters used
are described in detail on page 135.

To check the water level setting
In order to measure the exact depth, the system must know how
deep the transducer array is installed. This is calculated by the
system using the vertical locaton of the waterline and transducer
in the vessel coordinate system. The latter is fixed at installation.,
while the waterline changes.

The water line value may vary depending on vessel type, fuel
consumption and other factors caused by the ship design and
handling. Recalculate and modify the value as often as required.
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1 Open the Installation Menu dialogue box.

2 Locate the Sensor Location field, and check the Water Line
value. Modify if required.

3 Close the Installation Menu dialogue box.

Sound speed profile retrieval
In order to ensure accurate data, you must know the sound speed
profile in the survey area. This data is either retrieved with a
dedicated sensor, or downloaded from an external computer
system. In both cases, the information must be loaded into the EM
1002 Operator Station.
→ How to load a sound speed profile is described in Interfaces on

page 149.

The sound speed profile may change with both time and position
in the survey area. It may therefore be necessary to measure the
profile several times during the survey.

The Sound Velocity Profile Editor has been included with the EM
1002 to edit existing profiles or to create new.

→ The Sound Speed Profile Editor is described on page 321.

To activate the chosen sound speed profile, perform the following
procedure:

1 Locate the Runtime Menu dialogue box on the desktop.
- The default location for this dialogue box is in workspace

4. The dialogue box was automatically opened when the
EM 1002 was switched on.

2 Locate the Sound Speed field in the Runtime Menu where
the current sound speed profile is shown.

→ The Sound Speed field is described on page 117.

3 Make the appropriate choices to retrieve the sound speed
value from the transducer. We recommend that you use the
From Profile setting, at least with a horizontally mounted
Sonar Head.
- Select From Sensor if your vessel has a sound speed

sensor mounted near the Sonar Head. The offset (if any)
must then be defined with the Sound Speed Offset glider.

4 Click on the name to activate a profile from the selection on
the disk.

5 Select Sound Speed at Transducer depth from the following
choices:

√ From profile
√ From sensor
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√ Manual

Maximum and minimum depth
When you start the “pinging”, you may have to guide the echo
sounder to find the correct depth.

1 Consult the available charts, or use a small depth sounder to
locate the approximate depth.

2 Locate the Runtime Menu dialogue box on the desktop.
- The default location for this dialogue box is in workspace

4. The dialogue box was automatically opened when the
EM 1002 was switched on.

3 Locate the Sounder Main field where the minimum and
maximum depths are entered.

4 Enter the two depths to create a “depth window” wide
enough for the EM 1002 to track correctly.

→ The maximum and minimum depth settings are described on page
116.

Check runtime parameters
The system runtime settings will in most cases be the same as for
the previous survey, and the definitions are then stored. However,
to ensure that everything is set up correctly, we advice you to check
that all the settings in the Runtime Menu dialogue box are in
accordance with what you want.

The settings shown here are the default choices for a typical
system.

1 Locate the Runtime Menu dialogue box on the desktop.
- The default location for this dialogue box is in workspace

4. The dialogue box was automatically opened when the
EM 1002 was switched on.

2 Check the parameter settings. The following settings are
typical:

√ Minimum depth: <set to match local conditions>

√ Maximum depth: <set to match local conditions>
√ Angles,

port and starboard:<set to match local conditions>
√ Ping mode: Auto

Note: The minimum and maximum depths are important! Wrong settings
may inhibit the system from working if the bottom depths are
outside the defined window.
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→ Detailed descriptions of the settings are provided on page 113.

Test menu settings

Check to see that manual control parameters are set in accordance
with what you want.

Note: It is especially important to make sure that the tracking is set to
Range & Gain!

2.6 To start “pinging”

Start the echo sounder
The “pinging” is started first in this process.

1 On the EM 1002 Launchpad: press the Start button.
- The echo sounder will now start transmitting.

Check the external sensors
Proper operation of the external sensors are vital for the EM 1002
operation.

1 Check that the system’s external sensors are switched on.

2 Press the Sensors... button on the EM 1002 Launchpad to
access the Status Display for the sensors.

3 Check the sensor status.
- Green indicator flags must be present for all active and

operational sensors.
→ Refer to page 108 for a description of the Status Display’s sensor

presentation.

Check the basic operation
Before you start logging, you are adviced to make sure that the EM
1002 system has locked on the bottom, and that the beam coverage
appear as expected. This is easily checked with the Ping Display
utility, which was started automatically when you switched the EM
1002 on.

The Ping Display presents a real-time view of the system
performance during on-line operation. The display shows the raw
data from the system after corrections have been applied for vessel
attitude and sound speed.
→ The Ping Display is described on page 162.

If you have accidentally stopped the utility during the session, you
can restart the Ping Display from the icon on the EM 1002
Launchpad.



Operational procedures

15850-160977/E

1 Check the Ping Display window for proper operation:
- Check the Waterfall chart for a continous bottom.
- Check the Crosstrack chart to see the depths for all the

beams ping for ping.
- Check the Beam Intensity chart for a reasonable

backscattering strengths for each individual beam

→ Additional operational procedures for the Ping Display are found
on page 169.

2 Check the Survey Display for proper positioning of the
soundings..

→ Consult the Survey Display chapter for further information, refer
to page 188.

Identifying survey and operator names

In order to start a new survey or to continue an existing job, you
must identify the survey parameters. This is done on the
Launchpad.

To define the survey name, click on the small triangle on the right
side of the name field. A list of the existing survey names appear.
Select the survey you wish to work with, or click <New survey>
if you wish to establish a new job.

When you select <New survey>, the Survey Setup dialogue box
appears. This dialogue box provides three options:

• Survey name: Enter the name of the new survey. You can use
maximum 30 standard alphanumerical characters.

• Comments:

• Clock synchronization: Click to set the EM 1002 clock to the
synchronization source chosen in the Installation Menu.

→ Refer to page 135 for a description of the clock settings.

• Survey Predefined Setups: These entries define the projection
to be used in the systems geographical displays. Further
information about these setup files are provided in the System
administration chapter. in the EM 1002 Maintenance Manual.

To identify yourself as the EM 1002 operator, click on the Line...
button. A Line Setup dialog box appears, with the following data
options:

• Comments,

• Operator name
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Figure 5 - The Survey Set-up dialogue box

→ The Line Setup dialogue box is described in Figure 24 on page 77.

To enter the operator name, click on the small triangle on the
right side of the Operator field. A list of existing operator names
appears, and you can choose your own if it is already there. If
you are a new operator, select <New operator> and enter your
name in the dialogue box provided.

• Line

Line ID

Note: The setting for Line is optional. It will automatically identify the
first line in the survey as number 1 and automatically increase at
line shifts, but you can change this to any number using this field.

• Planned Line ID

This identifier may for example be used to tie line no to any
other line identifier.

To prepare logging
You can log the raw data and survey-data to disk.

1 Select Options on the EM 1002 Launchpad main menu.
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Programs

(CD4362H)

Figure 6 - The Launchpad Programs field

2 Select Logging on the submenu.

3 Select if you wish to log the survey data:
- Survey format to disk
- Note that the Survey format to disk option should

always be enabled. This is necessary to ensure safe
logging and to provide data for the geographical displays.
You should only disable it if you are using other display
software for online quality control than the geographical
displays provided with the EM 1002. Otherwise logging
of survey data should only be disabled if disk space is
critically small.

4 Click the appropriate buttons to define whether seabed
image and/or central beams echogram are to be logged.You
can choose whether to log raw reflectivity data (seabed
image) or central beam echo datagrams.

Note: Logging of seabed image datagrams to disk typically doubles the
need for media space ! Seabed image datagrams are not required
to create depth charts, but may give valuable information
regarding seabed composition.

To export data

Other equipment on the vessel may require information about the
depth below the keel. To provide this data, you can export
datagrams.

1 Select Options on the EM 1002 main menu.

2 Select Datagram subscriptions on the submenu.

3 Define the datagram subscription in accordance with what
type of data you want to be exported and where it is to be sent.

→ The Datagram Subscriptions dialogue box is described in detail
on page 99.
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2.7 Running the survey

To retrieve a planned job
As previously described, a survey should be properly planned
before it is started. The Planning tool in the Survey Display is
available for this use.

→ The Planning tool is described on page 60.

Before the logging starts, you can retrieve a planned job.

1 Locate the Survey Display dialogue box on the desktop.
- The default location for this dialogue box is in workspace

1 (Main). The dialogue box was automatically opened
when the EM 1002 was switched on.

2 Select Planning on the main menu.

3 Select Jobs... on the Planning menu.

4 Select Open... on the submenu, and select the plan for the
current survey.

→ The Planning tool operational procedures are described on page
287. For more detailed information about this utility, refer to
page 285.

To start and stop logging

Alternative 1

During the survey, the vessel navigates along the pre-planned
survey lines. Logging must be started at the beginning of each line.
Stop the logging at the end of each line and start it again at the
beginning of the next

At the start of every survey line:

1 Select Start log on the EM 1002 Launchpad.
- The logging starts.

Figure 7 - Sounder & Logging

Start

Start log

Off

Stop

Sounder & Logging

(CD4362FB)

2 Allow the vessel to navigate along the survey line.
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3 Press Stop when the vessel has reached the end of the line.

4 Allow the vessel to turn.

5 Press Start log when you start the new line

When the final survey line has been completed:

6 Press Stop.

7 Set Sounder Mode to Off whenever appropriate.

Alternative 2

You can also start the logging at beginning of the first line and let
it run continuously, toggling survey line change as appropriately.

At the start of the first survey line:

1 Select Start log on the EM 1002 main menu.
- The logging starts.

2 Press Start log at the beginning of each survey line.
- This assigns a new line number.

When the final survey line has been completed:

3 Press Stop.

To monitor the progress

Status information

The logging and system status is observed in the Launchpad, with
additional data available in the Status display.

1 Press the Sensors... button in the Launchpad to open the
Status Display to view all the status information.

The following is a summary of the status information:

• Online BIST error reports on sensors and Transceiver Unit

• Logging active/not active with current survey name and line
number

• Sensor data values

• Available disk space

Visual quality assurance with the Survey Display

The Kongsberg Simrad EM 1002 echo sounder system includes the
Survey Display application for visual quality control of the
survey.
→ The basic operational procedures for the Survey Display is

presented on page 55. The commands and functions of the Survey
Display software is described in a separate chapter. Refer to page
188.
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File backup, deletion and restore
procedures
Your system may run low on media resources during the survey;
the tape or disk may be filled faster than you planned. When the
system runs low on media resources, the appropriate warnings are
given. The logging stops automatically if certain limits are
exceeded.

Backing Up Raw Data & Survey Format Data

The following applies to both types of files. Selections are made
using the leftmost mouse button.
• 1. Select File Admin... from the File menu in the Launchpad

main window.
• 2. This brings up the File Admin window. Instructions and

messages are issued in the area close to the bottom of the
window.

• 3. Select Raw Data or Survey Format in the File Type menu. A
list of available files (surveys) for the selected file type is
presented in the Files list at the bottom of the window.

• 4. Select one or more surveys from the list. A survey may be
deselected or removed from the list of selected items by
reselecting the item.

• 5. Select the Apply button. This brings up the Confirm
Operation window containing a list of the selected surveys
along with information on what you are about to do.

• 6. Verify the type of operation, type of data and that the total size
of the selected surveys does not exceed available tape space.

• 7. To start backing up, select the OK button. The confirmation
window disappears, and the system starts performing the
backup. Any errors during the initial phase of the backup - like
no tape in the drive, or no tape drive available - will be issued
using a popup error message window.

• 8. When completed, a popup window will appear, listing all
files written to the tape.

Deleting Raw Data & Survey Format Data
The following applies to both types of fills. Selections are made
using the leftmost mouse button.
• 1. Select File Admin... from the File menu in the Launchpad

main window.
• 2. This brings up the File Admin window. Instructions and

messages are issued in the area close to the bottom of the
window.
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• 3. Select Raw Data or Survey Format in the File Type menu. A
list of available files (surveys) for the selected file type is
presented in the Files list at the bottom of the window.

• 4. Select one or more surveys from the list. A survey may be
deselected or removed from the list of selected items by
reselecting the item.

• 5. Select the Apply button. This brings up the Confirm
Operation window containing a list of the selected surveys
along with information on what you are about to do.

• 6. Verify the type of operation and type of data. To delete the
listed files, select the OK button. The confirmation window
disappears and the files are deleted. The deleted files are
removed from the list of available files in the File Admin
window.
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2.8 Closing down the EM 1002

Software

Method 1

Exit the EM 1002 by selectingthe Exit alternative on the File
menu. You will then see a dialogue box in which you can choose
how to close down the system.

→ The Exit dialogue box can be seen in figure 8.

Figure 8 - The Exit dialogue box

The options in the Exit dialogue box are:

Exit Launchpad - closes down the launchpad window.

Exit Launchpad & Logout - closes down the launchpad and logs
out this user.

Exit Launchpad & Power down - closes down the launchpad and
turns off the power. When you turn on the power again, your
windows are the same as before you closed down.

Method 2

This method is different whether you have a SUN or HP machine:

Sun - use the power button on the keyboard to close down the
system. This method equals Exit Launchpad & Power down
described above. The launchpad is closed down and the
configuration is saved.
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HP- use the power button to close down the system. This equals
Exit Launchpad & Logout described above, but in addition the
power is turned off.

Method 3

This method may still be used if you have older machines:

1 Exit all the EM 1002 software applications by selecting File
-> Exit -> Exit Launcpad on the main menu.

2 Remove the tapes.

3 Access the Common Desktop Environment (CDE), and
click on the computer icon to open a terminal window.

4 Enter “su” and press the Return key.

5 Enter password “simrad0” when prompted.

6 Enter “init 5” (Sun Workstation).

7 Log out

Hardware units

Operator Station

The EM 1002 Operator Station is powered down first.

1 Locate the unit’s mains switch, and switch off.

2 Switch off all the peripherals.

Tranciever Unit

1 Open the door on the EM 1002 Tranciever Unit, and switch
power off, or use the remote power switch.
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2.9 Initial setup

Software updates
The EM 1002 is initially supplied with all the software installed.
However, new software versions may become available as
updates, and these will usually be shipped on CD ROM.

The necessary instruction required to update the EM 1002 software
is included on the CD ROM. This applies for all EM 1002 units.

To access the basic installation
parameters
In order to ensure maximum accuracy when operating the EM
1002 system, it is very important to define the hardware
installation parameters. These include:

• Definition of serial interfaces

• Definition of offset values

Note: These hardware settings are typically done only once after the
system installation. However, it may be necessary to repeat the
settings if sensors are replaced.

The EM 1002 installation hardware settings are accessed on the
Installation Menu window. The following procedure applies to
access this window:

1 Locate the Runtime Menu window.
- This window is by default located in workspace 4. It is

automatically opened once the EM 1002 system is
switched on.

- If you have closed the Runtime Menu menu earlier in the
session, you can re-open it by clicking on the icon on the
Launchpad.

2 Select Show... on the main menu, and then Installation
Parameters.
- The Installation Menu window opens. This window

allows you to modify all the hardware parameters.
→ The parameters in this window is explained in detail on

page 124.

3 Select Edit on the pull-down menu in the Installation Menu
window, and the Edit enable.

4 Enter the current password.
- The password defined by Kongsberg Simrad on delivery

is em1002. Note that the password entry is case sensitive.
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5 Click OK.

Password:

Password Entry:

OK Modify Cancel

(C
d4

47
3)

Figure 9 - The Password window

Once the password is entered, you are free to modify the
installation parameters.

Caution: The installation parameters should normally not be tampered with.
Unauthorized and erroneous modifications may degrade the
accuracy of the survey results.

To change the password
You can change the password that protects the EM 1002
installation parameters.

1 Access the Installation menu.

2 Select Edit on the main menu, and then Edit enable.

3 Click in the password field, and enter the current password.

4 Select Modify
5 Enter the new password in the appropriate field in the

appearing dialogue box.
6 Press Ok.

To define the locations of the sensors
→ The sensor measurement procedure is described in the EM 1002

Installation Manual.

1 Access the Installation menu.
→ The Parameter fields are described in detail on page 136.

2 For each of the positioning systems, enter the measured
values for forward, starboard and downward position
relative to the coordinate system (as required).
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- The sensors may be programmed to calculate data for
another place than the physical location of the sensor. It
is the “virtual” location coordinates that must be entered
in the installation menu.

3 For the motion sensor, enter the values for forward,
starboard and downward position relative to the coordinate
system.
- The sensors may be programmed to calculate data for

another place than the physical location of the sensor. It
is the “virtual” location coordinates that must be entered
in the installation menu.

4 For each of the transducer arrays, enter the measured values
for forward, starboard and downward position relative to the
coordinate system.

5 Enter the correct and updated vertical location value for the
water line. This value must be measured at the physical
alongship location of the motion sensor when roll is zero.
→ Refer to page 11 for further information about the water

line setting.

To define the position delay
The accuracy of the position sensor is vital for the EM 1002 data
accuracy, and it is therefore important that the relative timing of
vessel position data and system depth data is correct. To define the
“age” of the positioning system input data, you can enter a position
delay.

1 Access the Installation menu.
- A dedicated field is available to define the position delay.
→ The parameter fields for the Position delay are described in

detail on page 130.

2 Define which positioning system you wish to modify.
→ This is explained on page 129.

3 Set the Position Delay for the selected system.
→ The correct Position Delay is found by running a Calibration,

described on page 254.

To define the motion sensor delay
As with the position sensor, the information from the motion
sensor is important for the system accuracy. The timing must thus
be correct, and to define the “age” of the motion information, you
can enter a sensor delay.

1 Access the Installation menu.
- A dedicated field is available to define the position delay.
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→ The parameter fields are described in detail on page 130.

2 Set the Delay as appropriate. The value should normally be
in accordance with manufacture recommendations.

To define sensor offsets
It may be necessary to define fixed offsets to the data from the
attitude and heading sensors.

To define the Transceiver Unit interfaces
The EM 1002 Transceiver Unit is equipped with four serial lines,
which must be set up in accordance with the actual interfaces and
data formats required.

1 Access the Installation menu.
- A dedicated field is available with all the necessary

parameters.
→ Access to the Installation Menu is described on page 24.

Refer to page 132 (Motion Sensor) and page 134 (Heading
Sensor) for further details.

2 Select which serial port you wish to modify.

3 Define the input data source and the parameters for the
specified serial line.
- Certain limitations apply to which sensor that can be

connected to which serial line.
→ This is described on page 126.

To define the Operator Station interfaces
The EM 1002 Operator Station is equipped with at least two serial
interfaces. These are normally set up to receive data from the EM
1002 sound speed probe located at the transducer’s depth, a sound
speed profile from an external computer or tide data input. One of
the serial lines can also be used to export depth and autopilot
steering datagrams.

1 Press the I/O Interfaces icon on the EM 1002 Launchpad.
- The I/O Interfaces dialogue box appears.

→ Further information about the parameters may be found on page
149.

To set the clock
The EM 1002 system requires accurate timing, and all data from
the survey is time tagged. If you wish to modify the clock settings
you must do so before you define the survey.
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Note: This is the clock in the EM 1002 Processing Unit and not the clock
on the Operator Station.

1 Access the Installation menu.
- A dedicated field is available with all the necessary

parameters.
→ Access to the Installation Menu is described on page 24.

The parameters are explained in detail on page 135.

2 Select the source of your clock.

3 Define the clock offset (if required).

4 Enable the 1PPS if desired.
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2.10 Unix, Motif and CDE information

Introduction
This chapter is intended for those not familiar with the UNIX
operational environment.

The Operator Station used for the Kongsberg Simrad EM 1002 is
a UNIX Workstation. It uses basic commercial software tools
following industrial standards. These include a MotifTM- compliant
windowing system and the Common Desktop Environment
(CDE).

A number of common functions regarding window and mouse
operation are described in this chapter.

Note: Normal system operation does not require further knowledge about
Unix.
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Mouse and window operations

Introduction

The following is a description of the MotifTM window system, and
how you can interact with it. The items discussed here are of a
general nature, and apply to all of the Kongsberg Simrad EM 1002
applications.

Details can be found in the following publications:

• OSF/Motif User’s Guide

• OSF/Motif Style Guide (Prentice-Hall Inc, 1990)

Mouse operation

The mouse used in Motif applications has three mouse buttons.
These are identified as:

• left
• middle
• right

The left mouse button is the most frequently used button, and the
default button in all descriptions. If a procedure does not specify
which mouse button to use, use the left.

The following terms are used:

Pointer - The small pictograph, usually formed as an arrow, which
you control through the mouse movements. A cross-hair pointer is
often used for digitizing and positioning purposes. A watch is
displayed when you must wait while the system is working.

Click - Press and release a mouse button.

Double click - Two clicks on a mouse button in rapid succession.

Drag - Press and hold down a mouse button, then move the pointer.
This will cause various things to happen, depending on which
mouse button is used, what the mouse pointer was pointing at
initially, and the current command sequence.

More detailed information on the use of mouse and pointer can be
found under the descriptions of the different menus and windows
in the applications.

Window terminology

A window is a rectangular area of the screen, shown in the figure
below, containing all, or some of the following elements:

Frame - The border around the window comprising two thin lines
parallel to each other and only a millimetre or two apart. It is used
to change the size of the window by mouse operations.
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Window menu button

Scroll bar and Slider

Menu bar Title bar

Client area

Minimize and Maximize buttons

(CD3388)

Title bar

F E O Wile    dit    ptions   indow

Figure 10 - A Motif Window (example)

Title bar - The horizontal bar along and below the upper window
frame containing a text; usually the title of the program represented
by the window.

Window menu button - A horizontal bar inside a small square in
the upper left corner of the window. One click on this button
displays a menu for window manipulation.

Note: Be aware that a double click on this button kills the window and all
processes connected to it. This may cause administration files not
to be updated, and should consequently be avoided.

Minimize button - A small button in the upper right corner of the
window containing a small square. It is used to transform the
window to a small icon.

Maximize button - A small button containing a square in the upper
right corner of the window which toggles the window from normal
size to full screen size and back again.

Menu bar - This is a horizontal bar below the title bar containing
the main menu connected to the window. Each of the menu items
will, when selected, display a pull-down menu where further
alternatives are presented.

Drop down menu - When a command on the main menu bar is
selected it will normally extend downwards in the vertical
direction to a vertical menu. Choices made inside this menu may
then be extended to left or right for additional choices.
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Active window - At any time, the window on the screen which
contains the mouse pointer, is defined as the active window. It is
recognised by having a highlighted frame and title bar. Any
keyboard input is assigned to this window.

The active window will not necessarily be displayed on the top of
the window stack. It may be partly hidden by other windows. To
lift a window to the top of the window stack, click on its frame.

Scroll bar - A graphical device used to change a user’s view of the
contents of a window. A scroll bar consists of a slider and two scroll
arrows. You can change the view by moving the slider up or down
in the scroll area or by pressing one of the scroll arrows. These
actions cause the view to scroll up or down in the window adjacent
to the scroll bar.

Client area - The area within the borders of a window’s frame that
is controlled by an application. In most EM 1002 applications, this
area may also be referred to as the Survey area or Geographical
area.

Window menu

When you click on the window menu button a small menu appears.
The same menu appears if you click on the window when it has
been minimized to an icon.
→ Refer to figure 10 for an example.

The following choices are available:

Restore - Use this option when your window has been minimized
to an icon. The choice will restore the window to the same size it
hade before it was minimized. The function will also restore the
window size after you have used the Maximize option.

Size - Use this option to change the size of the window. Click to
select, and pull the window frames out or in in any direction. The
next click sets the current window size.

Minimize - Use this option to reduce the window to an icon. The
icon is placed in the Icons window on the desktop.

Maximize - Use this option to expand the window to cover the
entire display.

Lower - Use this option to move the window behind all the other
windows on the workspace.

Occupy workspaces - Use this option to move the window to any
of the four workspaces available on the desktop. A small meny
allows you to choose.

Occupy all workspaces - Use this option to copy the window to
appear on all of the four workspaces available on the desktop.
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Unoccupy workspace - Use this option to delete the window from
the current workspace.
Close - Use this option to close the window. Note that some
applications may have disabled this function.

Window manipulation
The windows can be manipulated in several different ways to suit
your needs and personal preferences.

To minimize a window
You may minimize a window. The window will then be
transformed to a small icon, but will continue to run the process(es)
connected to it. To minimize a window, use either of the following
methods:
• Click on the minimize button in the upper right corner of the

window using the left mouse button.
• Select Minimize from the window menu.

To restore a minimized window from an icon
Use either of the following methods:
• Double click on the icon.
• Click on icon, then select the Restore option from the resulting

pop-up menu.

To maximize a window
A maximized window will fill the whole screen. All other windows
will be hidden behind it. To maximize a window, use either of the
following methods:
• Click on the Maximize button in the upper right corner of the

window.
• Select Maximize from the window menu.

To restore a maximized window
Click on the Maximize button in the upper right corner of the
window. This button toggles the window from normal size to full
screen size and back again.

To move the window
To move the window on the screen, without changing its size, put
the mouse pointer on the title bar and drag the window to another
position.

To change the window size
The window frames can be used for resizing the window. This is
achieved by dragging the appropriate side frame to a new position.
Dragging the corners will resize the window in two directions
simultaneously.



EM 1002 / Base version

34 850-160977/E

Switch area pop-up menus

The Switch area is the background screen where the background
pattern is not covered by any window. Clicking a mouse button
while the mouse pointer is in this area, activates any of three
pop-up menus, depending on which mouse button you click.

Left mouse button - The pop-up menu activated by the left mouse
button operates the windows system. Contained here are
commands for creating a new terminal window, refreshing the
screen, restarting the window manager and exiting from the
window system.

Middle mouse button - The middle mouse button activates the
menu to start up the Kongsberg Simrad applications.

Right mouse button - The right mouse button activates utility
software to extract screen or window dumps to a file on the home
directory, or to a system printer. The functions may be customized
to handle special printer set-ups.

Special keyboard functions

The Delete key on the keyboard is used to delete characters to the
right of the cursor, while Backspace is used to delete characters to
the left of the cursor.

Dialogue boxes

Overview

The various dialogue boxes may contain various standard graphic
components used to control the applications. These components
are mostly formed as buttons having different visual appearance
giving a clue to how they work. The various types of buttons
include:

• Push buttons
• Option buttons
• Toggle buttons
• Check buttons
• Radio buttons

The buttons are operated and the boxes selected by placing the
pointer within the desired area and clicking the left mouse button.
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Other controls are:

• Text fields
• Lists
• File

selection boxes.

The following types are used by the Kongsberg Simrad EM 1002
software.

Option button

This is a special type of push button containing a small rectangle
on the right hand side. When pressed, a limited set of options will
be displayed.

You may press the button, then drag the pointer down to the desired
option in the list before releasing the mouse pointer. The selected
option will then be displayed as text on the button.

Toggle button

This is a button formed as a square, and followed to the right by a
short descriptive text. When pressed, it will toggle between a set
and a not-set state. The set state is indicated by displaying the
button as depressed.

Check button

This button is formed as a small square, and is similar to the toggle
button, as it is used to toggle between a set and a non-set state. The
set state is indicated by a small check-mark inside the square, or by
the square having a special colour. Check buttons often comes in
groups where the buttons are used to independently set or reset
related options.

Radio button

A graphic component that looks and works like the frequency band
selector buttons on an old-fashioned car radio. The buttons are
found in groups of two or more, where they represent mutually
exclusive options. Clicking one of the buttons will select the
corresponding alternative, and de-select the other button(s) in the
group. This type of button appears as a small diamond or a circle.

Text field

These fields are rectangles containing text that you can change.
The text will represent parameters or other information that will be
used by the application.

List box

A component that provides you with a list of options from which
you can choose.
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File selection box

Whenever a file is selected for reading or writing, a file selection
box will be displayed.

“Tear-off” menus

The Tear-off menus are indicated by their perforation look-alike
line at the top of the pull-down menu.

Such menus can be removed from their original positions by
clicking with the mouse pointer on the upper side of the perforation
line. The menu will then establish itself as a separate window
which may be moved to another position and stay on the screen as
long as you wish. This speeds up access to the menu items. The
window can be closed by the window menu.
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Common Desktop Environment (CDE)

Front panel

The Common Desktop Environment (CDE) supplies you with
tools and commands to organize and navigate among the active
programs. The central facility in this environment is the Front
panel (of which a part is shown below) which is usually situated
along the lower edge of the screen. It is meant to function as a
“dashboard” through which you can do window administration,
launch programs, and so on.

Figure 11 - Central part of the front panel with workspace switching buttons. (example)

Virtual workspace

The screen together with all the windows and icons that exist on it
at a particular moment is called a workspace. The CDE support the
concept of a virtual workspace where windows and icons are
defined, but not actually visible on the screen at all times. Several
such virtual workspaces may exist simultaneously giving you a
wider total area in which you may organize your windows or
displays.

You may switch between the virtual workspaces by pressing a
button on the front panel. Each workspace has its own button. The
front panel remains visible through all workspaces.

Each window may individually be allocated to all or some of the
workspaces. This is done through the window menu button on the
window in question. Click on this button and select the Occupy
Workspace menu command. A dialogue box will then appear
containing a list of the available workspaces. Click on the
workspace in which you want the window to appear. To select
multiple workspaces, hold down the Control key while selecting
additional workspaces. Click on a selected workspace to un-select
it.

To place the window in every workspace, click on the All
Workspaces button.

Note that windows allocated to more than one workspace, may not
be moved or re-sized independently of the copies in other
workspaces. Any such operation will immediately affect all the
other workspaces where the window is present.
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When operating the EM 1002 system, you can also choose between
the workspaces on the Launchpad.
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2.11 Common Kongsberg Simrad functions

Introduction
The following paragraphs describe a number of common functions
and dialogue boxes used throughout the Kongsberg Simrad EM
1002 applications.

The following subjects are covered:

• Geographical areas

→ Please refer to page 40

• Opening and saving files

→ Refer to page 41.

• The Tool bar

→ Refer to page 48.

• Common view procedures

→ Refer to page 50.

• Special mouse operations

→ Refer to page 52.
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Geographical areas
A “geographical area” is a window where the client area represents
a geographical area. This area is used to display maps, survey lines,
and so on. Throughout the EM 1002 documentation these windows
are also referred to as “survey area” or “client area”.

These areas have a number of common features:

• A menu bar along the top

- This is often referred to as the main menu. It contains a
number of menu options, and although the options differ
between the applications, menu items like “File”, “Edit”,
“View”, “Options”, “Processing” and “Help” are fairly
common.

• A column of function buttons on the left hand side

- This is the tool bar. It contains a number of buttons for undo,
zooming and scaling.
→ Refer to page 48 for a description of the Tool Bar.

• Two text fields along the bottom of the window

- These are often referred to as the information bar. They show
the current scaling factor for the geographical area (the left
text field), and auxiliary information obtained by mouse
button operations (the right text field).

The geographical area may contain echo sounder data in various
forms.

In addition, user-defined objects called segments may be found.
These includes survey lines and rectangular areas used to define
regions to be displayed in other geographical windows.
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File

Overview

This window appears whenever it is required to open a new file or
save an existing file. It provides a list of all the available files in the
current directory, and allows you to move up and down the
directory structure. You can also define filters to narrow down the
list of files.

File selection

Figure 12 - The File selection dialogue box

A standard dialogue box is used. The box may be re-sized to
display the list more clearly, and the scroll bars may be used to
browse through the file name selection.

Filter

This text box is used to define directory and/or filename filters in
order to specify profile listings for specific file names.

You can for example reduce the selection to a named directory and
sound velocity profiles with extensions ending on *.svp, or depth
files with extensions ending on *.depth.
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The following wildcard characters are accepted:

* (representing any sequence of characters)

? (representing any single character).

The files conforming to the filter are shown in the list box to the
right. The filter is activated by pressing Enter on the keyboard or
by clicking on the Filter button at the bottom of the dialogue box.

Directories

This box displays the current directories. Double-click on a
directory name to jump further down in the directory structure. To
move “up” in the directory structure, double-click on the directory
name with the “/..” ending.

Files

This box lists the available files in the current directory. The listing
may be limited if a filter has been defined.

Selection

This box is used for direct entry of requested file name, or to define
a filter to narrow down the list of files.

Acceptance

OK - Press this button to accept the choices made. The dialogue
box will close.

Filter - Press this button to regenerate the file list using the
currently selected filter.

Cancel - Press this button to escape from the current operation. No
actions will be made, and the file selection box will be closed.

Help - Press this button to access the on-line help.
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Plot

Overview

Selecting this common command brings up two dialogue boxes,
one after the other.

• In the first dialogue box you select the area to print, the scale and
the geographical projection.

• In the second dialogue box, you select output format and
medium.

First dialogue box

Figure 13 - The first Print dialogue box

Region

This selection defines which area to print or plot.

If Entire is selected, the whole survey area will be printed, also that
part which is not currently visible to you. This is the same area that
can be seen if the reset (R) button on the left side of the main
window is pressed.
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If View is selected, only the part of the survey area currently visible
in the window will be printed.

Scale

This command is used to set the scaling method used for the plot.

Optimize to media will set the scale so that the full paper area will
be used for the plot. The scale factor might then be unfamiliar (for
example 1:3749), but the plotting media will be used with the best
resolution available.

The Best nice value option will use a “nice” scale value that just
brings the plot inside the available paper area. These scale values
are typically 1:1000, 1:2000, 1:2500 etc.

Projection

This list of possible projection methods allows you to select the
way the printout will be presented. The projection methods are
standard formats generally known to surveyors and map designers.

Origin

These manual settings are used to set parameters required for some
of the projections. For example, the Universal Transverse
Mercator (UTM) will need the longitude value used to calculate
the UTM zone.

Enter the longitude and latitude on the following formats:

E103 40 55.6
N 13 35.618

Reference

These settings are also used for parameters required by specific
printouts. For example, the Mercator projection needs a true scale
longitude which can be set in the longitude field.

Acceptance

OK - Press the OK button to close the current dialogue box and
bring up the second box.

Cancel - Use this button to close the dialogue box without doing
any printing. No second dialogue box will appear.
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Second dialogue box

→ The second print dialogue box is shown in figure 14.

Figure 14 - The second Print dialogue box

Format

This command is used to select the printer format.

• Postscript level 1: For PostScript black/white printers

• Postscript level 2: For colour PostScript plots

• Raster: For raster plotters

• HPGL: For plotters accepting the Hewlett PackardE (HP)
interface language.

Raster images can also be generated on a ppm format. If you want
to convert to another format, you must pipe the output into a filter
that can do the proper conversion.

Output

These settings allow you to decide on how to handle the output (i.e.
the generated printer commands).
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Selecting File will result in a print file containing the printer
commands. The file name must be defined in the text input field
below the radio buttons. You must then take manual action for
further operations on the file.

If the Command option is selected, the output is piped directly into
a UNIX command. The command must be entered into the text
input field below the radio buttons. This way of sending the output
to the printer is used when the printing device is available, and no
print file is wanted. The lp Unix command will send the plot to the
system’s default printer.

The default command value is:

lp --o nobanner --d ColRasPrinter

where:

• lp = print to default printer

• --o nobanner = print without banner page

• --d ColRasPrinter = currently selected printer device, where
“ColRasPrinter” is the network or local name of the printer.

Note: No printer output file will be generated unless you set this
command up properly.

The Command alternative is also useful for piping the raster
output through filters to get it converted to a wanted format. The
Simrad software includes a number of filters for this use, and
additional filters are available on the Internet.

Caution: The text input field below the radio buttons is used both for file
names and for commands. The text content will be saved between
each activation of the Print dialogue box. Make sure the text input
field has the content you intend for it (file name or printer path)
before you initiate the printing.

Device

If you have selected the Command option and an lp or lpr Unix
command, this list box is used to select the printing device(s)
available. Only those devices defined in the device window can be
used. For further information about the Unix commands and how
to install new printers, refer to the applicable Unix documentation.

Fitness

The Scale command is used to set the final scale factor of the plot.
You may want to adjust the scaling factor after the Optimize to
media option was chosen in the first print dialogue box.

The Region on media button is not used in the current software
version.
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Acceptance

OK - Press the OK button to close the dialogue box and start the
actions defined in the dialogue box.

Cancel - Press Cancel to close the dialogue box without printing.

Help - Press Help for online guidance.
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Tool bar
The buttons on the tool bar are general tools for scaling, mouse
operations and panning. These tools are available in several of the
Kongsberg Simrad EM 1002 software applications using
geographical presentations.

Undo

Reset zoom to initial view

Zoom in

Zoom out

Scaling factor

Scaling double/half

Graphics on/off

Mouse help on/off

Extra pan window

(CD3389)

Figure 15 - The Tool bar

”U”

This button performs an “undo” on the last zoom or pan operation.

“R”

This button resets the zoom factor to the initial optimal scaling
factor to display the entire data set in the geographical area.

Upper case “Z”

This button zooms in. The image in the geographical area is
expanded.

Lower case “z”

This button zooms out. The image in the geographical area is
compressed.

Scaling factor

The two scaling factor buttons are used to define the steps of
scaling factors. There are two different ways of increasing or
decreasing the scaling factor.
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• When the +1 button is selected, the scaling factor will be moved
up and down a list of normal scaling factors; from 1:10 up to
1:750.000 and 1:10.000.000.

• When the *2 button is selected, the scaling factor will be the
double or half of the previous scaling factor.

“G”

Use this button to switch the graphic contents in the geographical
area on or off. It may be useful to have the graphics turned off when
the window is rearranged to a proper size or when changing other
display settings. No graphical redraws will then be applied, which
saves time.

Mouse help

This button is identified with the mouse and question mark
pictograph. When you press the button it will present a small
information window describing the current available mouse button
functions. To close the window, push the button again.

Panning toggle button

An extra pan window will be displayed if you press this button
(recognized by the two squares pictograph). Press the same button
again to hide the pan window.

The pan window shows the total survey area as a black rectangle,
and the displayed area as a white rectangle. This is a
two-dimensional scroll bar to help you pan inside the area where
the application operates. If the area is all white the whole survey
area is currently displayed.

The ratio between latitude and longitude directions is not
preserved in the pan window, but the relative ratio between the
black and white rectangles is correct. The displayed area (white)
can be moved to another part of the survey area (black) as follows:

1 Position the mouse pointer in the pan window.

2 Press and hold the middle mouse button while moving the
pointer.

3 The white rectangle will move and the corresponding part of
the survey will be displayed in the graphical area of the main
window.
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View procedures

To change annotation colours

You can change all the display colours used in the main window.
This includes background, grid lines, survey lines etc.

1 Select View on the main menu bar.

2 Select Annotation colours on the drop-down menu.
- The Annotation colour dialogue box appears. It contains

a list of all the components on the current display and the
colours assigned to each of them.

3 Click on the name of the component you wish to change.

4 Click on the new colour you want.

5 Click Apply to preview the result.

6 Click OK to apply and exit.

→ The Annotaion Colour dialogue box is described on page 200.

To show or hide display information

You may find that the main window presents too much
information. It is then possible to suppress specific components
from view, such as grid lines.

1 Select View on the main menu.

2 Select Show/Hide on the drop-down menu.
- The Show/Hide dialogue box appears. It contains a list of

all the components on the current display and small
“on/off” buttons to identify which are visible or not.

3 Click on the button to the left of the component you wish to
hide or show.

4 Click Apply to preview the result.

5 Click OK to apply and exit.

→ The Show/Hide dialogue box is described on page 202.

To change geographical format

You may change the format of the scales along each of the axes in
a geographical window. These represents geographical latitude
and longitude. You can select between:
• Decimal degrees
• Degrees and decimal minutes
• Degrees, minutes and decimal seconds

1 Select View on the main menu.

2 Select Lat/Long format on the drop-down menu.
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- The Lat/Long dialogue box appears. It contains a list of
the alternatives.

3 Click on the button to the left of the alternative you wish to
use.

4 Click OK to apply and exit.

→ The Lat/long dialogue box is described on page 209.

To define the colours to be used

Colour use must be defined when survey data is displayed as a
continuous data set.

1 Select View on the main menu.

2 Select Colour Mapping on the drop-down menu.
- The Colour Mapping dialogue box appears. It contains

several choices for modifying the colours.

3 Change the colours to suit your specifications.

4 Click OK to apply and exit.

→ The Colour Mapping dialogue box is described on page 204.

To update the display information

Display interval is used if you wish the computer to redraw the
dislay at regular intervals.

1 Select View on the main menu

2 Select Update Interval on the Drop-down menu.

3 Select the time interval between each update.
- If you select No update you must Redraw the display

manually.

To display grid lines in true motion

With true motion display enabled, the vessel will always be in the
centre of the display, and the display information will “follow” the
movements of the vessel.

1 Select View on the main menu.

2 Select Vessel in centre on the drop-down menu.
- This is an “on/off” switch. Press again to deselect true

motion.
For each program there is several different dedicated view
procedures. These are described further in the program chapters.
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Special mouse operations

Overview

The mouse plays an active role when you use the geographical
windows. In addition to the usual left mouse button functions for
pressing buttons and menu selections, the middle and the right
mouse buttons are often used.

Zoom to region

Any user-defined region can be zoomed up to fill the geographical
area of the window. To define the region, perform the following:
1 Press and hold down the Shift button on the keyboard.
2 Position the mouse pointer in a corner of the new display

region.
3 While the middle button on the mouse is held down, move

the pointer to the opposite corner of the new display region.
4 Release the mouse button.
5 Release the Shift button.

Panning

In addition to the panning toggle button described above, the
following mouse utility is available:
1 Position the mouse pointer in the geographical area of the

main window.
2 Press and hold the middle mouse button while moving the

pointer in the desired direction.
To increase the speed, only parts of the data may be displayed while
panning.

Interactive selections using the mouse

Overview

Several methods for selecting segments in the geographical area
are supplied. The pop-up window with information about the
available mouse button functions presents the different selection
methods supplied for each module.

Select

The simplest selection method is to position the mouse button
pointer at the actual data segment (line or displayed area) and press
the left mouse button. The selected segment will then change
colour to yellow (or whatever colour you have specified).
When a new item is selected, this item will be given the selected
colour and the previous selected item will be deselected and given
the colour it had before it was selected.
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Drag select

For some of the geographical windows a part of a segment can be
selected by using the drag select method:

1 Press the Ctrl key and hold it down.

2 Position the mouse pointer at the segment in the
geographical area.

3 Press and hold the left mouse button while you move the
pointer along the segment until the actual part of the segment
is covered.

4 Release the mouse button

5 Release the Ctrl key.

Region select

All segments or parts of segments inside a user-defined region can
be selected:

1 Position the mouse button in one of the region corners.

2 Hold the Ctrl key, then press and hold the middle mouse
button while you move the cursor to the opposite corner of
the region.

3 Release the mouse button and the Ctrl key.

Extended selection

A selection can be performed in several incremented steps. If the
Shift key is used in addition to the select functions described
above, the selected segments are not deselected when new
segments are selected. The selected objects are instead added into
a list of selections. As an example, this gives you a possibility to
select several lines.

Displaying alphanumerical information in the
geographical area

In a number of application modules, data values can be displayed
in the geographical area. Two methods can be used:

• Position the mouse pointer at the desired position, then press
and hold the right mouse button and the CTRL key while you
move the pointer.

- Values will be displayed at the current mouse pointer
position, and deleted when the pointer is moved to a new
position.

• To display the values more permanently, press the SHIFT and the
CTRL keys simultaneously and click the right mouse button at
the desired position.



EM 1002 / Base version

54 850--160977/E

- The value will be displayed until the next time the
geographical window is redrawn.

Information text field below the geographical
area

The right text field below the geographical area can display
information about a segment in the geographical area. Typical
information displayed here includes coordinates, line name, region
name, etc.

To get information for a specific segment, position the mouse
pointer on the segment, then press the right mouse button while
holding down the Ctrl key.
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2.12 The Survey Display and the graphical
utilities

Introduction
The Survey Display is mainly used for visual quality control of the
survey, but it is also used as “host” for the other graphical utilities
incorporated in the EM 1002 system. The Survey Display is
automatically started when the EM 1002 is powered up for on-line
operations. If it is accidentially stopped during the survey session,
it can also be started manually from the EM 1002 Launchpad.

For off-line operations, the Survey Display is started from the
switch area pop-up menu. It is there identified as Merlin. You can
then use the application for replay of previously recorded data.

Start and stop

To start the Survey Display

Alternative 1: On-line operations

1 The Survey Display is started automatically when the EM
1002 is started.

2 If it is accidentially stopped, it can be restarted by pushing
the icon on the launchpad

Alternative 2: Off-line operations

1 Place the cursor on the screen’s background pattern (switch
area)

2 Press the middle button

3 Select Merlin from the menu.

4 Enter survey and operator name.

To stop the Survey Display

When operating on-line, the Survey Display is automatically
closed when you close down the EM 1002 launchpad. However,
you can also close the program as follows:

1 Select File -> Exit on the main menu.

The same method is used for off-line operations.

Graphical window functions

To shift the view

1 Place the cursor anywhere in the graphical window.
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2 Press and hold the middle mouse button, and move the
mouse sideways. The view in the window is shifted
accordingly.

To redraw

This function was implemented to make the graphical software run
on slower workstations, and allows you to redraw the display if the
display interval has been reduced. This is however not
recommended.
1 Select View -> Redraw.

To select data to be shown behind the vessel
symbol

This function is intended for realtime use only.

1 Select View -> Data choice.
2 Select information types.
→ The Data choice function is described on page 210.

Ping Display
The Ping Display presents a real-time view of the system
performance during on-line operation. The display shows the raw
data from the system after corrections have been applied for vessel
attitude and sound speed. The Ping Display starts automatically
when the echo sounder is started.
→ The Ping Display is described on page 162.

If you have accidentally stopped the utility during the session, you
can restart the Ping Display from the icon on the EM 1002
Launchpad.
→ Additional operational procedures for the Ping Display are found

on page 169.

To start the Survey Display utilities
The Survey Display hosts several additional utilities. These may
be started from the Processing menu. Each utility is briefly
explained in this chapter, while references are made to further
operational procedures.

Note: Some of the utilities are designed to be used only during on-line
operations!

Grid Display
The Grid Display displays all depths and related data for a
specified geographical area. The logged data for this area is then
displayed in a dedicated window.
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→ The Grid Display is described on page 226.

You can start it as described here.

Before the Grid Display is started, the display area and the cell size
to be used must be defined.

1 Select Processing -> Create grid... on the Survey Display
main menu. Logging must be switched off, if running
on-line.
- Select grid cell size.
- Allow the system to generate a grid.
→ This process is described on page 229.

2 Select the survey area in Survey Display’s geographical
window.
- Select Edit, New Display Area.
- Click the right-mouse button and select an area.
- Activate the new area by clicking the left-mouse button

on the new area.
3 Select Processing -> Grid display on the Survey Display

main menu, if off-line.
- Select Processing -> Grid display realtime if on-line.

You can also start the Grid Display from the launchpad, but you
must still define reference and select lines as described above
before you start the utility.

Bridge and Helmsman Display
The Bridge and Helmsman Display is designed to view track and
coverage data. It is only used during on-line operations. You can
start the utility as described here.

The Helmsman Display is a part of the Bridge Display and is
intended to show how to steer the vessel according to the planned
survey lines. It is only used during on-line operations.

1 Select Options -> Display on the Survey Display main
menu.

2 Select which display you wish to address the Bridge Display
to.

3 Select Processing -> Bridge Display on the main menu.

You can also start the Bridge Display from the EM 1002
Launchpad. Note that the Survey Display utility must be active
before you can start it.

4 Click the Bridge and Helmsman Display icon on the EM
1002 launchpad.
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→ The Bridge and Helmsman Display is explained in detail on page
244.

5 Click on the planned line you wish to use as a reference line
for the helmsman.

6 Select Planning -> Activate line on the Survey Display
menu.

7 Select Processing -> Helmsman Display on the main menu.

The Planning module
The Planning module is an integrated part of the Survey Display
utility. It allows a fully comprehensive survey plan to be made
aforehand, and it also presents a survey plan available during the
survey as an integrated part of the multibeam echo sounder
operation.
→ The Planning module is explained in detail on page 285. The main

operational procedures are presented on page 287.

Sonar Image
The Sonar Image is designed to display the seabed image data
on-line and off-line. Compared to the seabed viewer it will allow
correct scaling and more filtering options. However, it may be too
slow for real time use, especially in shallow waters.
→ The Sonar Image utility is described on page 304.

This utility can only be started from within the Survey Display as
described here.

1 Select Processing -> Sonar Image... on the main menu.

Note: Logging of sonar image data must have been set ON for this display
to function. The display will only be updated when the SI
workspace is activated.

Seabed Viewer
The Seabed Viewer is designed to display seabed image data
on-line and off-line in a scrolling window. For each ping a straight
line is plotted, this covers the swath width. The display is used as
a simple quality check of the data, or it can be used for object
detection.
→ Seabed Viewer is described in detail on page 313.

You can start the utility as described here.

1 Click the Seabed Viewer icon on the EM 1002 launchpad.

Note: The Seabed Viewer will be updated independently of the
workspace!
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SSP Editor
The Sound Speed Profile Editor is used to inspect and/or modify
exisiting sound speed profiles, or to create new profiles.

→ The utility is described on page 321.

The SSP Editor is started from the EM 1002 as follows:

1 Click on the icon on the EM 1002 launchpad.

2 Identify the profile you wish to work on.

The SSP Editor is also started automatically whenever a new
profile is downloaded.

→ Further operational procedures are found on page 325.
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2.13 Survey planning

Introduction

A survey is normally planned taking into account

• echo sounder coverage

• seabed topography

• sound speed variations

• current weather conditions.

→ The dedicated tool for the Planning is described on page 285.
Operational procedures for that tool is presented on page 287.

The need for calibration of the positions (time delay), heading, roll
and pitch sensors should be considered, and how and where to
gather sound speed profiles should be considered.

Coverage capability determines line spacing, and as it varies with
bottom reflectivity, this must be estimated. Usually 10% overlap
between lines is sufficient, but if large variations in bottom
reflectivity is expected, or reflectivity is unknown, it may be
necessary to increase overlap.

The overlap must also be increased if the vessel’s roll is excessive.

If there are steep slopes on the bottom, it is strongly advised to run
along these slopes, not up or down them. This will be beneficial in
keeping coverage reasonably constant along survey lines, thus
making survey planning easier. However the main reason for this
advice is that the echo sounder performance will always be poorer
when running up or down a slope rather than along. This is because
much less acoustic energy is reflected back towards the transducer
from steep slopes, causing less detections and the possibility of
false detections in sidelobes. Sidelobe detections should however
be very rare in the EM 1002 due to the advanced signal processing
implemented. Note that if circumstances require that survey lines
are run up or down a slope, reduction of vessel speed may be
required to allow the echo sounder to track the bottom
continuously.

Coverage capability is also affected by weather conditions and
possibly also by vessel speed. Heavy seas and possibly vessel
speed lead to increased noise level, and may also cause aberation
on the transducer array.
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Aeration is a function of sea state, but also of the heading with
respect to the wave direction and the vessel speed. It is strongly
advised that one builds a record of coverage and aeration problems
versus sea state, heading with respect to wave direction, and vessel
speed. This record could be very helpful in ensuring that surveys
can be performed efficiently with a minimum of line rejections and
corresponding reruns and infills.

Any drift rates of roll, pitch and heading offsets should also be
recorded to enable efficient planning of calibration intervals. If
calibration is required before a survey, a suitable calibration area
should be determined before reaching the survey area.

A sound speed profile should always be taken in the surveying area
and loaded into the EM 1002 before the survey is started. In some
areas the profile will vary, mostly due to fresh water inflows from
rivers or currents from areas with different salinity. If variations
can be expected, where and when sound velocity profiles are to be
taken should be planned ahead, and the survey line schedule
adjusted to take this into account.

If the measured sound speed value at the transducer array depth is
continuously updated, it should be compared with that measured
by the profiling instrument to evaluate the need for measuring a
new profile.

Note that in some cases the coverage capability of the echo sounder
cannot be fully utilized, because errors in roll and sound speed
profile measurements, which are critical in maintaining the
accuracy of the outer beams, become too large in relation to the
accuracy requirements of the survey.
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2.14 System self test

Overview

The EM 1002 supports off-line and on-line self test; BIST (Built-In
Self Test).

• On-line BIST is operational all the time, it monitors the
operation, and will detect failures and abnormalities during
logging.

• Off-line BIST must be manually initiated, and can not operate
while logging takes place. It is run by operating or maintenance
personnel to run specific hardware tests on the system.

The on-line BIST will present its messages in the Status Display.

→ Refer to page 103 for a description of the Status Display.

To access the off-line BIST

1 On the EM 1002 Launchpad, press the Off button in the
Sounder & logging” field.
- This stops the pinging.

2 Locate the Runtime Menu.
- This window is opened automatically when the echo

sounder is started, and is by default located in workspace
4.

3 Select Show -> Test on the main menu.
- The Runtime Menu window changes to contain the BIST

parameters.
→ The BIST is described in detail on page 145.

To run off-line BIST tests

The BIST self test on the EM 1002 system is controlled from the
BIST window described above.

1 Open the BIST window as described in the previous
sequence.

2 Select Execute All to run all the tests on the system, or select
individual tests by clicking in the buttons to the left of their
names.

3 Press Print Output for a hardcopy.

4 Press Write to File to create a file with the resulting
information. The file will be located in
$HOME/eso_system/BISToutput .

5 Press Reset to clear the window.

The indicators are colour coded to display the test results:
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Ok Indiacator is green

Fail Indicator is red

The test result messages are displayed in the text field at the bottom
of the dialogue box, and can be printed and/or saved as described
above.

More about the BIST files can be found in the System
Administration chapter in the EM 1002 Maitenance Manual.
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3 EM 1002 LAUNCHPAD & STATUS DISPLAY

3.1 Introduction
The purpose of this chapter is to provide detailed information
about the commands and parameter settings in the EM 1002 echo
sounder operation dialogue boxes. It thus presents all the windows,
icons and boxes associated with the operation of the EM 1002
multibeam echo sounder software.

The following topics are covered:

→ The Launchpad, page 65.

→ Status Display, page 103.

The following topics are described in Operation menus for EM
1002

→ Organization and Main menu, page 111.

→ Runtime Menu, page 113.

→ Installation Menu, page 124.

→ Manual control, page 140.

→ Simulator, page 143.

→ Built-In Self Test, page 145.

The following topic is described in I/O Interfaces

→ I/O Interfaces, page 149.

Note that the EM 1002 system comprises several individual
graphical applications. These are explained in separate chapters in
this manual.

→ Refer to the table of contents in the preface of this manual, or to the
Survey Display Processing commands overview on page 216.
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3.2 The launchpad

Introduction
All workspaces on the EM 1002 Operator Station contains:

• Launchpad window

Figure 16 - The EM 1002 Launchpad

Check this field
to monitor the
ping activity.
Press the 

button
to open the
Status Display.

Echo
Sounder 

Check this field
to monitor the
Operator Station
storage status.
Press the

button to open the
Status Display.

Operator Station

Use these two buttons to
define survey name,
projections to be used, line
identifiers, operator name
and specific comments.

Use these four buttons
to start and stop the 

echo sounder and the logging.

Use these four buttons to 
choose the active workspace.

Check this field
to monitor the
sensor activity.
Press the 
button to open
the Status Display.

Sensors

Unless the EM applications are started automatically
from the Survey Display, you can start them here.

(CD5782)

The EM 1002 Launchpad is used to monitor the status of the EM
1002 system during on-line operation, and to start the various
applications used to perform specific tasks.

The Launchpad is divided into the following groups of parameters:

→ Operator Station, (page 67)

→ Echo sounder, (page 68)

→ Sensors, (page 70)

→ Sounder & Logging, (page 71)

→ Workspace, (page 72)

→ Programs, (page 73)

→ Survey, (page 76)

In addition, the launchpad offers a main menu line with the
following options:

→ File, (page 79)
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→ Layout & Configuration, (page 92)

→ Options, (page 95)

The Help command provides on-line help for the system. It is
regarded as self-explanatory, and it is not described here.
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Operator Station
This group provides you with the status of your remaining disk
space, and the current load in percent. The information is dynamic,
and continuously updated. If you click on the Operator Station...
button, the Status Display dialogue box will be displayed with the
Operator Station parameters in view.

→ Refer to page 105 for more information about the Status Display.

Figure 17 - Operator
Station

If you log to disk and the available disk space falls below 50
MBytes a warning message is issued, and the Raw Data and
Survey data text box backgrounds turn orange. If the disk space
falls below 10 MBytes another message is displayed, the
background turns red, and the logging stops automatically.

Raw Data - This number shows you how much disk space you
have currently available for raw data.

Survey Data - This number shows you how much disk space you
have currently available for survey data.

Note: If raw and processed data are logged on the same disk , the total
disk space is raw data or survey data.

Load - This number shows you the current CPU load.
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Echo sounder
This group provides you with the status of a selection of the current
system parameters. The selection is defined by the choices you
make in the Sounder Status Configuration... dialogue box
accessed from the Layout & Config menu.

→ Refer to page 93 for a description of the Sounder Status
Configuration... dialogue box.

Figure 18 - The Echo Sounder group on the Launchpad

You may select 12 of the 14 following status parameters to be
displayed:

- Beams - Number of beams (tried/accepted)

- Ping Hz - Ping frequency (in Hz)
- Ping No. - Ping number
- Coverage - (in degrees), port/starboard
- Depth - Center depth (in meters)
- Across - Across swath width (in meters), port/starboard
- Mode - Sounder ping mode

- Tr.Sv - Sound speed at transducer (in m/s)
- DTN Inc -Depth to normal incidence (in meters)
- NI Bs -Normal incidence backscatter (in dB)
- Obl.BS - Oblique backscatter (in dB)
- Tilt - Transducer tilt angle, if a hull unit is mounted (in

degrees)
- Cycle - Cycletime between pings (in seconds)
- Abs. Coef. - Absorption coefficient used by the system (in

dB/km)
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The information is dynamic, and continuously updated either from
the last recorded ping, or once per second. If you click on the Echo
Sounder... button, the Status Display dialogue box will be
displayed with additional echo sounder parameters in view.

→ Refer topage103 for further information about the StatusDisplay.
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Sensors...
This group provides you with the status of your current sensor
parameters. The information is dynamic, and continuously
updated. The selection is defined by the choices you make in the
Sensor Status Configuration dialogue box accessed from the
Layout & Config menu on the Launchpad.
→ Refer to page 94 for a description of the Sensor Status

Configuration dialogue box.

Figure 19 - The Sensors group on the Launchpad

You may select 12 of the 13 following sensor parameters to be
displayed:

- Roll (degrees)
- Pitch (degrees)
- Heave (meters)
- Heading (degrees)
- Latitude
- Longitude
- Tide
- Probe Sv (Sound Speed Probe) value ( m/s)
- Height Sensor
- No. of Satellites
- Position Quality
- Position (H)DOP (Horizontal Dilution of Precisison)
- Clock

If you click on the Sensors button, the Status Display window will
be displayed with additional parameters in view.
→ Refer to page 108 for details about the Status Display dialogue

box, and descriptions of the various sensor parameters!
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Sounder & Logging
This group provides you with four buttons to control the main EM
1002 echo sounder functions.

The group may appear in two variations, one with Start in the top
left button, and one with Simulator in the top left button. The
variation shown here is presented during normal operation, while
the other is shown when the Simulator is enabled.

Figure 20 - The Sounder & Logging group

Start

Start log

Off

Stop

Sounder & Logging

(CD4362FB)

In order to start the Simulator, you must first enable it in the
Runtime->Test->Simulator dialogue box. This box is accessed
when you select it on the Show menu in the Runtime Menu
window.

→ Refer to page 143 for a description of the Simulator settings.

Start - Press this button to start the echo sounder’s pinging. This
button changes text to “Active” when pressed.

Off - Press this button to stop the echo sounder’s pinging.

Start Log - Press this button to start the logging, or to start a new
line when logging is already active. This button changes text to
“Logging” when pressed.

Stop - Press this button to stop the logging.

Simulator - A click on this button starts the built-in simulator. This
simulator provides artificial data for system validation, training
and exercises.
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Workspace
This group allows you to select which of the four workspaces you
need displayed. These buttons perform the exact same functions as
the four buttons in the Common Desktop Environment (CDE)
window.

Figure 21 - The Workspace options
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(Cd4362Gb)
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Programs
The options in the Programs group allow you to start a number of
individual programs.

Figure 22 - The Workspace options
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Each program is identified when you move the cursor over the
icon, and the following programs are available:

• Echo Sounder

- This is not a program, but must be regarded as a message
indicator.

• All programs

- This icon will only permit you to maximize or minimize all
the program windows simultanously.

• Ping Display

→ Ping Display: page 162

• Survey Display

→ Survey Display: page 188

• Bridge and Helmsman Display

→ Bridge and Helmsman Display: page 244.

• Seabed Viewer

→ Seabed Viewer: page 313
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• Grid Display

→ Grid Display: page 226

• Sound Speed Profile Editor

→ Sound Speed Profile Editor: page 321

• Setup for Echo Sounder

→ Setup for Echo Sounder: page 111

• Workstation I/O (Serial & Network)

→ Workstation I/O: page 149

• Multibeam Data Distribution

Indicates that the datagram distributor is running. This program
distributes data from the echo sounder to the different recipient
modules. The distribution is a background process with no user
interface.

• Single-beam Data Distribution

This is an indicator that tells you if the Single Beam Forward
program is running. This program sends data from a single beam
echo sounder to a work station, if there is a single beam echo
sounder being used in addition to the multi beam. In the
workstation the data is synchronized with the multi beam echo
sounder. The Single Beam Distribution is a background process
with no user interface.

A red border means that the program is active, but that an error
message has been issued. Press the button to recieve an error
message.

No border means that the program is not active. You can then start
it by positioning the mouse cursor on top of the icon, and click the
left mouse button.

When you move the cursor over the program icons, the programs
are identified.

If you click the right mouse button over the icon, a special pop-up
menu is displayed. The content of the menu differs slightly
between the various program.

Use current - Select this option if you wish to place the applicable
program into the current workspace.

Go to program - Select this option if you wish to bring the
applicable program into view. The system will automatically
maximize the window and - if necessary - change workspace.

Minimize - Select this option to shrink the program window into
a desktop icon.
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Maximize - Select this option to restore the program window into
its previous size.

Restore layout - Select this option if you wish to restore the layout
of the program window to the default.

Terminate - Select this option to stop the program.

Enable Auto restart - Select this option to enable the program to
restart automatically if it accidentally terminates.

Minimize all - Select this option (All Programs only) to minimize
all the programs.

Maximize all - Select this option (All Programs only) to
maximize all the program windows.
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Survey
The Survey field is shown below.

Figure 23 - The Survey group

Survey: Horten_Havn

(CD5630)

Line... 2

This field allows you to select the current survey. The field also
provides you with the current line number.

Survey

Click the small triangle (as indicated in the figure) to select a
survey from the drop-down menu or to enter a new survey.

If you click on <New Survey>, the Survey Setup dialogue box
opens. This window provides you with three fields for data entry
or selection.

→ The Survey Setup dialogue box is shown on page 16.

When a new survey is created, the Launchpad will check the name
of the current selected profile. If this is not the newest sound speed
profile found in $SHAREDHOME, a warning will be given. There
will be three choises: Confirm, Select and Ignore.

If the user confirms his choise, current .asvp profile will be copied
from $SHAREDHOME to the newly created raw data directory.

If Select is pressed, a list of profiles will pop up, from which the
user may select the newest profile. The selected profile will be
copied from $SHAREDHOME to the newly created raw data
directory. The name of the profile will be sent to esoSetup which
will update the “Current Sound Profile” field.

If Ignore is pressed, the Launchpad assumes that the user will
download a new profile before he starts logging. No profile will be
copied to the newly created raw data directory.

Survey name - Enter the name of the new survey. Use maximum
30 alphanumerical characters.

Enter any text you wish in the Survey Name comment box below
the Survey name.

Synchronize clock - Enable: set the system clock to the one
selected in the installation menu.

→ Refer to page 135 for further description of the clock settings.

Survey Predefined Setups - These settings are used as
“templates” for the echo sounder operation. They contain setup
information such as projections, environments and coastlines.
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Line...

This is the current line number if logging is on (active), or the next
line number if logging is off. To enter parameters for the line to be
logged, click Line... to open Line Setup dialogue box.

Clear Comments

Apply HelpCancel

Comments:

Line Setup

Operator:

Line Id:

Planned Line Id:

(CD4927)

Figure 24 - Line Setup dialogue box

The following parameters may be used:

Comments - Any string of text can be entered.

Clear comments - Press this button to clear the Comments field.

Operator - Select from the list. If you are not listed, select <New
operator> to open a data entry dialogue box where you can enter
your name. This is not a password box. The operator name will be
kept for each succeeding line until it is changed in this menu. If the
you want a special screen layout, this configuration may be saved
in the Launchpad’s Layout & Configuration menu.

Line Id - Line number of the line to be logged.

All line parameters are stored in the Start datagram.
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New operator:

OK Cancel Help

No Name

Enter a string

(Cd4413)

Figure 25 - String entry dialgoue box for operator
identification
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File

Overview

The File option on the launchpad’s main menu bar holds the
following options:

• File Admin

• Print/View

• Reset Logfile

• Storage Locations

• Exit

The File Admin dialogue box allows you to delete, backup or
restore survey and data files. You do not need to know where the
files are located on the Operator Station harddisk.

→ The File Admin dialogue box is described on page 80.

The Print/View dialogue box allows you view or print the system
setup files.

→ The Print/View dialogue box is described on page 85.

The Reset logfile function allows you to reset (empty) the main
system logfile.

→ Reset logfile is described on page 88.

The Storage Location dialogue box allows you to redfine the file
locations on your system’s harddisk.

→ The Storage Location dialogue box is described on page 89.

The Exit command presents you with different choices for exiting
the EM 1002 launchpad.

→ The Exit command is described on page 91.
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File Admin

The purpose of the File Admin dialogue box is to allow file
backup, deletion and restoration. You can perform dedicated
actions on all the files generated for or by the survey.

More about the file types and their location is presented in the
System Administration chapter in the EM 1002 Maintentance
manual.

CancelApply Help

File Admin

File Type:

Operation:

Tape

Terminate Tape Operation

Restore Source:

Restore:

Files:

Select ‘Apply’ to start Tape Restore.
File(s) will be restored to default
Catalogue for current file type.

Update

Show Surveys Only
Show Survey Contents

Append         Continue
Rewind

Clear

Restore files

Sound Speed Profiles

(CD4458B)

Tape OptionsTOC List Contents

Figure 26 - The File Admin dialogue box

File type

The first selection you need to make is the file type you wish to
operate on. A list of options is displayed once you click on the
small rectangle in the File type list box.
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Sound Speed Profiles - These are the files containing the sound
speed profiles. The profiles are stored in the standard directory for
sound speed profiles.

Raw Data - These are the files containing the raw data of the
survey. These files are the most important files collected during a
survey. If you accidentally loose your survey data format files
(required in the geographical displays in the Kongsberg Simrad
postprocessing software), you can recreate these files based on the
raw data files.

Note: You are strongly advised to back up raw data files on a regular
basis, using the tape facilities in this window.

Survey Format - These are the data files generated by the system.
Note that files will only be stored if the Survey Format To Disk
option is checked in the Logging dialogue box on the Options
menu.

These files are used by the real time geographical displays and also
the Kongsberg Simrad post-processing software.

→ Refer to page 98 for information about the Logging dialogue box.

Tape TOC’s - These are the “Table Of Contents” files generated
by the Generate Tape TOC option in the Operation menu. They
contain a list of all files on a tape, and may be given a unique name.
The tape TOC files may be used to select files that you want to
restore from the tape.

Logfile Backups - These are the backup copies of the logfile used
by the system.

Sounder Setup Files - These are the files determining how the
current echo sounder system is set up. The system uses separate
files for runtime and installation parameters.

Operator Config’s - These are the individual files containing each
operator’s preferred window layouts and desktop workspace.

Survey Jobs - These are the files generated by the Survey Display
Planning module.

Operation

This list box is used to decide what to do with the chosen file(s).

→ Refer to page 20 for backup, deletion and restore procedures.
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Delete - This selection will delete the files chosen by you. When
selecting files for delete, the file related information is shown
below the list, as well as the total size of selected files. When you
press the Apply button, a confirmation dialogue appears, and you
are asked to verify the deletion. The action is immediate once you
have confirmed the operation. When the current file type is
Sounder Setup Files and the current operation is Delete, the files
listed are restricted to the automatically created backups of the
Installation- and Runtime parameters files.

Caution: Delete is PERMANENT! If you delete data which is not backed up,
they will be lost - for good!

Backup All - The Files field will be updated with all files of the
current file type. The files will appear as selected with file statistics
just below the list. When you press the Apply button, a
confirmation dialogue appears. If you confirm the operation, the
backup process will be started immediately. You will be notified
when the backup is completed. The backup time will depend on the
size of the selected files.

Backup File(s) - As above, with the exception that you will have
to select one or more files for backup. When backing up to tape,
you will also be asked to confirm.

If the last file is not an .asvp file, a warning will be given. There
will be three choises: Confirm, Select and Ignore.

If Ignore is pressed, a message will be placed in a readme file, in
the raw data directory, that the user deliberately ignored his duty
to take a sound speed profile at the end of the survey.

Restore Complete Tape - This option allows you to restore all the
files on the selected tape to the disk. When you press the Apply
button, a confirmation window appears. If you confirm the
operation, the restore process will be started immediately. You will
be notified when the restore is completed. The restore time will
depend on the tape contents.

Note: The files will be restored to the default catalogue for the current file
types. These are listed in the System Administration chapter in the
EM 1002 Maintentance Manual.

Restore File(s) - This option allows you to restore individual files
from the tape. You may select the files by manually entering file
names, or by selecting one or more files from a pre-generated tape
Table Of Contents (TOC).

Note: The files will be restored to the default catalogue for the current file
types.
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Generate tape TOC - This option produces a tape Table Of
Contents (TOC), and you may use this TOC for later retrieval of
one or more files from this tape. When this command is selected,
an input dialogue appears, and you may supply a name to be
associated with the TOC. If you just select OK without supplying
a name, a file name based on current date and time will be
generated. The time used will depend on the tape contents. The
generated TOC will be added to the list of TOCs available in the
Restore Source pulldown menu.
List Tape - This command simply lists the tape contents in a
dedicated window. The list time will depend on the tape contents.
Tape
This field is only available if the Tape box is ticked on and Restore
file(s) is selected as operation. You can here perform dedicated
actions on the files stored on the system’s tape backup.
Terminate tape operation - This function will abort any tape
operation currently running.
Restore source - This selector allows you to select from your own
list of previously generated TOC (Table Of Contents) files. When
a TOC file is selected, the files are automatically listed in the
Restore field. The file structure presented is defined by the Show
Surveys Only and Show Survey Contents option buttons
described below.
Restore - This text box allows you to enter the name of the file(s)
you wish to restore. You then need to know the accurate file
name(s) and location(s) (path) on the tape.
If you have selected a TOC file using the Restore source selector,
the files included in the TOC will be listed automatically. The file
structure presented is defined by the Show Surveys Only and
Show Survey Contents option buttons described below.
Update - When you enter file names manually into the Restore
field, you can enter as many files as you wish. Once finished, click
the Update button to transfer the file names to the Files field.
Clear - Click this button to clear the Restore field.
TOC List Contents
This field is a part of the Tape field, and it is only available if the
Tape field is enabled. The two option buttons control the file listing
in the Restore text box.
Show Surveys Only - Click here if you wish the files in the
Restore text box to be listed on the top level (Survey name) only.
Show Survey Content - Click here if you wish to expand the list
in the Restore text box, and see all the individual files within the
survey.
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Tape Options

This field is a part of the Tape field, and it is only available if the
Tape field is enabled. The three option buttons control the
behaviour of the tape when you record or play back data.

Append - This function will add new data to the tape from where
the existing data stops. This is the default setting.

Continue - This function allows the tape to continue from the
present physical location.

Rewind - This function will rewind the tape to the start before data
is written to it or read from it.

Note: You must define the option before you press the Apply button to
start the tape operations.

Files

This field displays the current file names. To select a file, click on
the file name. The applicable file information is then displayed
under the File field.

Acceptance

Apply - This button allows you to perform the defined actions on
the files.

Cancel - This button allows you to cancel all actions.

Help - This button provides on-line help.
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Print / View

Purpose

This dialogue box is used to visualize the various settings made
automatically by the EM 1002 system and/or manually by you.

→ Please refer to figure 27.

Apply Close Help

Print / View

Sources

Source:

Survey: Indre havn

esoEMxxxxSetup.installation

0002_19980422_135805_raw.allLine:

Setup & Logfile

Setup & Logfile             Survey Parameters

Line Statistics               Line Parameters

Output Function

Print         View

(C
d4

45
9)

Figure 27 - The Print/View dialogue box

Output function

The settings you wish to view can either be sent to the default
printer, or presented in a separate window.

Print - Click here if you wish the settings to be sent to the local
printer.

View - Click here if you wish the settings to appear in a separate
window on the display.

Sources

These choices allow you select from the five different file types,
and for each file type decide the source of the information.

Source - Select the setup file or logfile you wish to view. A list of
files is available if you click on the small triangle in the file
selection box.

Setup & logfile - Click here to see the logfile and the setup files.
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The Logfile contains messages generated by the system
applications, while the Setup files contain the runtime or
installation parameters transmitted to the Transceiver Unit for use
during the processing. The file presented is the one you selected
using the Sources selector described above.

→ An example is shown in figure 28 (page 87). Further information
about the parameter files is found in the System Administration
chapter in the EM 1002 Maintenance manual.

If you select View to see a logfile, the window will - when opened
- present the messages from all the applications. You may select
messages from individual applications by clicking on the
corresponding icon on the top of the window.

Survey - Select the survey file you wish to view. A list of files are
available if you click on the small triangle in the file field.

→ For more information about the survey files, refer to the System
Administration chapter in the EM 1002 Maintenance manual.

Survey Logfile - Click here if you wish to see the survey logfile.

Survey Parameters - Click here if you wish to see the survey
parameters.

Line - Select the line you wish to study. A list of files are available
if you click on the small triangle in the selection box.

Line Statistics - Click here if you wish to see the line statistics.

Line Parameters - Click here if you wish to see the line
parameters.

Acceptance

Apply - This button allows you to perform the defined actions on
the files. If you have selected Print in the top of the window, the
files will be sent to the system printer. If you have selected View,
the files will be displayed in separate windows. Each window has
an OK button to close it. Note that the View window will not be
available if the amount of information is too large. An appropriate
message will then be issued.

Close - This button allows you to cancel all actions.

Help - This button provides on-line help.
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(Cd4395)

Figure 28 - Runtime setup seen in a window, example.
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Reset logfile

This option on the File menu allows you to clear the main survey
data file. Before the file is cleared a warning message appear, and
you may start the backup process.

If you decide to do a backup, the file will be named after the
following convention:

YYYY_MMDD_HHMM_esoLogfile

where:

YYYY = current year
MMDD = current month and date
HHMM = current hour and minute

The file will be located under $HOME/.eso_system .

→ Further information about the EM 1002 file system is provided in
the System Administration chapter in the EM 1002 Maintenance
Manual.
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Storage Location

Purpose

The purpose of the Storage Location dialogue box is to allow you
to control the location of the various files generated by the survey.

→ An overview of the file types and their default location is presented
in the System Administration chapter in the EM 1002
Maintenance Manual.

The dialogue box is split in five parts; four are used to control the
locations of the file types, while the fifth allows you to navigate on
the system hard disk.

Use location from Selector

Use location from Selector

Use location from Selector

Use location from Selector

Filter

/export/home/em1002/*

/export/home/em1002/*

Selection

Current Location:

Current Location:

Current Location:

Current Location:

/data1/raw

/data1/proc

/data1/shared

/data1/xyz

OK Cancel

Filter OK

Help

(CD4737)

.

..

.dt

.eso_system

.eso_system.990201

Storage Location Setup

Raw Data (RAWDATAHOME) Location Selector

Survey Data (PROCHOME)

Shared Data (SHAREDHOME)

Exported Data (XYZHOME)

Figure 29 - The Storage Location dialogue box,
example.

Raw Data

The text box is used to identify the preferred location of the Raw
Data files. Enter the folder identification directly, or use the
Location Selector to navigate. Press the Set Location button to
apply.

Survey Data

The text box is used to identify the preferred location of the Survey
Data files. Enter the folder identification directly, or use the
Location Selector to navigate. Press the Set Location button to
apply.
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Shared Data

The text box is used to identify the preferred location of the Shared
Data files. Enter the folder identification directly, or use the
Location Selector to navigate. Press the Set Location button to
apply.

Exported Data

The text box is used to identify the preferred location of the
Exported Data files. Enter the folder identification directly, or use
the Location Selector to navigate. Press the Set Location button
to apply.

Location Selector

The Location Selector options are used to navigate on your
system’s harddisk to locate and/or create dedicated folders for your
data files.

Filter - This text box is used to define directory and/or filename
filters in order to specify profile listings for specific file names.
You can for example reduce the selection to a named directory and
sound velocity profiles with extensions ending with *.svp, or depth
files with extensions ending on *.depth. The following wildcard
characters are accepted:

* (representing any sequence of characters)

? (representing any single character).

The files conforming to the filter are shown in the list box to the
right. The filter is activated by pressing Enter on the keyboard or
by clicking on the Filter button at the bottom of the dialogue box.

Directories - This box displays the current directories. Double-
click on a directory name to jump further down in the directory
structure. To move “up” in the directory structure, double-click on
the directory name with the “/..” ending.

Files - This box lists the available files in the current directory. The
listing may be limited if a filter has been defined.

Selection - This text box is used for direct entry of requested file
name, or to define a filter to narrow down the list of files.

Acceptance

OK - This button allows you to accept the defined locations and
close the dialogue box.

Cancel - This button allows you to cancel all actions, and close the
dialogue box without applying any changes.

Help - This button provides on-line help.
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Exit

This final choice on the File menu allows you to exit the EM 1002
launchpad. You are presented with three choices. All will first
check if the echo sounder is still running, and if a survey is in
progress.

If the last file is not an .asvp file, a warning will be given. There
will be three choises: Confirm, Select and Ignore.

Exit Launchpad

This option will close all the programs controlled by the EM 1002
Launchpad. You will however still be logged in on the workstation.

Exit Launchpad & Logout

This option will close all the programs controlled by the EM 1002
Launchpad, and you will be logged out from the workstation. It
will not check if other non-EM 1002 programs are running.

Exit Launchpad & Power Down

This option will close all the programs controlled by the EM 1002
Launchpad, you will be logged out from the workstation, and the
system will then automatically power down. It will not check if
other non-EM 1002 programs are running. If the Power Admin
utility is installed on the workstation it will record the current
settings and save them. When the system is switched on again, it
will restore these settings automatically.

Note: The Power Admin utility is only available on workstations
supplied by Sun. Refer to the applicable Sun documentation for a
description of this function.
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Layout and configuration

Overview

The layout of the EM 1002 windows and the way they are
positioned within the four workspaces may be saved into
individual files for each system operator. One factory default
configuration is also available.

The following options are available on the menu:

• Save default layout

• Save operator’s layout

• Read default layout

• Read operator’s layout

• Read factory default layout

• Sounder Status Configuration

• Save Sounder Status Configuration

• Sensor Status Configuration

• Save Sensor Status Configuration

The options are explained on the next pages.

Save default layout

Each user organisation can define its own default layout. Once the
decided layout has been defined, it is saved with this command
option.

Save operator’s layout

Each user can define a personal default layout. Once the decided
layout has been defined, it is saved with this command option.

Read default layout

Use this command to read the user organisation’s default layout.

Read operator’s layout

Use this command to read the user’s personal default layout. To
access the layout, it is important to apply the same operator name
as when the layout was created.

Read factory default layout

Use this command to read the default layout created by Kongsberg
Simrad AS.
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Sounder Status Config...
To access the Sounder Status Configuration dialogue box,
choose the Sounder Status Configuration choice on the Layout &
Config menu on the Launchpad.

Figure 30 - The Sounder Status Configuration dialogue box

Each box in the Launchpad’s Echo Sounder group displays
selected system status parameters. Using this dialogue box, you
can redefine which parameters you wish to have displayed. The
positioning of the buttons reflect the text boxes in the Echo
Sounder group.
Click on the small rectangle in each button to access the list of
choices. The same list is presented for all the buttons. The choice
you make is immediately applied to the Launchpad.
To save the chosen configuration, select the Save Sounder Status
Config command on the Layout & Config menu.
→ Refer to page 68 for a description of the Echo Sounder group on

the Launchpad, and a list of the parameter options available.
→ Refer to page 103 for details about the Status Display dialogue

box, and descriptions of the various parameters.

Save Sounder Status Config
This command saves the chosen configuration for status
information in the Echo Sounder group.
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Sensor Status Configuration

This command opens the Sensor Status Configuration dialogue
box.

Figure 31 - The Sensor Status Configuration
dialogue box

Cancel

(CD4739)

Sensor Status Configuration

OK Help

Roll Tide

Pitch Sound Speed Probe

Heave Height Sensor

Heading No.Of Satellites

Latitude Position Quality

Longitude Position HDOP

Each menu below corresponds to an item in the Sensor
Status area in the Launchpad. Use ‘Layout & Config ->
Save Sensor Status Config’ to save your sensor status
configuration.

Any changes are reflected immediately.

Sensor Status Fields

Each box in the Launchpad’s Sensors group displays selected
sensor status parameters. Using this dialogue box, you can redefine
which parameters you wish to have displayed. The positioning of
the buttons reflect the text boxes in the Sensors group.

Click on the small rectangle in each button to access the list of
choices. The same list is presented for all the buttons. The choice
you make is immediately applied to the Launchpad.’

To save the chosen configuration, select the Save Sensor Status
Config command on the Layout & Config menu.

→ Refer to page 70 for a description of the Sensors... group on the
Launchpad, and a list of the parameter options available.

→ Refer to page 103 for details about the Status Display dialogue
box, and descriptions of the various parameters.

Save Sensor Status Config

This command saves the chosen configuration for status
information in the Sensors group.
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Options

Overview

The Options menu contains the following choices:

• User preferences

• Logging

• Datagram subscriptions

The options in the User preferences dialogue box allows you to
define certain alarms and default settings.

→ Refer to page 96.

The options in the Logging dialogue box allows you to select
which data you will log to disk, and select optional datagrams to
be logged.

→ Refer to page 98.

The options in the Datagram subscriptions dialogue box allows
you to select which datagrams that shall be distributed where.

→ Refer to page 99.
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User preferences

Purpose
This dialogue box allows you to make a number of default settings
to your echo sounder. The modifications you do are implemented
immediately.

Figure 32 - User preferences

Dgrm.Dispatch Period:                1 min

Sensor Audible Alarm

Show Line Statistics

Exceeded Profile Depth Alarm

HelpClose

Sound Speed Max. Offset:     Alarm disabled

Lat./Long. Display Format:     60.333

Auto Logging Interval:             30 min

(CD4509B)

User Preferences

Lat/Long Display Format
This option defines the format of the position coordinates shown
in the Status Display. The following formats are available:
• 60.333° (Decimal degrees)
• 60°20.00’ (Degrees and decimal minutes)
• 60°20’00” (Degrees, minutes and decimal seconds)

Sound Speed Max Offset
This option is used to enable an alarm if the sound speed value
measured by the sensor at the transducer depth differs from the
value defined at the same depth in the current sound speed profile.

Auto Logging Interval
This option sets the time interval used when auto logging is
enabled, or it disables the auto logging feature altogether. The
interval defines the maximum time allowed for a survey line. A
new line is started automatically when this time limit is reached.
Datagram Dispatch Period
This option sets the interval between periodic datagram dispatch
of selected datagram output.
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→ Refer to Datagram subscriptions on page 99.

Sensor Audible Alarm

This option enables the audible alarm for missing sensor input.
When the system does not log, these alarms are only issued to the
Status Display as a warning, but as soon as logging is activated, the
alarm switches to an error situation which defaults to use a audible
signal. The audible signal may be disabled with this switch.

Show Line Statistics

When a line is terminated, a file containing statistical information
about the line is generated. You may toggle viewing this
information automatically using this switch.

Exceeded Profile Depth Alarm

This option enables an alarm if the latest measured water depth
exceeds the depth limit of the sound speed profile. Alarm if latest
measured depth is larger than largest depth from measured/set
value of sound profile. This is independent of the sound profile
being extended automatically.



EM 1002 / Base version

98 850-160977/E

Logging

The Logging dialogue box contains menus for selecting

• Logging media

• Optional Datagrams for logging

All the options in this window are automatically saved to disk to
be used as defaults at the next startup.

Figure 33 - The Logging dialogue box

Logging media

Raw data to disk - This option is always enabled, and it can not
be deactivated.

Survey format to disk - Disabling this function should only be
done if disk-space is limited. Doing this will disable all
geographically referenced displays.

Optional datagrams

In addition to the default datagrams logged during a survey, you
may specify one or more of the listed optional datagrams.

• Seabed Image (must be chosen for Sonar Image to display
properly)

→ Refer to Seabed Image datagram information in the Datagram
Formats chapter in the EM 1002 Maintenance Manual.

• Central Beams

→ Central Beams is not implemented for EM 1002.
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Datagram subscriptions

Description

This dialogue box is used to define which datagrams are sent to
which subscribers. They can be sent to external Ethernet or to
programs on the operator station. This is not used for data output
on serial (lines) ports.

• The datagrams sent to the User defined subscriber are sent to the
IP addresses and port numbers specified in the IP addresses and
IP Port no fields described below.

• The datagrams sent to the System defined subscribers are sent
to the other applications running on the EM 1002 system. You
cannot modify these settings, the information provided is for
verification only.

This information is used to maintain the datagram subscription
setup file. This file contains the following:

• Name of program (The program is called a ’subscriber’)

• IP address of program

• Port number of program

• List of datagrams subscribed to

The subscriber list is maintained with a set of commands available
from the Subscriber Options menu directly below the list.

The initial content of the setup file defines the system programs.
These are programs with datagram setups that cannot be modified.

For the user defined subscribers, you may enter any number of
subscribers, and use the commands and options available to
maintain these entries.

When defining a new subscriber, the Workstation’s IP address is
used as default. The next available port is automatically inserted.
You may change any of these parameters at any time.

• A non-periodic subscriber may select to receive one or more
of the datagrams in the Datagrams list (to the right). Every
datagram of the specified type issued by the EM 1002 will be
sent to the subscriber.

• A periodic subscriber may only receive the installation and
sound speed datagrams. Only one or both of these two
datagrams will be issued by the EM 1002 on an operator
controlled interval. This interval is defined in the User
preferences dialogue box using the Datagram Dispatch
Period setting.
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Figure 34 - The Datagram Subcriptions dialogue box

→ Refer to page 96 for a description of the User preferences
dialogue box.

If the periodic user has selected one or more of the periodic
datagrams, the system automatically enables the periodic timer. If
you de-select all the periodic datagrams, the periodic timer is
deactivated.

The Datagrams list contains the Start and Stop datagram. They
are used to toggle logging on/off by the system. They are basically
identical, except for the datagram identifier. Either of these two
datagrams may be referred to as the Installation datagram,
because they both contain the current installation settings of the
system.
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The IP Addresses list is maintained with a set of commands
available from the IP addresses Options menu directly below the
list. These commands are:

• Add IP address

• Remove IP address

• Modify IP address

There are no restrictions for adding IP addresses.It is not possible
to Remove or Modify an address that is used by one or more of
system programs.

A modified setup is not effectuated until the Apply button is
selected and then only after you have confirmed the modifications.

Subscribers

The following options are available in the Subscribers group.

User - Press this button to access the user defined subscribers.

System - Press this button to view the system defined subscribers.

Subscriber mode - This is an information field. When one of the
subscribers listed immediately below is selected, the subscriber’s
datagram dispatch mode is presented. The modes are either
periodic or non-periodic.

Subscriber options - This selector controls what you can do with
user defined subscribers.

• Add - Define a new non-periodic subscriber to receive
datagrams from the system. A small dialogue box appears to
accept the name of the new subscriber. You can use any name
you like, but maximum 30 alphanumerical characters.

• Add periodic - Add a new periodic subscriber to receive
datagrams from the system. A small dialogue box appears to
accept the name of the new subscriber. You can use any name
you like, but maximum 30 alphanumerical characters.

• Remove - Delete an existing subscriber. A small dialogue box
appears to list the names of the subscribers. Select the
subscriber you wish to remove

• Rename - Change the name of an existing subscriber. A small
text box appears to list the names of the subscribers. Select the
subscriber you wish to rename

IP Addresses

The following options are available in the IP Addresses group.

IP addresses options - This selector controls the IP addresses used
to reach the user defined subscribers.
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• Add - Define a new IP address to be used by the system.

• Remove - Delete an existing IP address

• Modify - Change an exisiting IP address to another value.

IP Port no.

Select an IP address from the list. Enter the port number required
to reach the selected IP address.

Datagrams

This field lists the available datagrams.
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3.3 Status Display

Overview
The EM 1002 Status Display is brought up if you click on any of
the following “name buttons” in the EM 1002 Launchpad:

• Echo sounder...

• Operator Station...

• Sensors...

Once up, the Status Display will automatically bring the selected
information into view. The Status Display is by default resident in
the Survey workspace. It will also pop up to give error messages.

The Status Display window contains two fields; the Status field
with the necessary information provided, and the Message field
with the latest messages displayed. You can scroll through both
fields.

All messages generated by the system are automatically stored in
the message log.

The bottom of the message field contains three buttons:

• Clear - to empty the message field in the window.

• Ackn.Error - to acknowledge a new error report.

• Help - provides on-line help

Echo sounder

Introduction

The Status Display for EM 1002 echo sounder status is shown in
the figure below. It provides auto-mode actual parameters and
system status.

Auto-mode Actual Parameters

The shown values are dynamic and updated continuously. The
settings are made automatically by the system.

→ A brief technical background for the various technical parameters
can be found in the Technical References chapter on page 357.

Depth to Normal Incidence - Current value in meters.

Normal Incidence Backscatter - Current value in dB.

Oblique Backscatter - Current value in dB.

Coverage - The current port side and startboard side (respectively)
angular coverage in degrees.
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Figure 35 - The Echo Sounder parameters, example.

Tx Power Att - The current attentuation of the output power.

Fixed Gain - This field displays the current fixed gain in dB.

Sounder mode - Current operational mode

EM 1002 System status

The following information is provided. The text on green
background means that the function is operational. The values are
dynamic, and are updated continuously.

TRU OK - Feedback from the Built-In Self Test (BIST) system
with he current operational status of the EM 1002 Transceiver
Unit/Processing Unit. The field is green when all is OK, and red
when there is no contact.

Sounder Active/Inactive - Feedback from the Built-In Self Test
(BIST) with the current operational status of the echo sounder. If
a malfunction occurs, or the sounder is switched off, the message
Sounder inactive appears.
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BSP OK - Feedback from the Built-In Self Test (BIST) with the
current status of the Beamforming Single Processing in the EM
1002 . The field is green when all is OK, and red when there is no
contact.

Other status parameters

Ping no - This is a sequential counter. The number increases with
1 for every new echo sounder transmission. It is set to 0 every time
you switch on the Transceiver Unit, or automatically when it
reaches 65535.

Beams - The number on the left side of the slash indicates the
number of beams with valid bottom detection in the current ping.
while the right number presents the maximum possible number of
beams in the present operational mode. Use this as a quality control
measure.

Load - Current processing unit load. The value is presented as a
percentage of maximum load (100%).

Ping rate - Ping frequency, i.e. the number of echo sounder
transmissions made every second. The ping frequency is adjusted
by the system according to the current depth. The value displayed
should therefore correspond to the water depth, as deeper water
will usually result in fewer pings per second.

Depth - Current depth straight down under the vessel’s keel.

Across - Current swath width in meters to port and starboard sides
respectively.

Sv At Trans - The current sound speed at the transducer depth.
This may come from a sensor, from the sound speed profile, or can
be set manually.

Current profile - File name to identify the current sound speed
profile used by the EM 1002 system.

Operator Station

Introduction

The Status Display for the Operator Station is shown on page 106.

The following fields are used:

• Logging selections

• System

• Tape options

• Programs
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• Storage Locations & Remaining Disk Space

Figure 36 - Operator Station parameters

Raw To Disk CPU Load:    4.90%

Free Swap:  200Mb

Free Memory:  47Mb

Surv. Form. To Disk

Raw To Tape

Logging Selections System

Operator Station

Tape Options

Programs

Storage Locations & Remaining Disk Space

Tape Size: 2.5GByte Logging Inactive

Rewind

Raw data:

Survey Format to Disk::

Shared data:

XYZ data:

Root Partition:

1444Mb, /data1/raw

1444Mb, /data1/proc

1444Mb, /data1/shared

1444Mb, /data1/xyz

74Mb, /

Continue

Append

(C
D
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48
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Logging selections
The following incidents are provided:
• Raw to Disk: The raw datagrams from the survey are logged

onto the workstation harddisk.
• Survey Format to Disk: The datagrams are logged in

Kongsberg Simrad Survey format onto the harddisk.
Raw to Disk is always enabled. The Survey Format to Disk
should normally be on, as the program’s geographical displays
require these data to be functional.
→ Further information about the raw and survey datagram formats

are found in the Datagram Formats chapter in the EM 1002
Maintenance Manual.
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System

The following information is provided (the values are dynamic,
and are updated continuously):

• CPU load : The current load of the Operator Station’s CPU. The
value is presented as a percentage of maximum load (100%)

• Free Swap : This is the current size of the system’s swap file.
A large swap file is advantageous. It should typically be at least
twice the size of the system’s initial memory.

• Free Memory : The current size of the free memory the CPU
can use. A large free memory is advantageous. The amount will
vary, but it should not normally fall below 10% of the installed
memory capacity.

Programs

All the programs installed on the EM 1002 Operator Station are
shown with the same icons as used on the Launchpad. The border
colour of each icon shows you the status of each program:

• No border : The program is inactive

• Green border : The program is active

• Red border : The program is active, but has issued a warning
message

Storage Locations & Remaining disk space

These fields display the current storage locations for the various
named files and the remaining disk space on the EM 1002 Operator
Station and/or the peripheral logging devices. If all files are logged
on the same disk or disk partitions, the values presented are
identical. If you log to different disks or disk partitions, you will
see the status of each of them.

• Raw data : Remaining space on the chosen disk for raw data
logging.

• Survey Format to Disk : Remaining space on the chosen disk
for Survey Format logging.

• Shared Data : Remaining space on the chosen disk for Shared
Data logging.

• XYZ Data : Remaining space on the chosen disk for XYZ Data
logging.

• Root partition : Remaining space on the system disk.

If any of these disks (or disk partitions) are filled up to maximum
allowed level, the system will issue appropriate warnings. When
50 Mb space remains, a yellow colour appears. When 10 Mb space
remains, a red colour appears.
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Sensors

Introduction

This part of the Status Display presents current information about
the sensors.

Figure 37 - Sensor status parameters
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Sensor data

The following information is provided (the values are dynamic,
and are updated continuously):

Time - This is the current system time.

Roll - This is the current roll of the vessel corrected for roll offset
in the motion sensor.

Pitch - This is the current pitch of the vessel corrected for pitch
offset in the motion sensor.

Heave - This is the current heave of the transmit transducer
positive downwards and with lever arm corrections applied.

Heading - This is the current heading of the vessel corrected for
heading offset in the active heading sensor.
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No. of Sat - The actual number of positioning satellites curently
detected by the positioning system

Pos (H)DOP - The current HDOP (Horizontal Dilution Of
Precision) value from the positioning system.

Pos. Quality - This is an indicator for the relative accuracy of the
current position. The value is calculated from information in the
position telegrams. A low value is good, and presents accuracy
measured in meters.

Probe SV / Sound Speed Probe - The current sound speed
measured by the sound speed probe at the depth displayed in the
Probe depth box.

Probe depth - the current depth of the sound speed probe.

Tide - This value presents the current tide.

Latitude (Lat) - This value presents the vessel’s current latitude.

Longitude (Long) - This value presents the vessel’s current
longitude.

Note: SIMRAD 90 position format datagrams do not contain (H)DOP or
number of satellites.

Input status

The following information is provided. Grey colour is used for an
input not in use, while green means that the sensor input is in use
and working well. Red colour is used to indicate an input sensor
supposed to be in use, but not receiving any data.

Position Port 1/3/4/Ethernet - indicates if the positioning system
is active (or not) on serial ports 1, 3 or 4 or Ethernet

Attitude - indicates if the attitude sensor input is working or not.

Heading - indicates if the heading sensor input is working or not.

Clock - indicates if the external clock input is working or not.

Depth / Height - indicates if the external sensor is working or not.

1 PPS - indicates if 1PPS is working or not.
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4 EM 1002OPERATION MENUS

4.1 Introduction

Purpose
The purpose of this chapter is to provide detailed information
about the commands and parameter settings in the EM 1002
installation, test and runtime setup dialogue boxes. These are all
accessed from the Runtime Menu window.

The following topics are covered:

• Overview (page 111)

• Runtime Menu (page 113)

• Installation Menu (page 124)

• Manual control (page 140)

• Simulator (page 143)

• Built-In Self Test (page 145)

Note that the EM 1002 system comprises several additional
graphical applications. These are explained in separate chapters in
this manual.

Access
The Runtime Menu dialogue box is started automatically when the
EM 1002 is started, and it is by default placed in MBES
Workspace. If you close it by accident during a logging session,
you can restart it by clicking the icon in the Program group on the
EM 1002 Launchpad. You may access the Runtime Menu at any
time if it is required to adjust certain parameters, but under normal
operating conditions these settings should be defined while not
logging and then remain unchanged during logging.
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4.2 Organization and main menu

Purpose
All setup for the EM 1002 is accessed through the Runtime Menu
dialogue box. The purpose of the Runtime Menu dialogue box is
to allow you to modify the parameters used by the EM 1002
multibeam echo sounder during operation as conditions change.
These parameters are important because they define how the
system and its peripheral sensors operate.

• Runtime Menu consisting of

- Sounder Main
- Sound speed
- Filtering

- Absorption Coeffisient
- Seabed Imaging

Main menu
The main menu bar on the top of the Runtime Menu dialogue box
contains three options:

• File

• Show

• Help

File
When you select File on the menu bar, the following commands
appear on the drop-down menu:

• Read

• Open...

• Save

• Save as...

Read

Select Read to open the current set of previously defined
parameters saved on the hard disk.

Open...

Select Open... to retrieve a chosen set of previously defined
parameters saved on the hard disk.
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Once the system is enabled to accept changes to the operation
parameters, you are prompted with a small window to select a
setup file.

Save...

Use this option to save all the current operating parameters on the
system’s default user setup file. Note that the file will be updated
permanently. No warnings are given before you replace the
existing file with the new set of parameters.
esoEM1002setup.runtime.YYYY_mmdd_hhmm

Save as...

Use this option to save all the current operating parameters as a
new parameter setup file you can define for your own use or for a
specific installation.

Show
The Show menu allows you to choose between the various views.
The following options are available on the menu:

• Runtime Parameters (page 113)

• Installation Parameters... (page 124)

• Testing (page 145)

- Manual Control (page 140)

- Simulator (page 143)

- BIST (page 145)

Help
This option provides on-line documentation.
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4.3 Runtime Menu

Overview
The Runtime Menu is available by default.

Figure 38 - The Runtime menu dialogue box
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The dialogue box gives you access to the following parameter
groups:

• Sounder Main

• Sector Coverage

• Sound Speed

• Filtering

• Absorption coefficient

• Seabed Imaging

All these parameter groups are visible simultaneously.

Sounder Main

Overview

These parameters allow you to:

• define the ping mode, the desired swath coverage and the beam
spacing

• define maximum port and starboard coverage.

• define the maximum and minimum depth for the echo sounder

• force a desired depth

Figure 39 - The EM 1002 Sounder Main field

Ping mode

This parameter defines the operational mode of the EM 1002
multibeam echo sounder. You can select any of the following
settings:

• Auto

• Shallow
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• Medium
• Deep
During normal operating conditions, you are advised to set the ping
mode to Auto. The system will then automatically use the most
appropriate mode, and - if necessary - switch between the modes
to obtain maximum coverage.

Sector Coverage
This parameter specifies the level of filtering of the heading.

Max port / starboard angle
These parameters allow you to define the maximum swath width
by setting the maximum port and starboard angles. The values are
entered in degrees.

Max coverage port / starboard
This parameter allows you to define the maximum swath width to
each side by selecting values in meters. The port and starboard
angles (as defined above) will then be adjusted accordingly by the
system. To make use of these settings, you must set Angular
Coverage to Auto.

Angular coverage
Manual - If Angular Coverage is set to manual, the values defined
as Max port and starboard angle above (in degrees) are used
directly. The Max coverage port and starboard settings (in
meters) are not used in this case. Be aware that the outermost
beams may be lost if the angular coverage set is larger than the
coverage capability at the current depth.
Auto - If Angular Coverage is set to Auto, the maximum coverages
(in meters) and the maximum angles will set the swath width limit.
The actual angular coverage will always be set so that almost all
the beams have valid detections. You may observe this in the
Launchpad’s echo sounder status display, as the numbers of beams
accepted should almost equal to the number of beams available.

Beam spacing
Depending on the purpose of the survey, you may define the
distribution of the beams on the seafloor.
Equidistant - This setting gives a uniform distribution of
soundings on the seafloor, and it is the normal mode for a
bathymetric survey.
Equiangle - The beams are distributed with an equal angular
spacing based on the angular coverage used. This gives many
soundings close to the centre of the survey line, and few on the edge
of the swath.
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In-between - Earlier the equiangle beam spacing was
recommended for seabed imaginery. However, the very few
soundings on the edge of the swath reduced the accuray of the
imaginery positioning, and makes them not so good for
bathymetry. Thus this in-between mode is introduced, giving a
higher density in the central part of the swath (near-equiangle) and
a acceptable density in the outermost parts (near-equidistant).

Minimum and Maximum Depth

These parameters allow you to define the operational depth range.
This range should normally be wide enough to cover all depths
encountered during the survey, as only depths within this range
will be accepted by the system.

A narrow range will help the system in bottom tracking under
difficult conditions. Exceptionally, it may be necessary to
temporarily narrow the range to assist the system in bottom
tracking. However, you must then monitor the actual depth closely,
and adjust the depth window as often as required.

Note: It is very important that valid depths are entered here when the
echo sounder starts ’pinging’. If the bottom depth exceeds the
limits with more than 10%, the sounder will not lock. It may
therefore be useful to enter larger values in the beginning to accept
a more dynamic depth, even though this may slow down the initial
bottom detection when the system is started.

If the bottom depth exceeds the limits given here it will simply
loose track. The true depth should therefore be monitored closely,
and compared with the settings here during the survey.

Minimum Depth (m)

Set the minimum limit of the depth range.

Maximum Depth (m)

Set the maximum limit of the depth range.

Force Depth

When the echo sounder is switched on and starts transmitting, or
if it looses the bottom track, you may sometimes find that it has
problems in finding or recovering the bottom. This happens
typically at extreme depths, and especially if there is a lot of
acoustic interference or if the water is very aerated. In order to help
it, you can then enter the correct depth. This depth may be taken
from your navigational charts, or from a navigation sounder
elsewhere on the vessel. Forcing the depth will cause the system
to set its gain and range windows accordingly, and ignore its own
findings about where the bottom is.
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Sound Speed

Overview

This parameter group has two subgroups:

• Sound Speed Profile

• Sound Speed at Transducer

• Sea Temp at Transducer

Figure 40 - The Sound Speed field

Sound Speed Profile

The Sound Speed Profile parameter allows you to select the sound
speed profile to be used in the EM 1002’s depth calculations. These
calculations are based upon ray bending theory, and the importance
of a correct sound speed profile can not be underrated.

The accuracy of the depth data obtained from the system is usually
critically dependent upon the use of a correct sound speed profile.
You must ascertain that the applied profile always corresponds to
the real conditions. On the average errors in the sound speed profile
should not be larger than about 0.5 m/s.

Sound speed profiles are organized as separate files. These may be
edited with the Sound Speed Profile (SSP) Editor. New profiles
may be created with the editor or imported into the system from
another computer or sound speed probe.

→ The SSP Editor is described on page 321.

Current Sound Profile

This button is pressed to select and make active a new sound speed
profile.

When this button is pressed, a standard file selection box appears.
This box is used to select a file and make the sound speed profile
active.

→ How to use the File selection dialogue box is described on page
41.
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To select a new sound profile, click on the arrow on the right side
of the name field and then click on the appropriate sound speed
profile file name.

A warning will be given if the profile is more than 24 hours old, or
if there exists a newer profile.

Sound Speed at Transducer

Note: When the surface sound speed varies much with time, position and
especially with tilted sonar head(s), it is recommended to install a
sound speed sensor close to the transducer face!

This is especially important for a curved transducer as used with
the EM 1002..
→ Sound speed errors are described on page 350.

The sound speed value from the sensor will automatically be used
as first value in the sound speed profile for depth/raybending
calculations and for beam steering.

Note: This can be disabled by the Use Transducer Dept. parameter in the
Show->Test-> Manual Control window, but this is not
recommended.

The sound speed sensor at the transducer may also be used as a tool
to give a warning when the sound speed profile is varying too much
from the real-time value from the transducer sensor, provided this
is set in the option menu. If the deviation is too large, a new profile
should be taken.

To select the source for the Sound Speed at Transducer depths,
select any of these three options:

From Profile

The system will use the active sound speed profile to derive the
sound speed near the EM 1002 Sonar Head. If no matching depth
is found in the profile, an interpolated value is used.

From Sensor

The readout from the specific sensor is used.

Manual

The EM 1002 system will use the sound speed you define.

Caution: The manual setting is intended only for experienced operators !

Sensor Offset (m/s)

This control is used to set a correction offset if the From sensor
source is chosen. The offset will be added to the sound speed values
received from the sound speed sensor.
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Note: When a new profile is taken into use, always set the offset so that
the sensor value is the same as that in the profile at the transducer
depth. This is most easily done by switching between deriving the
sound speed at the transducer depth from the profile and from the
sensor as the offset is changed.

Sound Speed (m/s)

To set the sound speed at transducer directly to a fixed value. This
function is only used if Manual is selected.

Filter(s)

If From Sensor is selected, the length of the filtering of the sensor
data can be selected (1-60 seconds). This also sets the update rate.

Sea Temp. at Transducer

The transducer has a coating with a sound speed which differs
significantly from water sound speed. As electronic beam steering
is used for all beam angles larger than 50°, outer beam pointing
angle accuracy is dependent on the coating sound speed being
known to the system. As this sound speed is temperature
dependent, the coating temperature must be known to the system.
To give the system the coating temperature, a sound speed probe
at the transducer depth may be equipped with an additional
temperature sensor. The temperature sensor may otherwise be
manually set or alternatively be derived from the sound speed if the
salinity is known. The latter is recommended in open water where
salinity does not vary, otherwise the use of a combined sound
speed/temperature probe is recommended.

From Sensor

The readout from the temperature sensor is used.

From Salinity

When From is set to “Salinity”, the salinity value you enter here
will be used together with sound speed at transducer depth to
calculate temperature.

From Manual

The sea temperature you enter will be used.
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Filtering

Overview

There is always a small risk of false detections in a multibeam echo
sounder. This is due to external factors such as fish shoals,
acoustical interference from other systems, passing over vessel
wakes, etc. According to bottom conditions, you can apply the
included filters to assist the system in discriminating against
erroneous measurements. It is recommended to try different filter
settings than the standards only if the occurrence of false
detections is too high to be acceptable.

Figure 41 - Filtering, Absorption Coeffisient and
Seabed Imaging fields

The recommended settings are:

• Spike Filter Strength: Medium

• Slope: On

• Sector Tracking: On

• Range gate: Normal

The bottom detection is performed in two passes in each ping.
Filtering is performed after every pass.

• The first pass is done on all beams individually.

• The second pass is done only on beams which lack valid
detection. However, the system then uses relaxed acceptance
criteria within range windows derived from neighbouring
beams with accepted detection.

It is always beneficial to eliminate erroneous measurements before
postprocessing. In addition, if a false detection in a beam is
eliminated in the first pass, a valid detection may be acquired in the
second pass.
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Spike Filter Strength

This selector button is used to define to what degree a non-smooth
bottom is to be accepted. The filter remove beams with depths that
deviate too much from a smoothed bottom profile as derived from
the detected beams. The stronger filtering, the less deviation is
accepted.

If you select Off, no filtering will takes place. Recommended
setting is Medium.

To detect an object (for example a wreck) on a flat seabed, it may
be necessary to switch this filter off to detect the object properly.

Slope

With this filter enabled, the EM 1002 system checks for bottom
slopes that tilt inwards. These slant towards the vessel, and they are
removed because the filter requires that the athwartships distance
increases for every beam from the centre. Such detections are
normally false, and after removal a new bottom detection is
performed searching for a value with increased range.

Figure 42 - Slope filter principles

This Slope filter should normally be enabled.

→ The Slope filter is described visually in figure 42.

Sector tracking

This setting does not affect the depth measurements, only the
backscatter strengths.
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Range gate

When the system detects the bottom, it will perform the search
within a predefined depth window, where the depth limits are
based on the information from the previous pings. The range gate
setting is used to determine the size of this window, and you may
choose between theese settings;

• small

• normal

• large

If the depth varies considerably (more than 10%) it may be useful
to select a large range gate, but this may also increase the chance
for false echoes from side lobes, interference or other noise
sources.

Selecting a large range gate may reduce the ping rate slightly when
operating in shallow waters.

The EM 1002 transmitter operates with three pulses within each
ping when the coverage exceeds 100 degrees. This setting will turn
on an automatic gain compensation to avoid gain steps between
these sectors. During normal operations, the Sector Tracking
should be on. However, if the survey specifications demand a fully
calibrated system for seabed image data, this function should be
turned off.

Absorption Coefficient
The setting in this field is used to define a value for the average
absorption coefficient through the water column at 95 kHz.

Figure 43 - Absorption Coefficient
and Seabed Imaging.
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The absorption coefficient depends upon depth, water
temperature, salinity and frequency. A correct value is important
with respect to the validity of the bottom backscatter data
measured by the system.

→ Absorption coefficients are described in more detail on page 365.

The Absorption Coefficient can be entered manually or can be
calculated from an Absorption Coefficient profile.

The Absorption Coefficient values can be calculated from a sound
speed profile that includes information necessary to calculate an
Absorption Profile. Use the Auto command to activate use of such
a profile, which will increase the accuracy of the bottom
reflectivity data. If Auto is selected, the absorption coefficient
value displayed will change continuously depending upon the
depth.

The system contains a default absorption coefficient profile. If you
have not measured your own profile, Kongsberg Simrad
recommends that you DO NOT use the default profile by selecting
Auto.

HI / LO frequency ratio

Because the EM 1002 uses two different frequencies (93 and 98
kHz), the absorption coeffisient will vary slightly (for example 30
db/km for 93 kHz, 31.2 db/km for 98 kHz). The ratio of the HI/LO
frequencies is to be set in this field.

Seabed Imaging

TVG Crossover

This value is used to define the angle at which the bottom
backscatter can be assumed to not be affected by the strong
increase at normal incidence. The optimum crossover angle will
vary with the bottom type.

For seabed imaging, it is important to adjust this angle so that a
minimum of angle-dependent amplitude variation is seen in the
Seabed Image data display. This is to give best use of its dynamic
range. The bottom backscatter strengths in the ping display are not
affected by this setting.
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4.4 Installation Menu

Overview
The Installation Menu is accessed from the Runtime Menu
dialogue box by selecting Installation Parameters from the
Show menu. The Runtime Menu is started automatically when
the echo sounder is started, but you can also open it from the
Launchpad.

You may use the Installation Menu dialogue box at any time if it
is required to adjust certain parameters, but under normal
operating conditions these settings should not be tampered with.
The parameters are controlled with a password.

Once activated, a large window opens to view all the settings
simultanously. This window gives you access to the following
parameters:

• TRU Input Interfaces

• Active Systems

• Motion Sensor

• Height Sensor

• Stand-Alone Heading Sensor

• Clock

• Misc. External Trigging

• Sensor Location

• Installation Angles

• System Parameters

The top of the Installation Menu dialogue box contains the
following options in the main menu bar:

• File

• Edit

• Help

Main menu

File

When you select File on the main menu, the following menu
appears:

• Read
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• Open...

• Save

• Save as...

• Close window

Read

Select Read to open the current set of previously defined
parameters saved on the hard disk. Before you can read this setup
file, you need to enable the EM 1002 to accept changes. To do this,
select Edit on the menu bar and choose Edit enable. See below for
further information.

Open...

Select Open... to retrieve a chosen set of previously defined
parameters saved on the hard disk. Before you can open a
parameter setup file, you need to enable the EM 1002 to accept
changes. To do this, select Edit on the menu bar and choose Edit
enable. See below for further information. Once the system is
enabled to accept changes to the installation parameters, you are
prompted with a small window to select a setup file.

Save...

Use this option to save all the current installation parameters on the
system’s default user setup file. Note that the file will be updated
permanently. No warnings are given before you replace the
existing file with the new set of parameters.

Save as...

Use this option to save all the current installation parameters as a
new parameter setup file you can define for your own use or for a
specific installation.

Close window

Use this option to close the Installation Menu dialogue box. You
can reopen it by selectiong Installation Parameters from the
Show menu.

Edit

The Edit option on the main menu bar contains one option: Edit
enable.

Edit enable

Before you can change anything in the Installation Setup window,
you need to enable the EM 1002 to accept changes to the
installation parameters. To do this, you must select Edit enable,
and then enter the password.
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If a password does not exist, you are prompted to enter one. Note
that this password is common for all EM 1002 operators.

Further information about this password is found in the System Administration
chapter in the EM 1002 Maintenance Manual.

Help

This option provides on-line documentation.

TRU Input Interfaces

Overview

The EM 1002 Transceiver Unit is equipped with four serial ports
to interface external time critical sensors. These parameter settings
allow you to select which sensors are connected to the various
ports. The dialogue is also used to set the communication
parameters for each selected interface port.

• A separate heading sensor is not required if the heading is
available from the motion sensor.

• Up to three positioning system may be connected to the EM
1002 Processing Unit and logged, but only one of these can be
active at any one time.

• Two heading sensors may be used (one with the motion sensor
data), but only one can be active at any one time.

• A third positioning system may be used on the Ethernet.

• Two motion sensors may be used, but only one can be active at
any given time.

• Only one clock input is allowed.

• On one port several sensors may be connected provided their
datagram formulas have clearly defined start and stop
characters (such as NMEA datagrams). However, not more
than one sensor of a specific type, such as a positioning system,
is allowed per port.

Several input types are available, and the list presented will depend
on the serial port you selected and the settings made for positioning
system and heading system input.

Port 1 : is initially available for general purpose, such as a
positioning system, external clock or heading sensor.
It is normally allocated for a positioning system. Itwill
not accept inputs from motion sensors.

Port 2 : is reserved for the motion sensor. No other sensor
type may be connected to this port.
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Figure 44 - TRU Input Interfaces

Input On:   Port 1

TRU Input Interfaces

HDT Heading

NMEA 0183 DPT Depth

ZDA Clock

Height

NMEA 0183 DBS Depth
GST Pos. Quality

Reset Selections

1200 2400 4800

9600 19200

2 71 8

None              Odd                Even

(CD4353EB)

Simrad90 Positions
GGA Positions
GGA - RTK Positions
GGK Positions

Port 3 : is initially available for general purpose, such as a
positioning system, external clock or heading sensor.
However, if the heading is retrieved from an SKR
80/82 (or an LR 40/60) gyrocompass (repeater), it can
only be connected to this port. Also a second motion
sensor can only be connected to this port.

Port 4 : is initially available for general purpose, such as a
positioning system, external clock or heading sensor.
It is often connected to an external clock.

The external clock is usually not required, unless the timing of the
position data relative to the depth data demands one, or if it is
wanted as the source for the setting of the system clock.
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→ See the description of the Position delay on page 130.

Input On

This selector button is used to select which of the four interfaces
to display in the dialogue box shall apply to.

Serial line specifications

Parity - Use these buttons to select the parity for the currently
selected serial port.

Stop Bits - Use these buttons to select the number of stop bits for
the currently selected serial port.

Data Bits - Use these buttons to select the number of data bits for
the currently selected serial port.

Baud Rate - Use this selector to define the baud rate for the
currently selected serial port.

Input formats, Serial Port 1/2/3/4/Ethernet

This area allows you to define what type of external sensor is
connected to the serial interface port you selected with the Input
On button.

Inputs in the following formats are available:

• Simrad90 Positions

• GGA Positions

• GGA - RTK Positions

• GGK Positions

• GST Pos. Quality

• NMEA 0183 DBS Depth

• NMEA 1083 DPT Depth

• Height

• HDT Heading

• ZDA Clock

• Attitude (on port 2 or 3)

• MK39 (only on Port 3)

• Motion sensor 2 (only on Port 3)

• SKR Gyrocompass (only on port 3)

Refer to EM 1002 in chapter Datagram Formats in the EM 1002
Maintenance manual for a description of these formats.
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Positioning Systems

Overview

You can connect three positioning systems to the EM 1002
multibeam echo sounder, but only one of them can be active at any
one time. One positioning system may be connected on Ethernet
instead of serial line. For each of these positioning systems, you
need to define certain basic parameters.

Figure 45 - Positioning Systems

Positioning System On

Up to three positioning systems may be defined. Data from all of
them are logged, and may be used in post-processing. However,
only the positioning system you have selected as “active” will be
used by the EM 1002 system in its real-time displays.
→ Refer to page 131 for a description of the Active Positioning

System parameters where the selection is made.

Use this selector to choose which positioning system you wish to
alter the parameters for. The positioning system is thus not
identified by its name, but by the serial line it is connected to.

The following ports are available:

• Port 1

• Port 3

• Port 4
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• Ethernet

Time To Use

Usually the system’s internal time should be used during logging,
since the clock reference then will be identical for both positions
and depths. Any time delay in the positioning system and the data
transmission from the sensor must be taken into account. This is
done by defining a fixed average position delay.

If this delay is not sufficiently constant - and provided that the time
stamp in the position datagram is the time when the position was
valid - the input datagram’s time stamp may be used. However, it
must then be assumed that the EM 1002 and the positioning system
clock are both synchronized with the 1PPS signal, and that any
time difference between the two clocks are entered as a position
delay.
→ For more information on timing, refer to page 360.
System The EM 1002 will use its own internal time stamp

when applying positions to the realtime display.
Datagram This choice allows the use of the time stamp in the

input datagram when applying positions to the
realtime display.

Note: Both time stamps are stored, so the choices made can be redone in
post processing!

Pos. Motion Correction

When the vessel moves due to roll, pitch and heave the antenna on
the positioning system moves as well. This parameter allows the
system to compensate for this movement by adjusting the values
from the positioning system based on the current information from
the motion sensor(s).

Correct timing of the positions is very important if motion
correction is to improve position accuracy.

Position Delay

This parameter is used to define the “age” of the position in the
position datagrams.

The relative timing of vessel position data and system depth data
is critical to the total achievable accuracy. The best solution is if it
can be assured that the position datagrams are always received by
the system with a fixed and sufficiently constant age with respect
to the time of validity of the enclosed positions. This age is the
position delay to be entered. Such a solution will make the use of
any clock synchronization of the system with the positioning
system unnecessary.
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Datum
This parameter enables you to select which datum the positioning
system uses. The datum specific parameters are also shown in the
window. These describe the ellipsoid that defines the datum.
• Major Axis
• Flattening

Active Systems

Active Positioning System On
This selector button is used to choose which positioning system
you wish to use as the active positioning system. The positioning
system is thus not identified by its name, but by the serial line it is
connected to.
• Port 1
• Port 3
• Port 4
• Ethernet

Figure 46 - Active Positioning System

Active Pos Filtering
The Active Pos Filtering makes it possible to filter the position
data. This is done in real-time.

Pos Filtering
Selecting this button makes it possible to remove spikes from
positioning data.

Ships Max Speed (kn)
To remove the spikes from the positioning data, you need to set the
limit in knots for the spikes to be removed.
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Figure 47 - Active Pos. Filtering

Motion Sensor

Overview

The motion sensor is presumed to measure the vessel attitude of
some specified point on the vessel. The sensor must thus be aligned
with the vessel, not the system’s transducer(s). Any angular
transformations required due to the transducer(s) not being aligned
parallel with the vessel’s forward axis will be done by the system.

If the motion sensor is programmed to calculate attitude at a
different location than where it actually is mounted, this must be
taken into account when describing the motion/attitude sensor
location. The “virtual” site must then be entered, not the real one.

The roll reference plane convention used by the sensor may be
defined in two ways, both are handled by the system.

Figure 48 - The Motion Sensor
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Offset Angles

Roll Offset (deg)

This setting is used to set a correction offset for roll values received
from the Motion Sensor.

The offset will be added to the roll values received from the
Motion Sensor. If the roll offset is found using the system’s built-in
calibration utility it should be applied without any change of sign.

Pitch Offset (deg)

This setting is used to set a correction offset for pitch values
received from the Motion Sensor.

The offset will be added to the pitch values received from the
Motion Sensor. If the pitch offset is found using the system’s
built-in calibration utility it should be applied without any change
of sign.

Heading Offset (deg)

This setting is used to set a correction offset for any heading values
received from the Motion Sensor.

The offset will be added to the heading values received from the
Motion Sensor. If the heading offset is found using the system’s
built-in calibration utility it should be applied without any change
of sign. If the heading offset is found by other methods, for
example by a calibration with the vessel tied to a quay:

• a positive offset must be entered if the sensor reading is too
“small” with respect to the true heading.

• a negative offset must be entered if the sensor reading is too
“large” with respect to the true heading.

Delay

This parameter is used to define the expected time delay of the
motion data.

If the data from the attitude sensor are delayed with respect to when
they were valid, this may be corrected by the system provided the
delay is known. This delay may be due to filtering and/or
processing time in the sensor, and should be provided by its
manufacturer. Some sensors are able to compensate for such
delays by a prediction, but it is not advisable to use such a feature.

Roll Scaling

It has been found that at extreme and rapid roll some motion
sensors can give a slight overshoot. A small change in scaling may
improve the results.
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Roll Reference
This selector button is used to define the reference plane against
which the angle for roll is measured.
Horizontal (Hippy) - Select this alternative if roll is measured
against the horizontal plane, i.e. against the plane normal to the
gravity vector. This is the convention used by the Hippy 120, often
emulated by other sensors.
Pitch Roll axis plane - Select this alternative if roll is measured
against a plane defined as horizontal in the acrosstrack direction,
but following the vessel pitch in the alongtrack direction, i.e. as a
rotation around the forward axis of the vessel coordinate system.
This is the convention usually used by inertial systems such as the
POS/MV (the Tate-Bryant convention).

Stand-Alone Heading Sensor

Overview

The EM 1002 system must have access to the vessel’s current
heading. The data may be received from the motion sensor, or from
another sensor (for example a gyrocompass or a dual GPS reciever
system).

Figure 49 - Stand-alone heading sensor

Heading Offset

This selector is used to set a correction offset for the heading values
received from the Heading Sensor.
The offset will be added to the values received from the heading
sensor. If the heading offset is found using the system’s built-in
calibration utility it should be applied without any change of sign.
If the heading offset is found by other methods, for example by a
calibration with the vessel tied to a quay:
• a positive offset must be entered if the sensor reading is too

“small” with respect to the true heading.
• a negative offset must be entered if the sensor reading is too

“large” with respect to the true heading.
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Clock

Overview

The EM 1002 system has an internal clock with 1 millisecond
resolution. This clock is used to time stamp all logged data. The
drift of the internal clock can be several seconds per day. The clock
may be synchronized to an external 1 pulse per second (1PPS)
signal. This signal will then determine the clock’s drift rate, and in
practice reduce it to zero using a GPS receiver as source.

You may set the internal clock’s date and time to the values found
in the datagrams sent to the system, either from a connected
external clock or from the positioning system, or to that of the clock
in the Operator Station.

Figure 50 - The Clock

Such setting is only allowed while defining a new survey. The
relative time stamp values will then be constant (without any
“jumps”) throughout each survey.

At power on the system will also set it’s clock in accordance with
the option chosen here.

For more information about timing, please refer to the Clock in the
Datagram formats chapter in the EM 1002 Maintenance manual.

Set Source

This selector is used to define the source for the synchronization
of date and time. The following options are available:

• External clock (UTC time received in ZDA format)

• Operator Station

• Active Positioning System

Clock Offset

This offset value is applied to the source time. Use it to offset the
source time to the local time or whatever time zone you require.
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1PPS Sync

Click to turn on the 1 pulse per second external clock
synchronization.

Misc. External trigging
This option enables external trigging of the EM 1002 echo sounder
system.

Figure 51 - External triggering

More about the External Triggering can be found in the EM 1002
Maintenance Manual.

Sensor Location

Overview

In order to make accurate measurements, the EM 1002 must know
the physical location of all the sensors and its own transducers.

These locations must be related to the vessel’s reference point. The
position of each system must therefore be given as a forward (X),
downward (Z) and starboard (Y) position relative to the reference
point. The coordinate system assumes that the X-axis follows the
vessel’s keel, and that the X-Y plane is horizontal while the vessel
is in normal trim.
→ The vessel’s coordinate system and reference point is described in

the EM 1002 Installation manual.

Positioning systems

These settings are used to define the physical location of the
selected positioning system’s antenna. The downward positions
are required if RTK is to be used to position the bottom with respect
to a datum vertically.

Note: The downward position will also be used if the positions are to be
corrected for vessel attitude. This requires that the actual physical
antenna position is entered and that the given position is at the
antenna.
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Figure 52 - Sensor Location

The position data you define here may however not necessarily
always be the physical location of the antenna. This is because
settings in the positioning system’s own software can redefine the
location of the antenna. The XY values of the soundings are
referred to the location of the active positioning system, and it is
this “virtual” position that you must enter.

Transducer

Use these settings to define the physical location of the lowest
point of the transducer array.

Motion sensor

The Motion Sensor parameters allow you to define where the
sensor is physically located, or where its data are valid.

Waterline

Enter the vessel’s waterline (in normal trim) related to the vessel’s
reference point. The value should be an average of two
measurements; one on each side of the vessel. The measurement
must be made at the same alongship location as the physical
location of the motion sensor.

Note: If the vessel’s deplacement or trim changes during a survey, this
value must be updated accordingly.
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Installation Angles

Overview
After the installation of a transducer array, it must be measured
accurately to find the angles between the transducer and the vessel
coordinate system.

Transducer

Use this setting to enter the installation angles. These settings are
normally entered once and for all, but if the vessel undergoes major
repair or maintenance and the array is moved, all the installation
checks must be repeated and new angles defined.

System Parameters

Overview
These are general system parameters. These settings are normally
entered once and for all.

Figure 53 - System Parameters

Hull Unit included

The EM 1002 may be supplied with or without a hull unit with
mechanical pitch compensation. Set Yes or No here as applicable
with your system.

Tilt Offset (deg)

This setting is used to compensate for a fixed tilt setting of the hull
unit.

Gain Offset (dB)
This setting allows you to compensate for a gain offset between the
system and any difference in its backscatter measurement and any
other systems you wnat to use as a reference. The gain offset may
need changing with the aging of the system transducer(s).
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HI / LO Frequency Gain Difference

The system uses three sectors with a higher frequency (98 kHz) in
the middle and a lower in the outer two (93 kHz). Depending on
the actual transducer, this may result in a gain difference in the
backscatter measurements. The HI / LO Frequency Gain
Difference parameter will allow you to compensate for this
difference.

Outer beam angle offset

The pointing angles of the outer beams of the EM 1002 depend on
the sound speed of the transducer coating material. This parameter
will allow you to add a correction for this effect. The value may
need changing with transducer aging and sea temperature (a
compensation for temperature is built into the system software, but
it may not be 100% effective). The actual parameter value must
be found by estimating the beam pointing angle error in degrees by
comparing the depths measured in th eouter beams to those of the
beams. This is most easily done by running two lines
perpendicularly and using the roll calibration applications to find
the beam pointing angle offset.
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4.5 Manual Control

Overview

The Manual Control options are available on the Test, Simulator
and Manual Control dialogue window.

Using the Manual Control options, you can overrun several of the
parameters set automatically by the echo sounder. We strongly
advice you not to do this unless you are very familiar with the
system, and well aware of the consequences these changes may
have on your survey.

Figure 54 - The Manual Control field
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Manual Control

Tracking

This setting is used to control the bottom tracking method used by
the EM 1002 system.

The available options represent different degrees of automatic
control. Bottom tracking requires good estimates of the ranges to
the bottom and bottom backscattering strength which again are
used to set the system gain. These values may either be set by you,
or automatically estimated by the system.

Manual

The automatic control of the Fixed Gain, Oblique Backscatter,
Normal Incidence Backscatter level and the TX power level, is
disabled. The values entered by you will be used instead.

No bottom tracking will be performed, the range gates will be set
assuming a horizontal bottom at the depth specified by the Depth
To Normal Incidence parameter.

Range Only

The system will perform normal bottom tracking.

As in manual, the automatic control of the Fixed Gain, Oblique
Backscatter, Normal Incidence Backscatter level and the TX
power level, is disabled. The values entered by you will be used
instead.

Range & Gain

With this setting the system will do bottom tracking and control the
gain fully automatic. This is the normal setting.

Note: The selected option should normally be Range & Gain. Other
alternatives should only be selected for test purposes, or under
exceptional conditions if the automatic bottom tracking is not
working properly.

Depth to Normal Incidence

The strongest echo from the bottom is usually the first echo which
arrives from where the sound pulse hits the bottom
perpendicularly. The model uses two parameters to describe this
echo:

• Depth (equal to range on flat bottom) to normal incidence

• Normal incidence backscatter strength

The Depth to normal incidence parameter is used only if tracking
is set to Manual. This parameter will be used as the depth to set the
range gates, and for the TVG calculations.
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Oblique Backscatter

This parameter is used to set a value for the oblique backscatter
strength.

As the incidence angle decreases, the echo strength falls rapidly.
From about 10 to 25 degrees (depending on bottom type) it may be
modelled by the geometry and a single parameter: the oblique
backscatter strength. The model used in the system assumes the
bottom backscatter strength to vary linearly with incidence angle
up to 25 degrees, and to decrease in accordance with Lambert’s law
for larger angles. In addition the model assumes the bottom to be
flat, and that the signal is attenuated by spherical spreading and
absorption loss in the water column. The value is used only if the
tracking mode is set to Manual or Range only.

Normal Incidence Backscatter

This parameter is used to define a value for the backscatter strength
at normal incidence. The value is used only if the tracking mode
is set to Manual or Range only.

Fixed Gain

The preamplifier system has two independent gain controls; a
fixed gain consistent during each ping, and the TVG (Time
Variable Gain) setting implemented in the system software. Use
this selector to set the value of the fixed gain. The value is used only
if the tracking mode is set to Manual or Range only.

TX Power

You can set this parameter if you need to reduce the output power
from the EM 1002 system. The normal setting is Full, you can
reduce it to -10dB or -20dB. This value is used only if Tracking
is set to Manual or Range only.

Use transducer depth sound speed in raybending
calculations

If this function is activated, the sound speed measured at the
transducer depth is used as the start point for the raybending
calculations. It is strongly recommended to have this option
activated.
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4.6 Simulator

Overview
The Simulator options are available on the Test, Simulator and
Manual Control dialogue window.
The built-in simulator allows you to practise your skills on the echo
sounder system even without leaving port. You can also use it to
train new operators, or to perform troubleshooting on an external
logging and display system. The artificial bottom generated by the
simulator is not advanced, but it allows you to define a few basic
parameters.

Figure 55 - Simulator

How it works
The Simulator simply creates a flat, artificial bottom. You can
manipulate the bottom depth properties by setting the parameters
described below.
The simulator is located in the Sonar Head, and when runnning, it
will test most of the EM 1002. Only the transmit and recieve part
will not be tested. If the sound speed profile is different from the
transducer depth sound speed, the bottom will be curved.

Note: Please be aware that the Simulator does not work in real time, it
will have a reduced ping rate.

Simulator
Off - Click to switch the simulator off.
Enabled - Click to switch the simulator on. To start the Simulator
you must start it from the Launchpad.
Minimum depth - Change this parameter to modify the minimum
depth of the simulated bottom.
Maximum depth - Change this parameter to modify the maximum
depth of the simulated bottom.
Step Along - This setting determines how much the depth shall
change from ping to ping. The depth will automatically change
from the minimum to the maximum setting, and then be reduced
again.
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Slant Across - Change this parameter to modify the across slant
angle of the simulated bottom.
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4.7 Built-In Self Test

Overview
The Built-In Self Test options are available on the Test,
Simulator and Manual Control dialogue box. To access this box,
select it on the Show menu in the Runtime Menu menu bar.

The Built-In Self Test options provide a number of automatic tests
that may be started to check the operation of the echo sounder
system.

You can also enable a test to be performed every time you start the
system. Test results are displayed in the dialogue box’s text box.

Figure 56 - The Built-In Self Test options

Note: To operate the BIST system, the echo sounder must be in standby
mode (not pinging), and logging must be off.

Execute All
This button allows you to run all the built-in test programs
automatically. The tests are rune one by one, and the results are
shown in the message field at the bottom of the window. Note that
this is a rather time consuming task, especially the Tx channel.
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BIST At Startup
When this function is enabled, the system runs most of the built-in
test programs automatically when the system is switched on. The
tests are run one by one, and the results are shown in the message
field at the bottom of the window.

Independent of this setting, the Operator Station software issues a
“power up” BIST request to the Transceiver Unit when the
Operator Station starts the EM 1002 operator interface. This
verifies the operation of the Transceiver Unit and the software.
This power-up test must be successfully completed in order to
operate the system.

Reset

Press this button to erase all the current information in the message
field.

Print

Press this button to print all the current information in the message
field. The output is automatically sent to the default printer
connected to the system.

Write To File

Press this button to print all the current information in the message
field to a text file. A small dialogue box opens to let you select file
name and location. The file format is normal ASCII.
→ For more information about the file system, please refer to the

System Administration chapter in the EM 1002 Maintenance
manual.

BIST Options

Overview

When you run the built-in test programs, you can either run all the
test automatically (by pushing the Execute All button described
above), or you can select which parts of the EM 1002 system you
wish to test. The options available here allows you to test
individual functions and hardware items. Note that efficient use of
these parameters are only possible if you have a general knowledge
of the EM 1002 design. The descriptions here are are only for
general information.
→ For more detailed descriptions, refer to the EM 1002

Maintenance manual.

SW Version

Presents the software versions of the processors in the system.
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TRU Power

This test checks the low voltage power supply in the EM 1002
Transceiver Unit. All the output levels are tested.

RX Noise Level

The level is normally higher at shallow waters due to reflections
of the ship’s noice from the bottom. This noise, the flow noice,
normally increases with the ship’s speed.

This test measures the noise level on all the receiver channels.

• The average equivalent isotropic noise level for all channels.
(Typical value is 45-50 dB ref 1 V per µPascal).

• The equivalent isotropic noise level for each receiver channel
(ref 1 V per µPascal)

BSP

This test check the Beamformer and Signal Processing circuit
boards in the EM 1002 Transciever Unit.

TX Power

This test checks the high voltage power supply in the EM 1002
Transceiver Unit. All the output levels are tested.

Note: This test may take several minutes!

TX RAM

This test checks the memory on the transmitter boards in the
Tranciever Unit.

Cal. Offsets

Factory calibration values for the transducer are stored in the
transducer unit. This test displays these values.

SPRX / BSP Link

This test checks the communication between the Signal Processing
Receiver and the Beamformer and Signal Processing circuit
boards.

SPRX

This test checks the SPRX processor board. The SPRX is
controlling the data aquisition and the transmitter.

Rx Channels

A test signal is injected individually to all 128 reciever channels.
The amplitude and phase response is checked.
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TX via RX

This test checks all the transmitter channels through the water to
a neighbouring reciever. One pulse is transmitted at a time using
one transmitter element only. Note that this test can last for several
minutes.

Hull Unit (HU)

This is a test of the processor board (SPS) in the Hull Unit.

HU MOSINT2

Test of the driver circuit to the Hull Unit step motors.

HU Servo

This drives the Hull Unit to vertical then to +/- 5 degrees off and
back.

Message field
The reports issued by the built-in test programs are shown here.
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5 I/O INTERFACES

5.1 Overview
Various data may be imported to or exported from the EM 1002
Operator Station on serial lines. The imported data may come from
another computer (in which case specific formats must be used) or
directly from sensors.

The I/O Interfaces dialogue box functions are used to set up the
serial lines. The dialogue box is accessed directly from the icon on
the EM 1002 Launchpad.

In this chapter you will find

• I/O functions and main window

• Menu commands

• Operational procedures
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5.2 I/O functions
The I/O functions are enabled by selecting the corresponding
option button beside the function name. A green button indicates
that the function is currently active. The different I/O functions are
listed by group as follows:

Figure 57 - I/O Interfaces dialogue box

Fixed Depth Probes:

• SV Smart Probe Input - sound speed probe

• SV & T Smart Probe Input - sound speed and temperature probe

• SV & P Smart Probe Input - sound speed and pressure probe
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Profile Input:

• SV & P Smart Probe Profiling - sample a profile using AML SV
& P probe

• SV Plus Probe Profiling - generate a profile using data collected
with the AML SV Plus probe

• AML Calc Format Profile

• KS SSP Profile Datagram

• Kongsberg Simrad ASCII Profile Datagram

• Kongsberg Simrad Binary Profile Datagram

Datagram Input:

• Tide

Datagram Output:

• NMEA DPT - depth of most vertical beam

• NMEA APB - position with respect to the active survey line

Only one Fixed Depth Probe may be chosen at a time. All other
functions can be combined as desired, depending on available I/O
interfaces.



EM 1002 / Base version

152 850--160977/E

5.3 Menu commands
The menu includes the following commands:

File
- Save - saves current settings
- Read - allows you retrieve previous values

- Exit - closes the I/O Interfaces dialogue box

Edit
- Device Setup...

Choose Edit->Device Setup... from the menu to control the
parameters of each I/O function. The Device Setup dialogue box
allows you to associate each of the available functions with an
input device. For most functions, this is a serial port, but the AML
Calc Format Profile, the KSI SSP Profile Datagram and
SIMRAD ASCII and Binary Profile Datagrams input functions
may in addition be set up to the Ethernet.

→ See description below.

Probe
- Probe Controls...

→ See description below.
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Edit menu

Device Setup

Figure 58 - The Device Setup dialogue
box

To modify the device setup for any given function, select the
function from the I/O Functions button at the top of the dialogue
box. The various fields and items available for selection in Device
Used are then updated according to the I/O Function chosen.

Options for controlling the associated device are:
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• Probe Type: Use this selector to define whether the probe is
Autonomous or Configurable. An Autonomous probe sends out
data automatically when power is applied, a Configurable probe
requires commands from the system to provide data.

• Parity: Use these option buttons to select the parity for the
currently selected device.

• Stop Bits: Use these option buttons to select the number of stop
bits for the currently selected device.

• Data Bits: Use these option buttons to select the number of data
bits for the currently selected device.

• Baudrate: Use this selector to define the baudrate for the
currently selected device.

All input is verified for the appropriate read & write access as given
by the currently selected I/O Function and appropriate warnings
are issued if necessary.

It is possible to verify device input in the Raw Input Verification,
All Devices field and to verify the device output in the Output
Verification, All Devices window.

5.4 Probe

Probe Controls

Sound Speed Profile Input

The EM 1002 may receive the sound speed profiles from either a
combined sound velocity and depth/pressure sensor, or from an
external computer. The only separate sensors currently accepted
by the EM 1002 software are the Applied Microsystem’s Smart
SV&P Probe and the SV Plus Probe. Profiles loaded from an
external computer are only accepted if they conform to the CALC
format defined in the Applied Microsystem’s Total System
Software, or to proprietary formats defined by Kongsberg Simrad.
They are the SSP format, the SIMRAD ASCII format originally
defined for the EA500, and the SIMRAD Binary format originally
defied for the EM12 and also used by the EM 950/1000. These
formats are more useful than the other formats, as they also support
sound speed input, absorption coefficient, temperature and salinity
as a function of the depth. From these data, both sound speed and
absorption coefficient profiles may be generated.
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SV & P Smart Probe Profile Input
When SV & P Smart Probe Profiling is enabled under Profiling
Input, the SV & P Smart Probe Profile Input controls at the
bottom of the I/O Interfaces dialogue box become active for
selection.

Figure 59 - The Device controls dialogue box, SV & P Smart Probe
Profiling

Push to start Logging Probe Data

This button is used to start the collection of probe data in order to
established a complete sound speed profile. The sampling process
runs until you press the button again.

Note: Please note that the probe starts sampling data as soon as it is
enabeled in the main window!

Probe depth

This field displays the current probe depth as a function of the
pressure read by the sensor. The information is continuously
updated once the sensor is activated.

Sound speed

This field displays the current sound speed as read by the sensor.
The information is continuously updated once the sensor is
activated.

5.5 Operational Procedures
The following procedure allows you to collect the sound speed
profile using the Applied Microsystem’s Smart SV&P Probe
connected to the EM 1002 Operator Station. The procedure
assumes that you have defined a serial line input for the probe.
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1 Open the I/O Interfaces on the EM 1002 Launchpad.

2 Click the SV&P Smart Probe Profiling option button.

3 Lower the probe to a stable position beneath the water
surface.

4 Apply power to the probe and wait for the displayed values
to stabilize.

5 Click Push to Start Logging Probe Data to activate the data
logging. The button then turns green indicating logging is
active, and the label changes to Push to Stop.

6 Lower the probe to the required depth.
- The sinking speed should not exceed 1 m/s. Allow the

probe to sink freely, but try to keep an even movement.

7 Click Logging Probe Data - Push to Stop when the
probe has reached the required depth to terminate data
acquisition. The green colour is then switched off, and the
label changes to Push to Start Logging Probe Data.

Note: There may be systematic differences in the measurement values
according to the up/down direction. This is due to the water flow
around the sensor. If this is the case, only data from one direction
should be measured!

Note: Also note that if logging of data is active in both directions, all data
will be used!

- Once the computer has collected all the data, it will
automatically start the SSP Editor. The profile you have
just collected will there be displayed for a visual check.
→ The SSP Editor is described on page 321.

- You may also collect data when the probe is hoisted. You
must then press Use Sampled Values again (re-select) to
start a new data acquisition before hoisting. Click again
(deselect) just before the probe breaks the surface to
terminate the second data acquisition.

8 If required, modify the sound speed profile to remove
obvious erroneous measurements, or to correct for known
offsets.
- The procedure for this is given in the SSP Editor

instructions.
→ The SSP Editor is described on page 321.

9 Close the window by selecting the OK button.
- The sound speed profile is automatically saved on the

hard disk. The file name is generated from the current date
and time.
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SV Plus Probe Input
The SV Plus Probe is configured, monitored and managed from the
SV Plus Probe Profiling section of the Probe Controls window.
The section may be expanded or collapsed using the section title
button. The default state is collapsed.

The section contains several subsections whose titles are used as
section titles below.

The SV Plus probe comes with a number of configuration options,
most of which can be accessed from this window. For a complete
description of the SV Plus probe configuration, operation and
maintenance, please refer to the manufacturers documentation that
comes with the probe.

During normal operation, available sensor data is logged to data
files local to the probe. The data may be collected when the probe
is retrieved and connected to the workstation.

Note: Please note that the probe must be connected to the workstation
with a special cable supplied with the probe in order to
communicate with the probe!

All commands issued to the probe is echoed in the Raw SV Plus
Input Verification area of this section, along with any probe
response or feedback to the issued command(s).

You may at any time select the Push To Monitor Probe button at
the top of the window to monitor the probe sampling. Sampling
will be performed according to the current probe configuration.

Show

The text field Show contains the following probe command
options:

Pressure

Displays one sample of pressure sensor data.

Temperature

Displays one sample of temperature data.

Date & Time

Displays probe’s current date and time.

Battery Status

Displays sensor battery data.

Sound Speed

Displays one sample of sound speed sensor data.
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Current Logfile

Displays name of file local to the probe containing probe sampling
data.

Current Sample Rate

Displays current probe sample rate.

One Scan

Displays one scan of data using the current setup.

Data Management

Fetch & convert Probe Data

Lists all files local to the probe available for retrieval. The files are
echoed in the input verification area and in a popup selection
window. One file at a time may be selected in this window. Each
file contains at least one cast (sampling session) of data. When the
OK button is activated, the selected file of logged data is
transferred to the Operator Workstation, and converted to one or
more sound speed profiles.

The files are named according to the date and time found for each
cast of data. The files are stored in the directory designated for
sound speed profiles used by the system. Whenever a new profile
is downloaded through esoIO, it will be copied to current raw data
directory in addition to SHAREDHOME. The sound speed
profiles may at any time be renamed, provided that the file
extension ’.asvp’ is kept.

Fetch Probe Data

Lists all files local to the probe available for retrieval. Same as
above except files are not converted but stay in the original format.

Set Logfile

Pops up a window for input of a file name to be used for storing data
locally in the probe. The naming syntax follows that of the DOS
operating system. The file name is sent to the probe when selecting
the OK button. All subsequent data acquisition uses this file for
data storage.

List Logfiles

Lists all data logfiles currently present in the probe. The file list is
displayed in the Raw SV Plus Input Verification area.

Initialize Probe

Resets probe settings to factory defaults, and clears the probe
memory. Since this operation destroys any data that you have
collected, a verification box is diplayed and the initialize command
is only issued if the Yes button is selected.
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Figure 60 - The Device controls dialogue box, SV Plus
Probe Profiling.

Erase Logfile

Lists all files local to the probe available for erasure. The files are
echoed in the input verification area and in a popup selection
window. Several files at a time may be selected in this window.
When the OK button is activated, a verification box listing the
selected files is presented. The erase command is only issued if the
Yes -button is selected.
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Monitoring: Create Profile from Data

This option is used to switch On / Off logging of realtime data.
Realtime data is only available when the probe is deployed with a
communication cable attached. In addition, monitoring of probe
data must be activated. This is achieved by selecting the Push To
Monitor Probe button at the top of the SV Plus section. Sampled
data is converted to s sound speed profile when monitoring is
switched off by reselecting the same button - now titled
Monitoring Probe - Push To Stop.

Sync Probe Clock

In order to ensure correct timestamping of data, the probe clock
should be synchronized with the operators workstation clock once
for every recharge of the batteries. Use the Sync Probe Clock
button to perform this operation. The synchronization command is
echoed in the input verification window.

Sampling Parameters

The frame titled Sampling Parameters contains the available
options which determines how the data acquisition is configured.
All options, including the interval option input fields, updates the
probe automatically. Please note, that the input fields need a
’Return’ from the keyboard to trigger the parameter download.
Alternatively, you may select the Apply Settings to do the same.
Only relevant options may be selected at any time during the probe
configuration and setup.

The probe may basically perform logging of data in four different
modes:

• Time based

• Sound speed based

• Pressure based.

• Time Based combined with either a sound speed or pressure
trigger limit.

Time based

Use the Sample Mode option menu to select one of the following:

• Interval In Seconds and Samples per Second

• Interval In Minutes and Samples per Minute

• Interval In Hours and Samples per Hour

For all of the above, you have to supply a time argument in the
Time Delta input field which controls how often a sampling and
logging is performed. The sound speed and pressure increments
are set to zero.
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The Use Sound Speed Delta and the Pressure Delta options in the
Sampling By Time Extensions frame should both be deselected.

Sound Speed based

Use the Sample Mode option menu to select the By Sound Speed
option. This option configures the probe to sample continuously
and to log a data scan only when the sound speed has changed with
a value specified in the Sound Speed Delta input field.

Pressure based

Use the Sample Mode option menu to select the By Pressure
option. This option configures the probe to sample continuously
and to log a data scan only when the pressure has changed with a
value specified in the Pressure Delta input field.

Time and sound speed / pressure based

Use the Sample Mode option menu to select one of the time based
sample options. Supply the time argument in the Time Delta input
field. Then select either the Use Sound Speed Interval or the Use
Pressure Interval option in the Sampling By Time Extensions
frame. Supply the relevant trigger limit in the Sound Speed Delta
or the Pressure Delta input field.

Probe will start sampling according to the time sample mode, and
will log data only when the change in sound speed or pressure is
as specified.

Pressure Offset

As the surface pressure may vary, it is quite important to supply the
probe with a pressure offset calibration value that will correct the
probe’s readings of the pressure (and thereby the speed). Use the
input field titled Pressure Offset (in dBar) to supply the correct
value, and press the enter button. Alternatively, select the Apply
Settings button to download the current configuration to the probe.

Raw SV Plus Input Verification

As long as the probe is connected to the operator workstation with
a communication cable, it is possible to monitor the probe
sampling by selecting the Push To Monitor Probe button at the
top of the window. The data is displayed in Real Mode. Please refer
to manufacturer’s documentation for information of the format.

SV Plus Data

The frame titled SV Plus Data displays data from the probe when
it’s connected to the workstation using a communication cable.
The available data types are depths, sound speed, pressure and
temperature. Decoded samples are displayed in the SV Plus Data
frame at the bottom of the SV Plus section of the window.
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6 PING DISPLAY

6.1 Purpose
The Ping Display presents a real-time view of the system
performance. The display shows the raw data from the system after
corrections have been applied for vessel attitude and sound speed.
Note that the data are de-sampled, which means that data are not
shown for every ping. You must define the actual update rate.

The following three default displays are shown initially

• Crosstrack display

• Beam Intensity display

• Waterfall display

In addition, the following optional displays may be shown:

• Scope display

• CCD Display (Colour Coded Depth)

• Time Based Displays

- Backscatter data versus time
- Across data versus time
- Motion data and/or beam depth data versus time

The Crosstrack and CCD displays can present data in a per beam
mode, or in across per beam mode.

6.2 Overview

Main menu
When you start the Survey Display, the main Ping Display window
appears with all the individual information displays present. The
following elements are shown

• Menu bar

• Graphic presentation of the three default information displays

The menu along the top side of the Ping Display window controls
the display presentation. The Ping Display’s main window has a
menu bar with the following options

• File

→ Refer to page 180.

• Options
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→ Refer to page 180.

• Displays
→ Refer to page 187.

• Help

Figure 61 - The Ping Display main
window

Crosstrack Display
This display shows the measured depths in all beams from the last
ping. Different colours are used to show if a beam has a valid
bottom detection, and if so what type of detection has been used:
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• Red to show beams with phase detection

• Blue to show beams with amplitude detection

• Beams without any detection are not shown

Legends describing these colour codes may be shown along the
bottom of the display.

The display contains a depth scale along the righthand (vertical)
axis and beam numbers along the horizontal axis. These scales may
also be turned on or off using a popup parameter menu. Turning
legends and scales off will expand the display area containing the
depth curve.

The automatic scaling may be adjusted using the Depth delta from
the Crosstrack & Depth displays section in the Parameter
Window.
→ Please refer to page 170 for the Common display controls, and

page 172 for the popup parameters available for this display.

You may at any time switch Crosstrack presentation mode by using
the rightmost mouse-button and select wanted mode from the
display mode selection popup-menu. The display may also be
switched off using the same menu.

Default mode for the Crosstrack display is depth per beam.

Beam Intensity
This display presents a bar for each individual beam. The beam
numbers are shown along the horizontal axis.

The bar shows the backscattering strength of the bottom in dB. The
values are corrected for system parameters, but not for any
dependence upon angle of incidence. Normally the backscattering
strength will be highest straight down, typically -15 dB, and lowest
in the outer beams, typically -35 dB. These figures will vary
dependent upon bottom material type and roughness (±15 dB or
more).

This display also shows a data quality measure for each beam. This
is the green bars shown along the bottom of the display. Small
values (on a scale from 0 to 128) conveys good data quality.
The display contains scales along the left and right vertical axes,
giving dB values (left side) for the intensity bars, and a quality
measure (right side) for the data quality bars. The scales may be
turned on or off using the parameter form available from the
Options -> Parameters menu command.

The same colour codes as applied for the crosstrack display
regarding bottom detection type are used, as are legends shown
along the bottom of the display.
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Turning legends and scales off will expand the display area
containing the bars.

Parameters controlling these displays may be found in the
Parameter Window or as menu items in a popup menu.

→ Please refer to page 170 for the Common display controls, and
page 172 for the popup parameters available for this display.

Waterfall
The depth profiles from a number of pings as a function of
acrosstrack horizontal distance are displayed with a small vertical
offset between each profile. This gives a crude 3D representation
of the most recently measured bottom area.

The colour coding applied to the profiles shows different depth
levels, not bottom detection type as in the other displays. The
deepest areas will be given a deep blue colour, shifting to lighter
blue as the depth decreases. In ranges of middle depths, different
shadings of green are used. The shallow areas are represented as
different shadings of red.

A colour map (legends) showing the colours for each depth range
may be shown along the bottom of the display.

The legends may also be toggled On/Off by selecting the Legends
parameter menu option in a popup menu.

As the depth will usually change with position, the colour codes
used initially may only be adequate for a limited time period.
Therefore, an automatic adjustment of the depth ranges allocated
to each colour code will take place.

Please note, that when both the Waterfall Display and the CCD
Display are running at the same time, they will synchronise the
colour coding. Since the CCD Display usually contains a bigger
history buffer, the colour coding of this display will override the
coding used by the Waterfall.

Parameters controlling these displays may be found in the
Parameter Window or as menu items in a popup menu.

→ Please refer to page 170 for the Common display controls, and
page 172 for the popup parameters available for this display.

Note: Increasing the size of this display will result in decreased
performance!

Scope display
The display can be used to investigate the the receiver echo data,
and is used mainly for test purposes.
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Parameters controlling this display may be found in the Parameter
Window or as menu items in a popup menu.

The data is shown as on an oscilloscope, with time on the
horizontal X axis and level on the vertical Y axis.

A red colour is used to display the electrical phase difference
between two so called half beams. This is also called
interferrometric, or split beam phase signal.

The beam to investigate can be selected in the Scope section of the
Parameter Window.

Beams close to the normal incidence will have a short echo and a
noisy split beam phase signal. The outer beams will normally have
a long echo and a well-defined phase curve.

The range for the bottom detection is indicated by a vertical dotted
line. A dark blue line indicates an amplitude detection, and a red
line indicates a phase detection. If the received echo is not
accepted, no dotted line will be shown.

It is possible to switch on an information field that shows the beam
number, the echo length and the phase variance (if phase detected
beam).

→ Use the controls located in the Scope section of the Parameter
Window on page 171 to select which parts of the graph to display.

→ Please refer to page 170 for the Common display controls, and
page 172 for the popup parameters available for this display.

Stave data

On EM 120 and EM 300 it is possible to display amplitude data for
a selected receiver channel (stave). This can be used to check that
every receiver transducer element (stave) is working, and to check
the level of the received echoes. The level shall normally be 10 to
20 dB below saturation (saturation level is at the top of window).

→ Please refer to page 171 for the Scope display controls, and page
172 for the popup parameters available for this display.

CDD Display - Colour Coded Depth Display
The CCD Display shows the colour coded depth per beam using
a history buffer of varying size. The size of the history buffer
depends on the size of the display. One vertical screen unit (pixel)
is used per ping. Increasing the vertical size of the display area
increases the number of vertical screen units, thus increasing the
history buffer size.

Note: Increasing the history buffer increases the processing time of this
display function, resulting in reduced update rate!
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You may at any time switch CCD presentation mode by using the
rightmost mouse-button and select wanted mode from the display
mode selection popup-menu. The display may also be switched off
using the same menu.

Default mode for the CCD Display is depth per beam.

Please note, that when both the Waterfall Display and the CCD
Display are running at the same time, they will synchronise the
colour coding. Since the CCD Display usually contains a bigger
history buffer, the colour coding of this display will override the
coding used by the Waterfall. This may produce situations where
the Waterfall may seem overdue for refreshing the colour coding.

→ Please refer to page 170 for the Common display controls, and
page 172 for the popup parameters available for this display.

Time Based Displays
The Time Based displays uses one or two vertical Y-axis’ for
display of data using a time-based X-axis.

Figure 62 - The Time Based Display

The possible display types include:

Y2 Axis (Righthand Axis):

• Height, using data from Height Sensor

• Roll/Pitch, using data from Active Motion Sensor

• Roll/Pitch, using data from Inactive Motion Sensor

• Backscatter - Centerbeam
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• Backscatter - 4 Beams, user-selectable

• Across - 4 Beams, user-selectable

Y1 Axis (Lefthand Axis):

• Heave, Active Motion Sensor

• Heave, Inactive Motion Sensor

• EM & EA Depth (in a multi sounder configuration)

• Depth Below Keel

• Depth - Centerbeam

• Depth - 4 Beams, user-selectable

The Active Sensor used for the Roll/Pitch/Heave display is given
by the current setup of the installation parameters.

Depth Below Keel and Depth From Centerbeam are not the
same. The first is computed using sensor data, and the latter is
depth from a fixed beam.

The Backscatter option displays the same type of data as the Beam
Intensity display on a per ping basis.

Note: Any combination of the types of data associated with the two Y axis
is possible!

Parameters controlling these displays may be found in the
Parameter Window or as menu items in a popup menu.

→ Please refer to page 170 for the Common display controls, and
page 172 for the popup parameters available for this display.

The filtered amplitude is displayed with a dark blue color. The light
blue color is used to show bottom candidates.
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6.3 Operational procedures

Windows
• Crosstrack display

• Beam Intensity display

• Waterfall display

In addition, the following optional display may be shown:

• Scope display

• CCD Display (Colour Coded Depth Display)

• Time Based Displays

- Backscatter data versus time
- Across data versus time
- Motion data and/or beam depth data versus time

A menu along the top side of the window is used to control the
display presentation.

Start and exit

To start the Ping Display

When the Ping Display is used with a mulitbeam echo sounder, it
automatically starts displaying data when the EM 1002 is
activated. The program is then designed to be active throughout the
operation of the EM 1002 operation. The procedures supplied here
are only submitted in case the Ping Display is stopped by accident.

To start the Ping Display from the EM 1002
Launchpad

Press the Ping Display icon.

Figure 63 - The Ping Display icon

To exit the Ping Display

Follow these steps to exit the Ping Display:
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1 Select File on the Ping Display’s main menu bar.

2 Select Exit on the drop-down menu.

Common display controls

To change the display parameters

Several parameter settings are available to control the display of
information in the displays. Some of the parameters are available
in a Parameter Window, some in a display-dependent popup menu.

1 Select Options on the main menu bar.

2 Select Parameters on the drop-down menu.

To change display update rate

1 Select Options on the main menu bar.

2 Select Parameters on the drop-down menu.

3 Change Sampling Rate to change how often the Beam
Display fetches a new datagram for update

or:

4 Change the General Update Frequency to set the
frequency at which the displays are updated.

To change window orientation

You can decide if the three displays shall be presented in
“landscape” or “portrait” format.

1 Select Options on the main menu bar.

2 Select Parameters on the drop-down menu.

3 Set Window orientation to Vertical or Horizontal.

To change the text fonts

1 Select Options on the main menu bar.

2 Select Parameters on the drop-down menu.

3 Set Fonts in Graphs to desired size.

If the system is configured with a single beam sounder like the
EA500, it is possible to display depth data from this sounder along
with depth data from the EM echo sounder installed. This display
option is controlled using the EM & EA Depth menu item in the
display-dependent popup menu.

The program selects the EM beam falling inside the EA footprint,
and displays both beams.
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Special display controls

Special Single Beam controls

To modify the beam width

1 Select Options on the main menu bar.
2 Select Parameters on the drop-down menu.

In the Single Beam section enter the EA500 beam width used for
the EA sounder.

Special Crosstrack & Depth control

To modify the depth scale

All the displays using depth data in one form or another uses auto
scaling. But occasionally it is convenient to control the amount of
scaling. As an example, bottom conditions may yield spiky dept
data, giving a jagged depth display. Using this parameter enables
smoothing of the displayed data.

1 Select Options on the main menu bar.

2 Select Parameters on the drop-down menu.

3 In the Crosstrack & Depth Displays section, move the Depth
delta glider to modify the value.

The specified value is added to the scaling computations based on
the minimum - maximum depth values. A greater depth delta value
has the effect of smoothing the displayed data, and vice versa.

The default depth delta value is dependent on the type of echo
sounder.
→ The Waterfall Display by default is unaffected by this parameter. It

may be switched on using the display-dependent popup parameter
menu. Please refer to 174 for details.

Note: Scaling may be switched off altogether, using the same
display-dependent popup parameter menu.

→ Please refer to 173 for details.

Special Height and Heave controls

To modify the Height & Heave scale

The scaling in these two displays may be modified in the same way
as the depth displays. The procedure is exactly the same, except
that the slider is located in the Height and Heave section.

Special Scope controls

The Scope display has a set of parameters in a special section of the
Parameter Window.
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1 Select Options on the main menu bar.

2 Select Parameters on the drop-down menu.

To modify type of data displayed

The section contais one button for each type of data

• Amplitude

• Phase

• Filtered Amplitude

• Stave

• Detection Information

When the data type is activated, the indicator to the left on the
button turns green. When selected once more, the green indicator
disappears.

To select stave to display

Use the slider to select the Stave selection to select the stave to
display.

To select beam to display

Use the slider labelled Beam selection to select the beam to
display.

Special Beam Selection controls

The Backscatter, Across and Depth displays may display data from
4 beams at the same time. The beam selection is performed in a
special section of the Parameter Window.

1 Select Options on the main menu bar.

2 Select Parameters on the drop-down menu.

To modify beams to be displayed

1 Select Options on the main menu bar.

2 Select Parameters on the drop-down menu.

3 In the Beam Selection section move the Beam To Display
sliders to set the wanted selection of 4 beams.

The displays are updated immediately using the new set of beams.

Popup Parameter Selection
To modify parameters affecting displayed data

All displays may modify several display parameters affecting how
the current type of data is being presented. In addition to the
parameters in the Parameter Window, several parameters are
available in a popup menu.
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1 Point the mouse cursor in the window that you want to
change displayed type of data.

2 Press SHIFT + Mouse Button 3 in the selected window and
a popup menu appears.

3 Active parameters in that window have a green indicator to
the left.

4 Parameters not applicable to the currently displayed type(s)
of data are grayed out.

5 Keep the button depressed, and move the cursor onto the
selected parameter.

6 When the mouse button is released, the current state of the
menu item is toggled. Active items are switched off, and
inactive items are switched on.

Any change of parameters is reflected immediately in the affected
display.

The popup menu contains the following items:

Common Parameters

Graph Parameters

Auto Scaling

• Off: Locks the display to the current scaling factor

• On: Enables automatic scaling and positioning of data

Axis Labels

• Off: Data displayed without showing the axis. Increases data
area size.

• On: Shows the relevant axis numbering and labelling

Legends

• Off: Removes legends. Increases data area size.

• On: Shows explanation of graph content.

Active

• Off: Stops updating display. Yellow Inactive label placed across
the graph area.

• On: Updates display with latest data. Removes any visible
Inactive labels.

Grid

• Off: No gridlines are displayed.
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• On: Horizontal gridlines are displayed. Waterfall Display does
not have any grid lines.

Time Based Graphs

Sync. Time Axis

• Off: All data from all buffers are displayed disregarding any
difference in buffer start- and end-time.

• On: Shows only data falling within common time interval.

CCD - Waterfall

Line Width = 1

• On: Uses only one screen unit (pixel) per line drawn. This is the
optimum option in terms of performance. When selected, Line
Width=2 button is switched off.

Line Width = 2

• On: Uses two screen units (pixels) per line drawn. May give a
nicer, more readable display, especially if CCD is active in a
tear-off window. When selected, Line Width=1 button is
switched off.

Waterfall

Black Background

• Off: Draws data on a black background. When selected, the
White Background button is switched off.

White Background

• Off: Draws data on a white background. When selected, the
Black Background button is switched off.

Centreline

• On: Draws a white, vertical line through the centre of the
displayed across profiles.

• Off: No vertical centreline is drawn.

Remove Hidden Lines

• Off: All ping sections are drawn.

• On: If a ping section crosses behind an already drawn ping, the
section is not drawn. Has the effect of making a cleaner data
presentation.

Use Depth Delta Smoothing

• Off: The data is scaled (if scaling is activated) independent of
the Depth Delta parameter found in the Parameter Window.
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• On: The data is scaled (if scaling is activated) using the Depth
Delta parameter found in the Parameter Window. Has the effect
of smoothing spiky data.

Display Selection

To modify displayed data type

All displays except the Waterfall diplays may change the type of
data being presented.

1 Point the mouse cursor in the window that you want to
change displayed type of data.

2 Press Mouse Button 1 in the selected window and a popup
menu appears. Data being displayed in that window have a
green indicator to the left.

3 Keep the button depressed, and move the cursor onto the
selected data type.

4 When the mouse button is released, the current state of the
menu item is toggled. Active items are switched off, and
inactive items are switched on.

The popup menu contains the following items:

X-Axis, Meters

Crosstrack

• Off: No acrosstrack depth profile is displayed.

• On: Displays acrosstrack depth profile, using the rightmost Y
axis. The graph uses the across distance on the X axis.

CCD

• Off: No CCD data is displayed.

• On: CCD data is displayed, using the leftmost Y axis. In the
main window, one horizontal line is drawn per ping. The line
uses one pixel line width. The graph uses the across distance on
the X axis.

X-Axis, Beams

Crostrack

As above, except that data is displayed on a per beam basis.

CCD

As above, except that data is displayed on a per beam basis.

Y2-Axis (X=Time)

Height

• Off: No height sensor data is displayed
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• On: Height data is displayed, using the rightmost Y axis. The
data buffer contains 100 samples.

Roll / Pitch, Active Sensor

• Off: No roll / pitch sensor data is displayed

• On: Roll / pitch data from the active sensor is displayed, using
the rightmost Y axis. The data buffer contains 100 samples.

Roll / Pitch, Inactive Sensor

• Off: No roll / pitch sensor data is displayed

• On: Roll / pitch data from the inactive sensor is displayed, using
the rightmost Y axis. The data buffer contains 100 samples.

Backscatter - Centerbeam

• Off: No backscatter data is displayed.

• On: Backscatter data from the centerbeam is displayed, using
the rightmost Y axis. The data buffer contains 100 samples.

Backscatter - 4 Beams

• Off: No backscatter data is displayed

• On: Backscatter data for the currently selected beams are
displayed using the rightmost Y axis. The data buffer contains
100 samples.

Across - 4 Beams

• Off: No across track data is displayed

• On: Across-track data for the currently selected beams are
displayed using the rightmost Y axis. The data buffer contains
100 samples.

Y1-Axis (X=Time)

All following options display data as a function of time (X axis).

Heave, Active Sensor

• Off: No heave sensor data is displayed

• On: Heave data from the active sensor is displayed, using the
leftmost Y axis. The data buffer contains 100 samples.

Heave, Inactive Sensor

• Off: No heave sensor data is displayed

• On: Heave data from the active sensor is displayed, using the
leftmost Y axis. The data buffer contains 100 samples.

EM & EA Depth

• Off: No EM & EA data displayed
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• On: EM & EA Depth data is displayed. The EM beam within
the footprint of the EA beam is displayed. The data buffer
contains 100 samples.

Depth Below Keel
• Off: No depth data displayed
• On: The computed depth-below-keel data displayed. The data

buffer contains 100 samples.
Depth - Centerbeam
• Off: No depth data displayed
• On: The centerbeam depth data is displayed. The data buffer

contains 100 samples.
Depth - 4 Beams
• Off: No depth data is displayed
• On: Depth data for the currently selected beams are displayed

using the leftmost Y axis. The data buffer contains 100 samples.

Other Graphs

Beam Intensity
• Off: No beam intensity data is displayed
• On: Beam intensity data for the last ping is displayed using both

axis. The quality factor uses the rightmost Y axis, the
backscatter strength (beam intensity) uses the leftmost Y axis.

Scope
• Off: No scope data is displayed
• On: Scope data for the currently selected beam from the last

ping is displayed using both axis. Amplitude and filtered
amplitude uses the rightmost Y axis, phase detection data uses
the leftmost Y axis.

Display controls

To select playback or real time mode
You can select real time or playback operational modes. To use real
time, logging must be active.
1 Select Options on the main menu bar.
2 Select Display Control on the drop-down menu.
3 Select desired mode with the Display Mode control button.

If you select Playback, the File Selection dialogue box
appears automatically. The files are either Survey Format
files or Raw Data files, depending on the current file type.
The file type is selected in the top rightmost corner in the
Display Control window.

→ Refer to page 184 for an in-depth description of Display Controls.
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→ Refer to page 41 for a description of the File Selection dialogue
box.

To retrieve a depth file for playback

1 Select Options on the main menu bar.

2 Select Display Control on the drop-down menu.

3 Select Survey Format in the top righthand corner in the
Control Window.

4 Select Line menu.
- The File Selection dialogue box appears. Select a file,

and press OK to retrieve it.
→ Refer to page 41 for a description of the File Selection dialogue

box.

To retrieve a raw data file for playback

1 Select Options on the main menu bar.

2 Select Display Control on the drop-down menu.

3 Select Survey Format in the top righthand corner in the
Control Window.

4 Select Raw Data in the top righthand corner in the Control
Window.

To control the playback

1 Select Options on the main menu bar.

2 Select Display Control on the drop-down menu.

3 Use the Replay control buttons to “play”, “rewind” or “fast
forward” the depth file.

→ Refer to page 186 the description of the Replay control buttons.
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6.4 Command references

Introduction
This chapter describes the various commands and dialogue boxes
used throughout the Ping Display application.

The following options are available on the main menu:

• File

• Options

• Display

• Help

Each of these options have a menu with further commands.

In addition, you access the Graph Mode Selection popup menu
when you click the right mouse button when the mouse pointer is
placed within one of the top two graphs. This popup menu presents
you with the following choices:

• X-axis, Meters

• Crosstrack

• CCD

• X-axis, Beam No.

• Crosstrack

• CCD

• Y2-Axis (x=Time)

• Height

• Roll/Pitch Active Sensor

• Roll/Pitch Inactive Sensor

• Backscatter - Centerbeam

• Backscatter - 4-Beams

• Across - 4-Beams

• Y1-Axis

• Heave, Active Sensor

• Heave, Inactive Sensor

• EM & EA Depth

• Depth Below Keel

• Depth - Centerbeam

• Depth - 4 - Beams
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• Other Graphs

• Beam intensity

• Scope

File
This selection brings up a menu which only contains one
alternative: Exit. This command closes the Ping Display. No
warning is given before the Ping Display closes.

Options

Overview

This selection brings up the following choices:

• Parameters

• Display Control

Parameters - When you select this option the Ping Display opens
the Parameters dialogue box. The options in this box are used to
define the parameters and options for the display presentations.

Display Control - This command opens a dialogue box where you
can select the source for the data to be displayed. Two alternatives
are available:

• Real time for normal operation

• Playback for verification

Note: Sensor data is not available in Playback mode!

During playback, a file with recorded data is used in a simulation
run. Several extra controls for replay operation are then available.

→ The Display Control dialogue box is described on page 184.

Parameters

Overview

The Parameters dialogue box for the Ping Display is activated
through the Options -> Parameters command. The dialogue box
has seven separate sections:

• Single Beam

• Common

• Crosstrack & Depth Displays

• Heave

• Height
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• Scope

• Beam Selection

Figure 64 - The Parameter dialogue box, part 1

Single Beam

Used when running a singlebeam- multibeam configuration, to
input key information on EA setup. The Single Beam Field
includes the Sounder Beam Width parameter.
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The Sounder Beam Width parameter value depends on the type
of transducer used for the EA500. It varies with the frequency, and
is a fixed value that may be found in the product specification of
the installed EA500 echo sounder.

Common
In this field, you can select options associated with the whole Ping
Display.
Sampling rate - Use this control to define how often the Ping
Display fetches a datagram to update the displays.
Display Update Frequency - Use this control to set the frequency
at which the displays are updated on the screen.
Window Orientation - This selector controls the overall
organization of the Ping Display.
• Vertical: The three charts will be stacked on top of each other.
• Horizontal: The three charts will be placed side by side

horizontally.
Fonts in Graphs - Use this control to define the character size used
in the displays.

Depth Displays
This is used to change the automatic scaling when spiky data gives
a noisy display. The Depth Displays field contains the Depth
Delta Parameter as a slider. To change the Depth Delta slider,
drag it to the wanted value and release. The new value will be used
immediately for all subsequent pings. The Depth Displays field
also contains Rescale after N Pings as a slider. This slider lets you
rescale after a certain number of pings.

Heave / Height Delta
This is used to change the automatic scaling when spiky data gives
a noisy display. The Heave / Height Delta field contains the
Heave / Height Delta Parameter as a slider. To change the Heave
/ Height Delta slider, drag it to the wanted value and release. The
new value will be used immediately for all sensor buffer contents.

Heave - Height Alarm Offset
In this field you can set the value Height Delta (m) with the slider.
The Height Delta is the difference in meters between heave and
height. You will then be notified when the difference between
heave and height is greater than your chosen value.

Scope
This field allows you to control the presentation of the Scope
Display. The following options are available:
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Figure 65 - The Parameter dialogue box -part
2

Amplitude - This button is used to select whether the amplitude
curve should be displayed or not.

Phase - This button is used to select whether the phase curve
should be displayed or not.

Filtered Amplitude - This button is used to select whether the
filtered (sliding mean) amplitude curve should be displayed or not.

When Off, the filtered amplitude is again available, and the stave
selection slider is made unavailable (insenstive).
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Detection Info - This button is used to turn the detection
information on or off.
Stave Selection - This slider is used to select which stave is to be
displayed.

Beam Selection - This button is used to select which beam is to be
displayed.

Beam Selection

This dialogue box allows you to control which beams to display in
the displays enabled for this feature.

There are 4 sliders available. All sliders have the same
functionality.
x Beam to display - This slider is used to set the beam number
of beam x to display. x varies from 1 to 4.

Display Control

Overview

This dialogue box allows you to select the source of the data to be
presented by the Ping Display. These data may either come directly
from the EM 1002 echo sounder, or they may be read from a disk
file containing previously collected data. In the latter case, the
Display Control dialogue box gives you several options on how
to replay the stored data.

Figure 66 - The Display Control dialogue box

Display Mode

This button is used to select between real-time data presentation or
playback of stored data.
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Real time - Logging must be active if you select this alternative.
The other options in the Display Mode dialogue box can not be
applied as they are only relevant for playback mode.

Playback - If you choose this alternative, you must select a file for
playback. The File Selection dialogue box appears automatically.
Other controls in the Display Mode dialogue box are available to
control the playback process. These are similar to the controls
found on audio or video cassette recorders, and they allow you to
position the playback operation to anywhere on the file. The files
selected in the File Selection dialogue box are of the currently
selected file type.

Line Menu

This button activates the Depth File Selection dialogue box which
automatically appears when the Playback option is selected. This
button allows you to switch to a new playback file while another
file is already active.

File type

To select the type of file to be used in the playback process.

Survey format - The playback file must be in the Simrad Survey
format.

Raw Data - The playback file must be a raw data file.

Line & Ping Info

This status field contains various information, some of which are
only relevant for playback data. The field is initially presented in
collapsed mode, which may be changed to expanded mode by
clicking on the field label or the adjacent box. When expanded the
following options appear:

Data source - This is the name of the playback file.

Log Start - Time when logging was started.

Ping time - Time in seconds since the start of a line.

Pos in file - Position in the file given as a percentage.

Ping status - Green when ping is valid, red when invalid.

Ping Min Depth - The minimum value in the current crosstrack
depth curve.

Ping Max Depth - The maximum value in the current crosstrack
depth curve.
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Replay Control

These buttons acts like the similar physical buttons found on audio
or video cassette recorders. They are used for starting and stopping
the playback of the file, and for changing the playback position of
the file.

Figure 67 - Replay control buttons

The following buttons are available (from left on the illustration):

• Rewind
• Backwards one hundred pings
• Backwards one ping
• Start
• Stop
• Forwards one ping
• Forwards one hundred pings
• Move to end of file

Depth file selection

The File Selection dialogue box, described in the Operational
procedures chapter, is used to select a playback file.

→ Refer to page 41 for a description of the File Selection dialoge
box.

Note: The filtered amplitude is displayed with a dark blue color. The light
blue color is used to show bottom candidates.
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Displays
This menu item brings up the following pull-down menu:

• Tear-off Waterfall

• Tear-off Crosstrack

• Tear-off Beam Intensity

These menu commands all act in a similar way. A copy of one of
the displays is put into a new window. This window obeys all the
usual window controls, and may be resized, moved, etc.

Help
This option on the main menu will provide on-line help.
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7 SURVEY DISPLAY

7.1 Introduction

Purpose
The purpose of this chapter is to provide detailed information
about the commands and parameter settings in the Survey Display
main window. Some commands and parameters are used in other
display modules, and have the same meaning as they have here,
they are only described here.
The purpose of the Survey Display application is to provide real
time quality control of position and depth data. These are merged
and presented on a geographical display. This information is a
valuable tool for inspection and quality control of the data
acquisition. The Survey Display windows thus provide both depth
and position control.

Note: Use of the Survey Display requires that you have enabled logging
of Survey data to disk.

Figure 68 - The Survey Display icon

Main window and menu bar

Overview
→ The main window in the Survey Display application is shown on

page 189.

The purpose of this window is two-fold:

1 The window itself constitutes a geographical utility for
survey planning, survey overview and real time display of
logged beam data in the nearest vicinity behind the vessel.

2 The window is also used to start the other graphical tools and
displays hosted by the Survey Display.

Basic window elements

Geographical area - This is the main display area where the
survey information is displayed.
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Figure 69 - The survey display main window

Menu bar - This the top line containing the the Main menu
commands listed below.

Information bar - This is the area below the geographical area,
where scaling factor and other information is displayed.

Tool bar - Buttons for easy access to common view functions.

→ The tool bar is described on page 48.

Main menu commands

The commands are described on the following pages:

→ File - refer to page 190.

→ Edit - refer to page 193.

→ View - refer to page 199

→ Options - refer to page 215

→ Processing - refer to page 216

→ Planning - refer to page 285
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7.2 File

Overview
The File menu contains general commands for printing and closing
the Survey Display utility. When the File menu item is activated
a pull-down menu with the following alternatives appears:

• Plot

• Import DAF contours

• Exit

Plot
This choice allows you to print out the current information in the
graphic window. This command is equivalent to the command
Print.

→ This is a common function, and it is described with the
operational procedures. Refer to Print on page 43.

Import DAF contours
This menu command activates a dialogue box to import depth
contours from a .daf-file.

→ Refer to the dialogue box description on page 191.

Exit
When this menu command is selected, the Survey Display will
terminate.

This includes all the utilities launched from the main geographical
window. A warning will be issued if any unsaved changes have
been made.
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Import DAF contours

Choose this option to import depth contour lines from a
.daf-format file containing depth curves and display them in the
Grid Display. If there already are .daf-format depth contour
objects in the application, the old ones will de deleted before new
objects are inserted. A popup warning will be given before the old
objects are deleted.

Choose Import contours from the File menu and the Select DAF
file to read dialogue box opens.

Figure 70 - Select DAF file to read dialogue box

1 In the Filter field, enter the pathname of the desired
directory and file(s) to choose from, and hit return on your
keyboard or click the Filter button. The contents of the
directory specified in the Filter field will now be displayed
in the list of Files.
- If the pathname entered in the Filter field ends with /* ,

all files in the directory will be displayed under Files.
- You can filter the list of Files by specifying filetype

extensions in the Filter field. If the pathname ends with
*.daf , only .daf-files in the given directory will be
displayed for selection under Files.

2 Use the Directory navigation bar to the left to select the
desired directory to choose from.

3 Choose the .daf-file to import by selecting it from the list of
Files or by typing the filename into the Selection field.

4 Click the OK button to import the selected file. A list of all
depth curves in the selected file will then appear.
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5 You may select only one or all of the depth curves. The
selected depth will then be displayed on top of all other data
in the Graphic Display. If you select only one depth contour
from the DAF-file, that depth contour will be automatically
be given top priority, and only that depth contour will be
available in the list.

Note: The depth contours graphic objects are limited by the amount of
Maximum MB RAM defined in the Show/Hide menu. If the
user-defined limit is reached a warning is displayed.

→ See Show/Hide menu described on page 202.

You can control the appearance (colour) of the imported contour
files by setting the desired colour for Imported depth contours
in the Colour Mapping dialogue box.

→ See Colour Mapping described on page 204.
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7.3 Edit

Overview
The drop-down menu activated by this menu item contains
operations for measuring distances and positions, selecting lines,
and defining the display regions for the Grid display utility.

The right mouse button is used as an edit button when the pointer
is inside the geographical area of the window. Select a menu
command with the left mouse button, and then use the right mouse
button inside the geographical area to execute the command.

The following command options are available:

• Reset Selection

• Keep Function

• Position

• Distance

• New Display Area

• Resize Display Area

These command options are explained on the following pages.
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7.4 Reset selection

Reset selection
This command deselects all previous selections made.
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Keep function
This option is just a function, and not a dialogue box. It is accessed
from the Edit menu in the Survey Control window. The function
allows the same operation to be performed over and over again,
until an other command is selected on the menu.

Example: Press Keep function and then Distance. You can then
try out different cursor positions until you press another function.

The “repeated” function is kept until the next function is selected.
To switch off the Keep function mode, just press it again. It works
as a toggle button (on/off).
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Position
The Position function displays the geographical position of the
points. It is available from the Edit menu in the Survey Control
window.

To execute, select this command and press the right mouse button
in the geographical area. A position is then written in the
information text field at the bottom of the window. If the right
mouse button is kept down and dragged around, the current
positions are continuously updated in the information text field.

The following type of text appears (example):

Geo: N59° 21.550’ E10° 29.575’ Map:N1342,46 m E716,13
m

The format is defined by your setting in the Lat/Long format
dialogue box. Unless Keep function is selected first, the Position
mode ends as the mouse button is released.

→ Keep Function is described on page 195.

→ The Lat/Long Format dialogue box is described on page 209.
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Distance
This function enables you to measure distances in the geographical
window. It is accessed from the Edit menu in the Survey Control
window.

To execute;

1 Press the right mouse button down.

2 Drag the cursor to another position while you hold the mouse
button depressed.

The distance between the two positions is shown in the text
information field at the bottom of the window. A guideline is
visible as long as the mouse button is depressed. This line indicates
the distance that is being measured.

The following type of text appears (example):
Delta S 661 m E 457 m Dist: 803 m Angle: 145

The resolution of the distance is 1 meter and the resolution of
angles is 1 degree.

Unless Keep function is selected first, the Distance mode ends as
the mouse button is released.

→ Keep Function is described on page 195.
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New Display Area
This command is used to define a new geographical area to be used
by the Grid Display utility.

Create an rectangular area with the right mouse button.

Note: The display area must have been made visible by the settings in the
Show/Hide window.

Note: The area must be selected (by clicking on it with the left mouse
button) before the Grid Display utility can be started.

Resize Display Area
If the area generated by New Display Area does not have the
required size, this menu command can be used to resize it.

Use the right mouse button to drag one of the corners to a new
position.

Note: This operation has to be applied before the Grid Display utility
using the area is started. Changing the area after the Grid Display
has been started will not affect that process, but only new ones
started after the resize operation.
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7.5 View

Overview
The pull-down menu activated by this menu item has menu
commands for controlling how the information in the geographical
area is presented.

The following menu commands are available:

• Annotation colours

• Show/Hide

• Colour mapping

• Lat/Long format

• Data choice

• Update View Area

• Redraw

• Vessel in centre

• Update Interval

The commands and dialogue boxes are explained on the following
pages:

→ Annotation colours - refer to page 200

→ Show/Hide - refer to page 202

→ Colour mapping - refer to page 204

→ Lat/long format - refer to page 209

→ Data choice - refer to page 210

→ Update view area - refer to page 212

→ Redraw - refer to page 212

→ Vessel in centre - refer to page 213.

→ Update interval - refer to page 214
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Annotation Colours

The background colour and the colours for the different attributes
and objects displayed in a geographical window can be changed to
suit your preferences. The Annotation Colours dialogue box is
then used.

In this dialogue box, the colour for each attribute type can be
chosen from a set of 18 different colours. A list of items (attributes
and objects), which will vary according to which application the
dialogue box belongs, is included.

Figure 71 - The Annotation Colour dialogue box
(example)

The 18 colours selectable are constant and identical for all the
modules.
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All modules have a common set of items: Background, Selected
and Grid, in addition to the specific items for each module. Current
settings for each module are saved as a part of the parameter
settings for each survey.

To select a new colour for an item;

1 Click on the item

2 Click on the appropriate colour

Press the OK button to implement and save the new colour
settings. The dialogue box is automatically closed.

The Apply button allows you to implement the new colour settings
on a trial basis. The new colours can be seen in the geographical
window immediately, but are not saved. The dialogue box remains
open.

Finally, press Cancel if you wish to cancel any changes to the
colours that have been done while the dialogue box was open. Even
if the Apply button has been used, the colours will be reset to the
setting that existed before the dialogue box was opened. The
dialogue box is closed.
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Show/Hide
The Show/Hide dialogue box contains a list of items that may exist
in the client area of the geographical window. These items can
either be displayed or hidden. A check button for each item
indicates the current display status for the item.

Figure 72 - One example of a Show/Hide dialogue box

Some items have two or more sub-items. Among these sub-items
only one can be selected. The buttons show the status for the
sub-items.

The current setting for each module is saved as a part of the
parameter settings for each survey.

Common items

Some items are found in all Show/Hide dialogue boxes. These are:

• Grid lines
• Coast lines
• Legends

Grid

Grid lines showing the geographical locations may be toggled on
or off by this button. The grid net can be set to metric scale. This
is useful for estimation of distances.

The projection method may be changed.
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For more detailed information about projections, please see the
Survey format conversion tools in the System Administration
chapter in the maintenance manual.

Coast

The coast lines are toggled on or off by this button.

Legend

The colour legend of the different objects in the display is toggled
on/off by this button.

Other items

The Show/Hide dialogue box may present several other options
depending on the actual display being used.

Acceptance

Press OK to implement and save the new settings for later use. The
dialogue box is closed.

Press Apply to implement the new settings on a trial basis. The
consequences can be seen in the geographical window
immediately, but the new settings are not saved. The dialogue box
remains open.

Press Cancel to cancel any changes that have been done while the
dialogue box was open. Even if the Apply button has been used,
the settings will be changed to that which existed before the
dialogue box was opened. The dialogue box is closed.
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Colour mapping

Modules where the survey data is displayed as a continuous data
set, require a definition of the colours to be used. The Colour
Mapping dialogue box uses an HLS (Hue, Light, Saturation)
model for this purpose.

Figure 73 - The Colour Mapping dialogue box

Colour table

This setting is used to select the colour table to use for the
application window.
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When RGB cube (Red/Green/Blue) is selected, the colour table
will be a standard RGB cube colour table defined commonly for
all windows on the computer. The colour table of the screen do not
change even if you change the HLS settings in the Colour
Mapping dialogue box. A Best fit colour table will be re-initiated
when any HLS setting is modified.
This Best fit choice is the slowest, but gives the best results inside
one window. However the colours of other windows might not
match the colours in the window containing the pointer. This can
cause flickering between the windows. If the computer uses 24-bit
colour planes, the flickering will disappear and a Best-fit colour
table can be used all the time.

List of items
This list of items is used to define the data type for which the other
selections are applied.
The list of items is a list box containing different data types
displayed by the application module, and may vary depending on
the module. The left column is the data type name, and the right
column defines which of the HLS components is to be used for the
data type. Select an item from this list by pressing the left mouse
button on the item name.
The remaining controls in the dialogue box (positioned below the
list box) all pertain to the settings for the selected item.

Hue, Light, Saturation
To each of the components in the HLS model (Hue, Light and
Saturation), the dialogue box contains a graphic control used to
define a value range for the corresponding component.
For the Hue component, this control is formed as a rainbow laid
out in a circular manner. A sector is defined, giving the applied
range. The sector may be changed by dragging either of the two
edges around.
For the Light and Saturation components, controls similar to a
slide bar are applied. Two vertical lines define the lower and upper
limits of the range. They may be dragged as the slider in a slide bar.
Among these three graphic controls, only those corresponding to
the components used for the currently active data type will be
enabled.
The minimum and maximum values for each component are
shown below the corresponding graphic control. The displayed
values are updated during modification.
The two radio buttons attached to each of the three graphic controls
defines the direction for the mapping of data to an HLS component.
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• If CCW (Counter-Clock-Wise) is selected, then the lower data
value will be displayed using the minimum value defined for the
corresponding HLS component, and the upper data value will
be displayed using the maximum HLS value defined.

• If CW (Clock-Wise) is chosen, the opposite direction will be
applied.

To obtain a grey scale on the display, do as follows:

1 Move the saturation limits to the left of its scale.

2 Widen out the light area of the light scale.

The resulting colour scale for the current data type is displayed
near the bottom of the dialogue box.

Scaling

This setting is used to choose how the value range used to display
the data should be defined.

If the Auto scaling radio button is selected, the data range given by
the actual minimum and maximum values in the data set is applied.

If Fixed scaling is selected, you need to set a range using the Range
input fields.

Range

These values show the actual minimum and maximum values in
the data set. Below these are text input fields where the lower and
upper limits of the value range used to display the data are entered.
These fields are only applied if the fixed scaling radio button is
selected.

Number of colour levels

This is a text input field where the number of colour levels used for
the display of the data is entered. A low number (3-10) gives very
distinct colours. A high number (50-100) makes a more continuous
impression.

Overflow mapping

These settings select how off-range values should be displayed.

When Fixed scaling is selected there may exist data values which
are lower or higher than the defined range. These data values can
be displayed by the same value as the nearest values inside the
range (Clamp), or they can be made invisible (Cut). The third
alternative is to apply the same colours again, to each of the
intervals of the same size as the defined range, below and above the
defined range (Wrap).
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Acceptance

OK - This button is used to implement and save the new colour
settings for later use. The dialogue box is closed.

Apply - This button allows you to implement the new settings on
a trial basis. The new colours can be seen in the geographical
window immediately, but are not saved. The dialogue box remains
open.

Cancel - This button allows you to cancel any changes that have
been done while the dialogue box was open. Even if the Apply
button has been used, the colours and the other parameter values
will be reset to the setting that existed before the dialogue box was
opened. The dialogue box is closed.
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Contour priority...

Contour priority is accessed from the view menu in the
main window. Select this option to specify if you want to
highlight one of the imported contour lines in the Grid
Display.

Note: The Contour priority is for highlighting one of the imported .daf
contours only!

Note that the contour curve may be visible or hidden
depending upon settings you have selected in the Show/Hide
dialogue box. The colour may be changed in the Annotation
Colours dialogue box.

Figure 74 - Contour priority

The .daf format must be choosen in the Import dialogue box
on the File menu in order to be able to use Contour priority.
If not, you will get a warning message.

Figure 75 - Contour
warning message
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Lat/Long Format
The scales along each of the axes in a geographical window
represents geographical latitude and longitude respectively. The
latitude and longitude coordinates will be displayed in one of three
different formats:

• Decimal degrees

• Degrees and decimal minutes

• Degrees, minutes and decimal seconds

The preferred format can be selected in this dialogue box.

This dialogue box is opened by selecting the Lat/Long Format
command from the View menu in the survey display.

The selected setting for each module is saved as a part of the
parameter settings for each survey.

Figure 76 - The Lat/Long Format dialogue box

You can also choose to use metric scaling. This is made in the
Show/Hide.. dialogue box. If metric scaling is selected, the
settings described here have no effect.

→ The Show/Hide dialogue box is described on page 202.
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Data choice

Overview

The purpose of this command is to select the type of beam data to
be displayed in the nearest vicinity behind the vessel.

In realtime mode, the main geographic window will display data
as they are received from the logging process. Only a limited
amount of beam data or points behind the vessel will be displayed,
and when the number of displayed points has reached its
maximum, the oldest points are removed as new points are
received.

To see all data of an area in real time, the Grid Display utility must
be used.

The type of information to be plotted is selected using the
sub-menu activated by the following Data choice menu
commands:

• Depth

• Range

• Depth gradients

• Sun illumination

• Backscatter

• Phase / Amplitude

• Quality factor

• Ping mode

• Beam number

• Ping number

Depth - The depth value for all beams.

Range - The slant range (in metres) for all beams.

Depth gradients - Displays the Abs(dz/dy) ratio between two
neighbouring beams.

- dz is the depth difference between the two depths.
- dy is the horizontal distance between the two adjacent beam

positions in the same ping.
Sun illumination - Simulates what the seabed would look like if
illuminated by a light source. This function is useful to emphasise
steep changes in depth, and to highlight any artifacts in the data.

Backscatter - The backscatter for all beams.

Phase/Amplitude - Shows whether phase or amplitude detection
was used.
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Quality factor - A data quality measure for each beam. Small
values (on a scale from 0 to 128) conveys good data quality. Only
the lower 6 bits are used.

Ping mode - Which mode the echo sounder was using.

Beam number - A number from 1 to 111 identifying each beam.

Ping number - The number for each ping.

Presentation

The data is displayed using the colour codes set in the Colour
mapping dialogue box activated by the View->Colour mapping
menu command.

→ Refer to page 204 for further information about the color
mapping..

The data may be shown as a raster plot, using either pixels or small
rectangles as the basic unit, or the data values may be displayed
directly, as numbers. In the latter case, Over Plot Removal (OPR)
technology is applied to avoid a screen crowded with numbers.
Select one of these alternatives using the View->Show/Hide menu
command.

→ Refer to page 202 for further information about the Show/Hide
feature.
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Update view area
The View Area is defined as the rectangle covering the current
survey.

Figure 77 - The View Area

This command redraws the view area.

Redraw
This command updates the current display image with new data
received since the image was last generated.
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Vessel in centre
This command acts like an on/off switch. When the function is
activated, a small rectangle appears next to the Vessel in centre
command on the menu.

By enabling the Vessel in Centre command, the vessels relative
position on the screen will be constant. The position of the vessel
on the display may be moved with the mouse.

If the choice is disabled the geographical display will freeze and
the vessel will move relative to the geographical display. In this
case there is a possibility for the vessel to move outside the visible
geographical area.
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Update Interval
Update Interval is available from the View menu in the main
window. The purpose of this command is to define an automatic
display redraw.

During normal operations, you may find that the ping rate is very
high, or the new positions come very often. If the computer is not
fast enough to plot this continuously, the interval for screen
updates can be manually set.

You can select between the following values or a small submenu:

• 5 seconds

• 10 seconds

• 60 seconds

• No update

If you select No update, the display image will never be redrawn.
This may be useful if you want to freeze the display that you want
to analyze further, or if you want to show the display to others on
the vessel.

Note: This function was useful with older computers, with present-day
equipment it is no longer required.
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7.6 Options

Overview
The pull-down menu activated by this menu item contains only one
menu command:

• Display

Display
This command is used to select another workstation as primary or
secondary display unit for utilities launched from the main
geographical window. It is usually used when the Bridge Display
is operated from a monitor or an X-terminal on the bridge.

This menu command brings up a list of display units available on
the external Ethernet. This may be other Unix workstations,
X-terminals or computers operating with X-terminal software
connected to the local area network. Select one of the units listed,
and the Bridge Display utility subsequently launched from the
Processing pull-down menu will use the defined display for visual
presentation and user interface.

Figure 78 - Display select dialogue box

To add or remove computers to your operator station, edit the file

$NEPTUNEHOME/defaults/NeptuneDisplay
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7.7 Processing

Overview
All utilities except the main geographical window in the Survey
Display software application, are started from the Processing
pull-down menu. The utilities that work on specific lines or areas
will use lines or areas that are currently selected in the main
geographical window.

The Processing pull-down menu contains menu commands for
launching the utilities, as well as auxiliary commands related to
how the utilities work.

The following commands are available from the Processing menu:

• Bridge and Helmsman display

• Sonar Image

• Create Grid

• Grid Display

• Grid Display Realtime

• Calibrate

• Sonar Image Replay

Some of these commands are explained in this chapter, but others
- due to the fact that they are also used in other applications - are
described in their own chapters.

Bridge and Helmsman display

The Bridge and Helmsman Display is a window very similar to
the main geographical window, but it is only intended for viewing
the steering route relative to the planned lines. This window is
usually allocated to another monitor or X-terminal available on the
vessels network. This is possible by using the Options -> Display
menu command in the Survey Display window. In earlier versions
the Bridge and Helmsman display were two separate programs.
The former Helmsman Display is now removed and this function
is now included in the Bridge and Helmsman display.

To start the Helmsman, use the options View -> Show/Hide ->
Helmsman. This application is also accessed from the Launchpad.

Note: Some of the functions in the Helmsman are only available when an
active planned line is defined!

→ The description of the Bridge and Helmsman Display is on page
244.
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Sonar Image

This utility gives you a reflectivity or backscatter image of the
seabed.

The Sonar Image application is also accessed from the
Launchpad, and it is used during online operations.

→ The Sonar Image can be found on page 304.

Create Grid

This command is used to define the cell size for the reference grid
The Grid Display utility displays the data using this grid.

→ The Create Grid function is described in the Grid Display on page
229.

Grid Display

This display is a geographical window dedicated to display depths
and related values for a specific area. The area to be displayed is
defined in the main geographical window using the Edit -> New
Display Area menu command. When an area has been defined,
it must be selected, and the Grid Display can be started to display
the values inside the selected region. If no area is selected, the
whole geographical area is used as display area.

Grid Display Realtime

The Grid Display Realtime is also accessed from the Launchpad,
and it is used during online operations. It is intended to be used
while logging is active. To avoid disturbing the logging process by
computationally intensive activities, some options are not
available (the As grid and As grid and OVR text in the
Show/Hide dialogue box).

→ The Grid Display is described on page 226.

Calibrate

The Calibration (Calibrate) utility is a geographical window
intended for analysis of data from a calibration survey. Depths
from different survey lines may be compared, and it is possible to
apply different roll, pitch and time offsets to see the consequences
on the computed depth values.

This utility is used during online and offline operations.

→ Calibration is described on page 254.

Sonar Image Replay

This utility gives you a reflectivity or backscatter image of the
seabed.
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The Sonar Image Replay is accessed from the Processing menu,
and used during offline operations.

→ The Sonar Image can be found on page 304.

→ The Seabed Viewer can be found on page 313.
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Import/Export

Export lines

General

The purpose of the Import/Export utility is to transfer survey
lines from one survey directory to another. All the survey format
files representing a survey line, or alternatively only specified file
types, are copied. The utility will either copy all survey lines, or
only some selected lines. Survey lines may also be transferred to
or from magnetic tape. The utility may also be used to delete survey
lines from a survey.

Note: You should not try to achieve similar functionality by using
ordinary copy file/delete file tools available in the operating
system. This will not be successful since internal references also
have to be changed when the files are moved to another location,
or deleted.

The Import/Export utility is launched by selecting Export Lines
on the File menu. This brings up the Export Lines dialogue box.

Figure 79 - The Import/Export utility

Note: If only some of the lines in the current survey are to be transferred
or deleted, they have to be selected in the Main geographical
window before the Import/Export utility is started. No means are
provided in the utility itself to include or exclude individual lines.
If no lines are selected in advance, all lines in the survey will be
transferred or deleted.
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Some of the buttons encountered in the dialogue boxes described
below activate a restricted version of the Kongsberg Simrad
SurveyControl utility. Use the File -> Exit menu command, and
push the OK button in the resulting confirmation dialogue box to
exit from this utility.

Commands

Overview

Six push buttons are available on the right hand side of the Export
lines dialogue box. They represent the commands described
below. After pushing one of these buttons, various dialogue boxes,
described in the following paragraphs, appear.

While copying operations are active, a dialogue box informing you
about this will sometimes appear. Although this dialogue box has
an OK button, no interaction from you is required.

Get

To copy some or all lines in a survey (or lines previously copied to
tape) to the current survey.

The lines in the source survey (or on the tape), but only version 01
of the Survey Format files, and only files adhering to the included
file types (see the Selecting file types paragraph below) are
copied.

Any selection of specific lines in the current survey, done before
the Import/Export utility was started, will be ignored.

The following dialogue boxes appear:

• File type selection box

• Source selection box

• SurveyControl dialogue box. This dialogue box displays all
the lines in the source survey. You may select some of these lines
to be transferred. If no lines are selected, all lines will be
transferred.

• Confirmation box

Note: To get access to the added lines, you must exit from the main
geographical window and restart Survey Display.

Put

This option is used to move the selected (or all) survey lines from
the current survey to another survey.

Only version 01 of the Survey Format files, and only files in file
types described in the Selecting file types paragraph below, can be
taken.
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The following dialogue boxes will appear:

• File type selection box

• Destination selection box

Note: The affected survey lines will be deleted from the current survey.

Note: To see the changes to the current survey, you must exit from the
main geographical window and restart Survey Display.

Delete

This option is used to delete the selected (or all) survey lines from
the current survey.

All versions of the Survey Format files are deleted, but only files
adhering to the included file types (see the Selecting file types
paragraph below).

The following dialogue boxes will appear:

• File type selection box

• Delete file confirmation box.

Note: To see the changes to the current survey,you must exit from the
Main geographical window and restart the Survey Display.

Copy

This option is used to copy the selected (or all) survey lines from
the current survey to another survey or to magnetic tape.

Only version 01 of the Survey Format files, and only files adhering
to the included file types (see the Selecting file types paragraph
below), are copied.

The following dialogue boxes will appear:

• File type selection box

• Destination selection box

Backup

This option is used to copy the whole current survey to magnetic
tape.

All files on the survey directory, including all versions of the
survey line files, are copied. Any selection of specific lines before
the Import/Export utility was started, will be ignored.

The following dialogue box will appear:

• A dialogue box informing you about the Backup operation.

Press OK to continue or Cancel to abandon the operation.
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Restore

This option is used to restore a tape Backup previously taken with
the Backup command, to the current survey directory.

All files are restored.

The following dialogue box will appear:

• A dialogue box informing you about the tape read operation.
This box has several buttons, not all of them relevant for the
current task. Push the Start button to continue with the
transaction, or the Cancel button if you want to abandon the
operation.

Note: Any existing files on the survey directory will be deleted.

Note: To get access to the restored survey, you must exit from the main
geographical window and restart Survey Display.

Selecting file types

The first dialogue box appearing after one of the Get, Put, Delete
or Copy commands has been initiated is the following dialogue
box:

Figure 80 - Dialogue box for selecting file types

File type buttons

This option is used to specify which file types should be included
in the transactions.

The five check buttons on the left hand side are used. Select either
the All types button, or any combination of the four others.
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All types - All file types will be included, disregarding the status
of the other check buttons.

Sidescan - Sonar image data (*.sidescan files) will be included.

Depth - Depth data will be included (*.depth files).

Pos - Position data will be included (*.pos files).

Index - Index data will be included (*.ind files).

Acceptance

Apply - Use the current file type combination and go on with the
transaction.

Cancel - Abandon the transaction.

Help - On-line help.

Selecting the source

Overview

Using the Get command, the source for the data to be transferred
has to be specified. This is done by the following dialogue box,
appearing after the File type inclusion box.

Figure 81 - The Source dialogue box

Tape

If this check button is checked, the survey lines to be imported will
be transferred from magnetic tape.

Survey

This option is used to select a survey directory on the hard disk
from where the lines will be transferred.

Two alternatives are available for the specification of a source
survey. One alternative is a text input field where you can enter the
name of a survey directly.
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The other is a push button to the right of this text input field.
Pushing this button, a survey selection dialogue box appears. Click
on the survey you want. Use eventually the scroll bar on the right
hand side to get more surveys into view. Click on the OK button
to confirm the selection.

Acceptance

Apply - This option is used to accept the selected source and
continue with the transaction.

Cancel - This option is used to abandon the transaction.

View - This option is used to view the lines to be copied using a
restricted version of the Simrad SurveyControl utility.

Help - On-line help

Selecting the destination

Using the Put or Copy command, the destination for the data to be
transferred has to be specified. This is done by the following
dialogue box, which will appear after the File types inclusion box.

This dialogue box will also act as a confirmation box for these
commands. After pushing the Apply button in this dialogue box,
the transaction will be executed without any further opportunity to
abandon the transaction.

Figure 82 - The Destination selection box



Survey Display

225850-160977/E

Lines to be COPIED

This option is used to show which survey lines are included in the
transaction. Use the scroll bars to get more of the list into view. This
box is not used for further line selections.

Tape

If this check button is checked, the survey lines to be exported will
be transferred to magnetic tape.

Survey

This option is used to enter a destination survey directory on the
hard disk.

Two alternatives are available for the specification of a destination
survey. One alternative is a text input field where you can enter the
name of a survey directly.

The other is a push button to the right of this text input field.
Pushing this button, a survey selection dialogue box appears. Click
on the survey you want. Use eventually the scroll bar on the right
hand side to get more surveys into view. Click on the OK button
to confirm the selection.

If no survey of the given name exists, a new survey directory will
be created.

Acceptance

Apply - This option is used to accept the selected destination and
complete the transaction.

Cancel - This option is used to abandon the transaction.

View - This option is used to view the affected lines.

Help - Online help.
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8 GRID DISPLAY

8.1 Purpose
The purpose of the Grid Display is to display a gridded image of
large areas of the survey. This image can be used for a visual
inspection of the quality and distribution of the logged data and
related data for a specified geographical area. The logged data for
this area is then displayed in a dedicated window.

The program contains different type of representations, such as
backscatter, shaded depth and number of datapoints in each grid
cell. Depth contouring is also included in the Grid Display.

The area to be displayed is defined in the main geographical
window using the Survey Display’s Edit->New Display Area
command.

Two versions of the Grid Display application may be used:

• Online version
• Offline version

The online version of the Grid Display is intended to be used while
logging is active. The As grid and As grid and OVR text options
in the Show/Hide dialogue box are then not available to avoid
disturbing the logging process by computational intensive
activities.

8.2 Main window

Overview
The Grid Display main window is shown below. It is designed with
the following elements:

• Menu bar

• Graphic presentation of the currently selected area

• Mean depth colour coding

• Tool bar
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Figure 83 - The Grid Display main window

Main menu
The Grid Display’s main menu bar provides the following choices:
• File
• View
• Planning
• Crossline
• Help
The Planning and Crossline modules are explained separately.
→ The Planning utility is described on page 285.
→ The Crossline utility is described on page 276.

Graphic presentation
The graphic presentation area displays the current geographical
area. A grid positions the area, and colour codes are used to
visualize the depths.
The bottom part of the graphic display presents the current colour
coding used to visualize the various depths. The scale (in meters)
is shown under the colour bar.
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Information bar
The information bar at the bottow of the window contains
information about the scale (for example 1:25000).

Tool bar
The buttons on the tool bar provides general tools for scaling,
mouse operations and panning.

→ Refer to the description on page 48.
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8.3 Operational procedures

Purpose
The purpose of the Grid Display is to display all depths and related
data for a specified geographical area. The logged data for this area
is then displayed in a dedicated window.

The area to be displayed is defined in the main geographical
window using the Survey Display’s Edit->New Display Block
command.

Start and exit

Before you start the Grid Display

You must define a data set and a display area before you start the
Grid Display. The following procedure applies:

1 Select Processing on the Survey Display’s main menu.

2 Select Create grid on the menu. This opens the Grid
Definition dialogue box.
- If logged data is available, the system will present you

with a suggestion about the grid cell size.

Figure 84 - Create grid/Grid definition dialogue box

Note: If you attempt to perform Create Grid with no survey data, an error
message is presented.

Note: If you attempt to perform Create Grid for the second time on the
same survey data, a warning message is presented. You can then
either cancel the process, or continue.

- A subsequent re-definition of the reference grid will force
the system to compute depths values for the new cells,
which will take some time if the amount of data is large.

3 Select New Display Area on the Edit menu.
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Figure 85 - Create grid warning message

4 Press the right mouse button to select an area.

5 Click once on the area border to select it.

6 Select Edit on the Survey Display’s main menu bar.

7 Select New Display Area on the Edit menu.

8 Press the right mouse button to select an area.

9 Click once on the area border to select it.

You can now start the Grid Display, and only the selected lines will
be displayed. If no lines were selected, all lines will be displayed.

To start the Grid Display

The Grid Display is started from the Survey Display application as
follows:

1 Select Processing on the Survey Display’s main menu bar.

2 Select Grid Display on the menu.

3 Change to Workspace three too see the Grid Display.

You can also start the Grid Display from the Launchpad by
clicking on the dedicated icon.

If you try to start the Grid Display without first defining a display
area, an error message will appear to guide you.

To start the Grid Display realtime

Before you start the Grid Display Realtime you need to log one
survey line, or parts of one. You then need to create a grid for that
line, the procedure for create grid is described above.

1 Select Edit on the Survey Display’s main menu bar.

2 Select New Display Area on the Edit menu.

3 Press the right mouse button to select an area.

4 Click once on the area border to select it.
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5 Select Processing on the Survey Display’s main menu bar.

6 Select Grid Display Realtime on the menu.
- The grid is updated continously.

Note: When the vessel leaves the area defined by the realtime grid, the
gridding stops.

Note: If you define an area for the realtimegridding that is too large, the
Grid Display Message dialogue box will appear with a warning.

To start the Grid Display realtime

Before you start the Grid Display Realtime you need to log one
survey line, or parts of one. You then need to create a grid for that
line, the procedure for create grid is described above.

1 Select Edit on the Survey Display’s main menu bar.

2 Select New Display Area on the Edit menu.

3 Press the right mouse button to select an area.

4 Click once on the area border to select it.

5 Select Processing on the Survey Display’s main menu bar.

6 Select Grid Display Realtime on the menu.
- The grid is updated continously.

Note: When the vessel leaves the area defined by the realtime grid, the
gridding stops.

Note: If you define an area for the realtimegridding that is too large, the
Grid Display Message dialogue box will appear with a warning.

You can also start the Grid Display from the Launchpad by
clicking on the dedicated icon.

If you try to start the Grid Display without first defining a display
area, an error message will appear to guide you.

To start the Grid Display realtime

Before you start the Grid Display Realtime you need to log one
survey line, or parts of one. You then need to create a grid for that
line, the procedure for create grid is described above.

1 Select Edit on the Survey Display’s main menu bar.

2 Select New Display Area on the Edit menu.

3 Press the right mouse button to select an area.

4 Click once on the area border to select it.

5 Select Processing on the Survey Display’s main menu bar.
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6 Select Grid Display Realtime on the menu.
- The grid is updated continously.

Note: When the vessel leaves the area defined by the realtime grid, the
gridding stops.

Note: If you define an area for the realtimegridding that is too large, the
Grid Display Message dialogue box will appear with a warning.

To exit the Grid Display

The Grid Display is closed as follows:

1 Select File on the main menu bar.

2 Select Exit on the File menu.

The common view procedures are presented in the Grid Display
Command Reference.
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You can view and modify the distance between the chart contours.

1 Select View on the main menu.

2 Select Make Contour... on the submenu.

3 Enter the desired contour interval.

4 Press Ok.

Once the contour lines are established, you can place depth labels
on them.

1 Select View on the main menu.

2 Select Contour labels at on the submenu.

3 Select the desired level.

Make sure that Contour is enabled in the the Show/Hide dialogue
box. If Grid cell is also enabled in the Show/Hide dialogue box,
and your current Annotation Colours settings have defined Grid
cell and Contour to be displayed in the same colour, you will not
be able to see the contour labels. This can be fixed by either
changing the color definitions in Annotation Colours or by
disabling Grid cells in Show/Hide.

→ Refer to page 202 for further information about the Show/Hide
dialogue box.

→ Refer to page 200 for further information about the Annotation
Colour dialogue box.

To create Sun illumination charts

You can add shading to the displayed image, and thus make an
artificial 3D effect.

1 Select View on the main menu.

2 Select Grid/Cell on the submenu.

3 Select Sun illumination.

4 Select Shading parameters on View submenu.

5 Select desired value.

You can select what kind of data to be displayed.

1 Select View on the main menu.

2 Select Grid/Cell on the submenu.

3 Select desired value.
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8.4 Command references

Introduction
This chapter describes the various commands used throughout the
Grid Display.

The following options are available on the main menu:

• File

• View

• Planning

• Crosslines

• Help

Each of these options have a number of commands available on
drop-down menus.

The File menu allows you to print the contents of the geographical
display, and to exit the Grid Display.

→ Refer to the description on page 235.

The View menu provides a number of commands and dialogue
boxes to control the geographical display.

→ Refer to the description on page 237.

The Planning menu provides a utility to plan your surveys.

→ Refer to the description on page 285.

The Crosslines application makes it possible to evaluate the data
quality of the multibeam echo sounder inside a corridor generated
in any direction in the survey area.

→ Refer to the description on page 276.

The Help menu provides on-line help. It is not described here.
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8.5 File

Overview
The File option on the Grid Display’s main menu bar activates a
drop-down menu where the following commands appear:

• Plot

• Export depth contours...

• Import...

• Exit

Plot
This menu command activates the Plot dialogue box.

→ Refer to the dialogue box description on page 43.

This menu command activates the Export depth contours
dialogue box.

→ Refer to the dialogue box description on page 236.

This menu command activates a dialogue box to import depth
contours from a .daf-file.

→ Refer to the dialogue box description on page 191.

Exit
When this menu command is selected, the Grid Display utility will
terminate.
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Export depth contours

This option exports contour lines to an output file.

You can select from the following options:

• plotmtv

• DAF

You can also select the output file name.

Plotmtv is a general purpose graphics utility available on the
Internet. The utility is supplied with the Neptune, and may be
started in a terminal window. When you press Ok, this application
is started automatically.

DAF is a graphical format for use with the dKart software from
HydroService. The dKart program also reads and generates the
S57 ECDIS format.

A separate program named HydroService is supplied to read DAF
format for conversion to Neptune’s internal coast line format.

→ Refer to page 191 for a more detailed description of the DAF
format.
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8.6 View

Overview
The drop-down menu activated by this option contains commands
for information presentation.

• Annotation colours

• Show/Hide

• Lat/Long format

• Colour Mapping

• Contour Priority

• Selections

• Vessel in center

• Make contour

• Contour Labels at

• Display Interval

• Shading Parameters

• Grid/Cell

• Keep Function

• Position

• Distance

The Annotation Colours command presents the Annotation
Colours dialogue box, where you can modify the various colours
used in your graphical window presentations.

→ Refer to the description on page 200.

The Show/Hide command presents the Show/Hide dialogue box,
which contains a list of items that may exist in the client area of the
geographical window. These items can either be displayed or
hidden.

→ Refer to the description on page 202.

The Lat/Long Format command allows you to choose the scales
along each of the axes in a geographical window. These represent
geographical latitude and longitude respectively.

→ Refer to the description on page 209.

The Colour Mapping command allows you to manipulate with
the colours in the graphical window.

→ Refer to the description on page 204.
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The Contour Priority command is used to specify priority of
imported contour lines to be displayed in the Grid Display.

Note that the contour curves may be visible or hidden depending
on settings you have selected in the Show/Hide dialogue box.

The Selections command provides a small submenu with two
choices: Reset selection and Lines. The first option deselects the
currently selected line in the main window, and empties the edit
buffers. Lines opens a small window to make the line selection.

The Vessel in center command places the vessel in center of the
geographical window.

The Make Contour command enables the necessary
computations to display the contour curves connecting all the
points with equal depth.

→ Refer to the description on page 239.

The Contour Labels At command enables you to choose at which
levels the contour curves should have labels displaying the depth.

→ Refer to the description on page 240.

The Display Interval command enables you to set up an automatic
redraw period for the display.

→ Refer to the description on page 214

The Shading Parameters command controls the “amount” of
shading you can apply to the image, as well as the angle of the light
source.

→ Refer to the description on page 241.

The Grid/Cell command enables you to control which data types
you wish to see.

→ Refer to the description on page 241.

The Keep Function command enables you to do the same
operation over and over again, until an other function is selected.

→ Refer to the description on page 195.

The Position command allows you to identify positions on the
geographical display.

→ Refer to the description on page 196.

The Distance command allows you to measure distances on the
geographical display.

→ Refer to the description on page 197.
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Make Contour
Make contour is available from the View menu. This dialogue
box enables the necessary computations to display the contour
curves connecting all the points with equal depth.

The dialogue box (shown below) asks for the current contour
interval in meters. This is the depth difference between each
contour curve.

Figure 86 - The Make Contour dialogue box

Enter the desired value, and press OK. Cancel will close the
dialogue box without any changes. Help starts the context
sensitive help.

The computer now performs the contour calculations, and the
result is displayed in the main geographical window.

Note that the contour curves may be visible or hidden if you use
the Show/Hide dialogue box.
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Contour Labels At
Once contour lines are enabled, you can choose at which levels the
contour curves should have labels displaying the depth.

The following options are available:

• Every level

• Every second level

• Every fifth level

• Every tenth level
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Shading parameters
This menu option allows you to choose the “amount of shading”
to be applied when the Sun illumination alternative is selected on
the Grid/Cell sub-menu.

Options are:

• Normal

• 2 * Normal

• 4 * Normal

• 8 * Normal

• Light from <geographic direction>

Grid/Cell
This option defines the data type to be displayed. Select any of the
following:

Mean depths - This is the mean value of the cell.

Min.depth - This is the minimum value of the cell.

Max. depth - This is the maximum value of the cell.

Diff.depth - This is the depth range (maximum value minus
minimum) of the cell.

No.points - This is the number of data points in the cell.

Backscatter - This is the mean backscatter value of the cell.

Sun illumination - This is the mean depth of the cells with shading
based on an artificial light source placed in the geographical
direction described in Shading Parameters above.

Mean height - Mean distance from vertical reference to sea floor.

Max.height - Maximum distance from vertical reference to sea
floor.

Min.height - Minimum distance from vertical reference to sea
floor.
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Create Grid
This command is used to define the grid’s cell size for the Grid
Display utility. The option brings up a dialogue box to define the
size of the grid cells.

Note: The generation of the cells takes much of the system resources, and
should only be used while logging is not active!

Figure 87 - Create Grid dialogue box

Grid cell size

To start the Grid cell size

To start the Grid cell size you need to do the following

1 Start Merlin
2 Change workspace to the SI.
3 Choose Processing on the main menu.
4 Choose Create Grid.

Introduction

If logged data is available, the system will present you with a
suggestion about the grid cell size. For this purpose, some logged
data is required.
• If you attempt to perform Create Grid with no survey data, an

error message is presented.
• If you attempt to perform Create Grid for the second time on

the same survey data, a warning message is presented. You can
then either cancel the process, or continue.

To start EM 1002 on a survey, run the system for a few minutes
without any grid defined, and then stop the logging. Use the Create
Grid command to define a reference grid. The system will then
have some data from which a reasonable suggestion about the grid
cell size can be made.
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Figure 88 - Create Grid warning

A subsequent re-definition of the reference grid will force the
system to compute depths values for the new cells, which will take
some time if the amount of data is large.

Try to select the right cell size early in the survey. A good rule is
to define the reference grid when the first line has been finished,
and before the start-up of the next.
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9 BRIDGE AND HELMSMAN DISPLAY

9.1 Purpose
The Bridge and Helmsman Display is designed to view track and
coverage data. It presents a geographical view of the current survey
area with vessel position, survey lines and swath coverage. On the
Bridge and Helmsman Display various steering information with
regard to the current survey line may be displayed.

• No depth or other beam data are shown.

• Only the track of the currently active line and optionally
coverage is shown.

The Bridge and Helmsman Display window is usually allocated to
another display unit. Therefore, use the Options -> Display menu
command from the survey display menu before the Bridge and
Helmsman Display program is started.
→ Refer to page 246 for a start-up procedure.

9.2 Main window
The Bridge and Helmsman Display window contains the
following main elements:

• Menu bar

• Graphic presentation of the current survey area

• Information bar at the bottom of the display

• Tool bar

The following commands and options are available from the the
Bridge and Helmsman Display main menu bar:

• File

• Edit

• View

These menu options and the respective commands are the same as
used elsewhere in the Survey Display application.

The Bridge and Helmsman Display window is shown in figure 89.
This window contains the same geographical information as the
Survey Display main window, but the options on the main menu
bar have been reduced.

The information bar at the bottom of the display contains
information about the scale (for example 1:25000).
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Figure 89 - Bridge and Helmsman Display. The
Helmsman information is in the grey areas of the

window.

The Tool bar provides easy access to a number of view functions.

→ The Tool bar is explained on page 48.
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9.3 Operational procedures

Windows
The Bridge and Helmsman Display operates in a single window.
In this window you can view the survey lines.

Start and exit

Before you start the Bridge and Helmsman
Display

The Bridge and Helmsman Display is designed to run on a local
workstation/x-terminal/remote display on the vessel’s bridge, and
to aid the crew during the survey.

In order to make the application appear on the remote display, the
following procedure must be performed in the Survey Display
main menu:

1 Select Options -> Display.
- A display select dialogue box appears. This box contains

the logical addresses of the possible displays on your
network. Each workstation is identified by its “alias” or
IP address.

(Cd4392)

Figure 90 - The Display Select dialogue box

2 Select the workstation/x-terminal/remote display alias or
adress to receive the Bridge and Helmsman Display window.
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3 Clock OK to apply.

Note: Usually, only the Bridge Display is sent to the display you select
here.

To start the Bridge and Helmsman Display

The Bridge and Helmsman Display is started from the Survey
Display’s main menu as follows:

1 Select Processing on the main menu bar.

2 Select Bridge Display on the pull-down menu.

You can also start the Bridge and Helmsman Display from the
launchpad using the icon.

To exit the Bridge and Helmsman Display

The Bridge and Helmsman Display is closed as follows:

1 Select File on the main menu bar.

2 Select Exit on the pull-down menu.

Common view procedures
The common view procedures are presented in the Operational
procedures chapter.

→ Refer to page 50.

Show/Hide settings
You can start the Helmsman display by activating the Helmsman
button. What to display in the Helmsman can also be defined in the
Survey Display. This setup is saved when the Survey Display exits,
and it is restored when the Bridge and Helmsman Display is
started. You can choose to display this:

DTK - Desired Track. This is the heading of the current line
segment.

DPT - Depth. The water depth in meters.

COG - Course over ground.

CMG - Course Made Good. The heading from the first point in the
planned line to the current position.

XTE - Crosstrack Error. The shortest distance to the current line
segment.

SOG - Speed Over Ground. Current Speed.

TTG - Time to Go. Estimated time of arrival at the next waypoint.



EM 1002 / Base version

248 850-160977/E

DST - Distance to Waypoint. Distance in meters to the next
waypoint.

XTE deviation indicator - XTE bar displayed at the top of the
screen.

Use small fonts - Toggle between small and large fonts.

Output to Autopilot - Output of NMEA APB datagrams.

Automatic line direction - Automatically sets the active lines
direction.

The XTE deviation indicator displays the distance from the ship to
the active line. A line may have several waypoints and the DTK,
XTE, TTG, DST and XTE deviation indicators all show their
values to the next waypoint or to the current line segment. The
scale of the XTE deviation indicator is either 16 meters (minimum)
or 160 meters (maximum). When the ship is more than 16 meters
away from the line, the scale changes automatically. If the ship is
more than 160 meters away form the line, red and green arrows
indicate that the helmsman should steer port or starboard to
relocate. Before the ship reaches the start of the line, the indicator
will form an arrow pointing downwards.

Automatic line direction will try to change the active lines direction
according to the ships heading. This is done when the ship is close
to the line, and it is done only once. The line stays the same if the
ship turns.

If Helmsman coordinates are activated, the current position of the
ship is also displayed in a user selectable format: decimal degrees,
decimal minutes, decimal seconds or projection coordinates. If
Helmsman course offset is activated, DTK is corrected with the
value taken from the input field value. If the radio button ”Add
(degrees * 10)” is enabled, the input field value is divided by 10
(which means that if you want to correct the heading with 1 degree,
you must set 10 in the input field). If the radio button ”Automatic
true north” is enabled, the Helmsman will display DTK to the true
north.

If ”HUD” is activated the ship’s position relative to the active line
is displayed to the right as shown in figure 89. The active line is
always drawn in the centre and the ship’s position to starboard or
port of the line is then displayed. The scale along the active line is
time, and it is 10 seconds between the tic-marks. The across scale
will change automatically between 40 and 400 meters (20 to 200
meters to either side of the active line).
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The Bridge and Helmsman Display has the same colour- and
show/hide settings as Survey Display, except that coverage is on,
legend off, grid (metric) on, planning module on, displaying user
defined line names and helmsman on.
For the Helmsman display the operator can set the colours of the
background, the letters and the indicator in the XTE deviation
indicator. Remember that these settings are stored to file only when
Survey Display exits so it is really the operator of Survey Display
who decides what the colours should be.
The active line is always displayed in the Bridge and Helmsman
Display even if the operator changes the planned job in Survey
Display. This line is given the name ”ACTIVE” when it is
displayed. If the Helmsman functionality is turned on it will be
displayed whenever a line is active (and turned off automatically
when the line is deactivated).
If the button ”Output to autopilot” is enabled the system will output
NMEA APB datagrams. You must then input what device the serial
line is attached to. This is done from the ”Edit”-menu in Survey
Display where the you select ”Autopilot setup...” and an interface
pops up. If the you input something that is not a serial line device,
it is assumed that it is an ordinary file name and the NMEA APB
datagrams are written to this file (the file must already exist).

Note: NMEA APB datagrams contain information regarding the vessel’s
position with regard to the active survey line. The correctness of
this information is critically dependent on positioning system
input, correct setup of the system and user definition of the survey.
Using the APB datagrams as autopilot input is possible as a help
in steering the vessel during the survey, but it cannot in any way
relieve the vessel crew from the responsibility in safe handling of
the vessel.

Some final notes
If the planning module is off in the Bridge and Helmsman Display,
the helmsman will not see the activated line from Survey Display
in the Bridge and Helmsman Display, but the Helmsman
functionality will be active. This is an option if you want to display
for example SOG even if you are not logging: simply activate a line
and select DTK etc. in the Helmsman display.
You need to set the colours and select the planned job in Survey
Display and then exit Survey Display to set the default colours for
the Bridge and Helmsman Display.
When you reach the end of the line (or before you come to the line)
the Helmsman will continue to display the ship’s position relative
to the continuation of the last line segment of the planned line.
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The more you display in the Helmsman, the more work for the
computer and the bigger it gets. Try to choose only those values the
helmsman really needs.

If you change the planned job in Survey Display, you need to restart
the Helmsman display in order to view the changes.

Automatically setting the lines’ direction may fail in some
circumstances, like if the ship is close to the middle of the line
when it is activated, or if you try to activate the current active line.
Also note that the update of the display may be slow so you may
not see the changes immediately and that the change will not take
place until the ship is close to the line.
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9.4 Command references

Introduction
This chapter describes the various commands used throughout the
Bridge and Helmsman Display application.

The following options are available on the main menu:

• File

• Edit

• View

Each of these menu options have a number of commands available
on pull-down menus.

File

Overview

The File option on the main menu bar contains two commands:

• Print

• Exit

Print

This menu command activates the Print dialogue box, and makes
it possible for you to create a hardcopy of the current information
shown on your display.

→ The Print dialogue box is explained on page 43.

Exit

When this menu command is selected, the Bridge and Helmsman
Display program will close.
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Edit
The Edit option on the main menu bar contains these commands:

• Reset selection

• Keep function

• Position

• Distance

• New Display Area

• Resize Display Area

→ Reset selection is described on page 194.

→ Keep function is described on page 195.

→ Position is described on page 196.

→ Distance is described on page 197.

→ New Display Area is described on page 198.

→ Resize Display Area is described on page 198.

→ These commands are all used in the Survey Display application,
and they are described on page 193.
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View
The View option on the main menu bar contains the following
commands:

Several of these menu options are identical to the options on the
Survey Display main menu. These have been described previously
in this document as follows:

→ Annotation colours; described on page 200.

→ Show/Hide;described on page 202.

→ Colour mapping; described on page 204.

→ Lat/Long format; described on page 209.

→ Vessel in centre; described on page 213.

→ Update interval; described on page 214.



EM 1002 / Base version

254 850--160977/E

10 CALIBRATION

10.1 Introduction

Purpose
The purpose of the Calibration utility is to analyse survey data to
discover any systematic error in the roll, pitch or heading received
from the attitude sensor and the time delay of the positioning
systems.

It is also used to find the outer beam angle offset of the EM 1002
transducer.

The Calibration utility will also assist in judging the quality of a
sound speed profile.

The Calibration utility works on any survey data. To obtain valid
results, we recommend that survey lines planned specifically for
calibration purposes are used. These are lines where the same areas
are covered in two or more different ways.

The Calibration utility will only work with two or more selected
lines in a survey. These lines has to be selected in the survey display
before the Calibration utility is started.

You must define one or more calibration lines along which the data
will be analysed. For each line, the system will use data within a
corridor, which represents all points within a specified distance
from the line. The data will be displayed using a two-dimensional
diagram (the calibration profile window) with the horizontal axis
representing the distance along the line, and depth along the
vertical axis. Data from two different survey lines will be shown
in the same diagram, each with its own colour.

In the Calibration Profile window you can change the relevant
sensor offset and see its effect on the depths shown. The offset
value that gives the best fit betwenn the depths on the two
calibration lines is to be entered in the corresponding sensor field
in the system’s installation menu. The actual value should be a
mean of the values determined in several calibration corridors
placed at difference positions along the calibration lines.
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The Calibration utility is designed for determination of sensor
offsets. It is NOT intended for determining the angular orientation
of the system transducers, these must be determined through
measurements as described in the installation manual. The reason
for this is that it is not possible to do a linear addition of sensor
offsets and transducer orientation angles. The only exception to
this is if the transducers are oriented such that they have zero
heading and pitch installation angles, i.e. that they lie horizontal
when the pitch is zero and are mounted parallel to the keel, in which
case receive transducer roll installation angle and sensor roll offset
act as a linear sum. This may be exploited in temporary
installations where it may be very difficult to measure roll
installation angles with sufficient accuracy.

Main window and menu bar
When you start the Calibration utility the main window appears
with the following elements shown:

• Menu bar

• Graphic presentation of the survey charts

• Geographical data

• Tool bar

The menu bar contains the following options:

• File

• Edit

• View

• Help

The bottom frames in the window present the geographical data:

• Current scale (1:5335 in the example above)

• Location of the lines

→ The graphic presentation is shown in figure 91.
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Figure 91 - Calibration main window
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10.2 Calibration survey

Introduction

The correct calibration of the vessel attitude sensors and the time
delay of the positioning system is vital to the quality of the data
collected by the multibeam echo sounder. While modern motions
sensors have little or no drift with time, they may fail. The time
delay of the positioning system may vary according to system
set-up. It is therefore important that the calibration values are
checked at regular intervals, say once every month, or at the start
of a new survey.

The built-in Calibration utility is used to process data from a
calibration survey, usually consisting of one or more sets of
overlapping lines as described below. The data should be
processed by the Calibration utility, and a depth profile displayed
with data from only a narrow corridor you define. This allows a
comparison of the data collected on the two lines. Offsets may be
found entering corrections into the system and reprocessing the
lines to observe the effect of the correction.

Determining a suitable calibration area

On a flat area only roll error will cause significant depth errors.
(Sound speed and echo sounder errors are not considered in this
discussion.) Thus if the survey is to be run in a reasonably flat area,
it may be sufficient to perform roll calibration only. Usually,
however, a full calibration is required, and the calibration should
then be done so that different sensor errors have no influence on the
echo sounder data, except for the one which is to be determined.
Note that the positioning accuracy is vital for good calibration
results, except for the roll error calibration on a flat bottom. It
should also be noted that although heading calibration is in
principle possible from echo sounder data, it is recommended to
calibrate the heading sensor with the vessel lying along a quay
using standard land surveying methods.

The ideal calibration area is partly flat and partly a fairly steep
slope with little change in depth acrosstrack, and with a distinct
feature such as a peak or hollow in the flat area. If the heading and
positioning errors are negligible, the flat area is not required if the
slope has a reasonably constant depth acrosstrack.
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The slope used for pitch and time delay calibration should have an
appreciable relative change in depth from top to bottom, say 30%,
if pitch offset and time delay are to be resolved accurately. Note
that the slope should not be too steep, say not more than 20_,
otherwise the echo sounder could have problems in maintaining
good data quality.
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Roll offset in the acrosstrack direction
Choose a horizontally flat area (at least acrosstrack). Survey a
sufficiently long line twice in opposite directions. Ensure that a
sufficient lead-in time to the line is used for the roll sensor to
stabilize.

→ Refer to figure 92 on page 259.

Side view

Survey line

Calibration corridor

Survey line

BA

Top view

(CD3571)

Seabed

Figure 92 - Roll offset calibration procedure

The corridor used to compare data from the two survey data sets
should be placed orthogonally to the survey lines.



EM 1002 / Base version

260 850--160977/E

If there is a roll offset, there will be a depth difference between the
two data sets, linearly increasing with acrosstrack distance from
the centre.

Pitch offset and time delay
Choose an area with a continuous but not too steep slope
alongtrack. Survey a sufficiently long line twice in opposite
directions with the same vessel speed, and once with a significantly
lower speed. The direction is not important in the last survey.
Ensure that a sufficient lead-in time to the line is used for the pitch
sensor to stabilize.
→ Refer to figure 93 on page 261.

The corridor used to compare data from the survey data sets should
be placed parallel to the survey line on the vessel track.

Any alongtrack depth difference between the runs may be due to
four different factors:

• Pitch offset

• Time delay between actual position and position when position
datagram supposed to be valid

• Position distance offset (either due to an error in the positioning
system or an error in entered locations

• Tide difference

Note that a depth error on a constant gradient slope due to pitch
offset, increases with increasing depths, while that due to position
time delay increases with vessel speed, and that due to distance
offset is independent of depth and speed but varies with slope
angle.

Using a profile on the two lines in the same direction, but with
different vessel speed, will thus allow the time delay to be found.
After the correction has been applied to the data, you can determine
the pitch offset from the two lines run in opposite directions. Any
distance offset must of course first be removed.

Heading offset

Note: The best check of the gyro is done with theodolite in the harbour.

Alternative 1

Run two parallel lines up or down a slope in the same direction,
separated, but with overlap in-between. The corridor used for
comparison should be placed alongtrack in-between the lines. Any
heading offset will give a depth difference between the two lines.
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Figure 93 - Pitch offset and time delay calibration procedure

Side view

Slope

Survey line

Calibration corridor

Slope

Survey line B

A

Top view

(CD3571)

Seabed

→ Refer to figure 94 on page 262.

Alternative 2

Find an easy recognizable point or feature on the bottom such as
a peak or a depression. This may be difficult !

Set up two survey lines well to opposite sides of this feature so that
the point will be in the outer part of the echo sounder swath. Survey
these two lines in same direction.
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Side view

Slope

Survey line

Calibration corridor

B

A

Top view

(CD3571)

Seabed

Survey line 1 Survey line 2

Slope

Figure 94 - Heading offset calibration procedure
(Alternative 1)

The corridor used to compare data from the two survey data sets
should be placed so that it intersects the feature, and is parallel to
the survey lines. If there is a heading offset, you will have a
different location alongtrack in the two data sets. Note that
accurate positions and position time delays are required.

→ Refer to figure 95 on page 263.
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Side view

Seabed

Survey line

Calibration corridor

Survey line Survey line

B

A

Reference point

Top view

Reference point

(CD3572)

Figure 95 - Heading offset calibration procedure
(Alternative 2)

Verification
After the calibration has been completed, we strongly advise you
to repeat the procedure for verification. This is especially
necessary if you initially had large errors (exceeding 1 - 2 degrees).



EM 1002 / Base version

264 850--160977/E

Outer beam angle offset calibration
Run two perpendicular survey lines on a relatively flat bottom. The
depth should be approximately 50 to 100 meters, and 150 degrees
coverage should be used. In the crossover area of the two lines, use
the roll calibration utility. Set a calibration corridor along each of
the tracklines in figure 96. Any angular error at the points 2, 4, 6
or 8 may be due to errors in

• outer beam angle offset

• sound speed

• roll offset

If sound speed and roll offset are correct, determine angular errors
by changing the roll offset angle to make the outer beam depths
equal at 2, 4, 6 and 8, and take the average of these. If the outer
beams are too shallow compared to the centre beams, the outer
beam angle offset is positive, if they are too deep the outer beam
angle offset is negative. Add the outer beam angle offset with sign
to the outer beam angle offset already used in the installation menu.

Note: The diagonal through 1 and 9 may be used to check roll offset. Thus
a crossline calibration is a good check to see if the system is well
calibrated. The outer beam angle offset is critically dependent
upon correct roll calibration and correct sound speed calibration.
Ensuring that these are correct before doing an outer beam angle
offset, is a sound principle.

→ Refer to figure 96 for the principles.

Sound speed control
The same procedure as used for the outer beam angle offset
calibration may be used as a check for sound speed corrections.
Provided that the roll offset and outer beam angle offsets are
correct, any depth deviation between the two lines in the two
calibration corridors are due to sound speed errors, either in the
used profile, and/or in the sound speed at transducer depth.
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Figure 96 - Offset beam angle calibration
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10.3 Command references

Overview
This chapter describes the various commands used throughout the
Calibration utility.

The next pages describes the various commands used throughout
the Calibration utility, and refers to other descriptions as required.

The following options are available on the main menu:

• File

• Edit

• View

• Help

Each of these menu options have a number of commands available
on pull-down menus.

The Help option provides on-line help, and is not described.

File

Overview

The File option on the main menu bar contains two commands:

• Plot

• Exit

Plot

This menu command activates the Print dialogue box, and makes
it possible for you to create a hardcopy of the current information
shown on your display.

→ Refer to the description on page 43.

Exit

When this menu command is selected, the Calibration utility will
terminate.
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Edit

Overview

The Edit option on the main menu bar contains these commands:

• Reset selection

• Keep function

• Position

• Distance

• New line

• Move point

• Move region

• Delete region

• Pitch calibration

• Roll calibration

• Compass calibration

The drop-down Edit menu contains the same commands for
measuring distances and positions, as the survey display. In
addition, there are commands for calibration line definition and
manipulation, and commands for initiating a calibration analysis
of data along the calibration lines.

The right mouse button is used as an edit button when the pointer
is inside the geographical area of the window. Select a menu
command with the left mouse button, and then use the right mouse
button inside the geographical area to execute the command.

Note: To work with the calibration lines, they must be visible on the
screen. Make sure the Calibration lines entry in the Show/Hide
dialogue box (available from the View menu) is checked.

→ See Reset selection described on page 194.

→ See Keep function described on page 195.

→ See Position described on page 196.

→ See Distance described on page 197.
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New Line

This command is used to create a new calibration corridor. Depth
profiles will be made along this corridor.

After this menu command has been selected, a new line is made by
placing the pointer at an initial point, pressing the right mouse
button and dragging the pointer to where the line should end. The
profile will be from where the first point was set and to the point
where the mouse button was released.

Move Point

This command is used to drag the initial point or end point of a
calibration corridor to a new position.

Use the right mouse button to drag the point. This is useful for
changing the direction or length of calibration corridors generated
by New Line.

Move Region

This command is used to move a calibration corridor and
corresponding region to a new position.

This is done by selecting the Move Region menu command, and
then using the right mouse button to drag the region to another
place.

Delete Region

This command is used to remove a calibration corridor and
corresponding region.

This is done by selecting the Delete Region menu command, and
then click on the region using the right mouse button. The region
must not be in use.
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Pitch Calibration

This command is used to analyze data in the region around a
calibration line in order to do pitch and/or position delay
calibration.

Use the following procedure:

1 Select two separate lines to use for pitch calibration. These
lines should cover the same track, but be in opposite
direction.

2 Generate a calibration corridor in the same direction as the
two selected lines, and located on the top of the same lines.

3 Select the Pitch calibration menu command.

4 Click on the calibration corridor of interest with the right
mouse button. This calibration corridor should be parallel to
the vessel track, and include a steep slope.

A calibration profile window will appear. This window is
explained below.

Roll Calibration

This command is used to analyze data in the region around a
calibration line in order to do roll calibration.

Use the following procedure:

1 Select two separate lines to use for roll calibration. These
lines should cover the same track over a flat sea floor, but be
in opposite direction.

2 Generate a calibration corridor perpendicular to the two
selected calibration lines.

3 Select the Roll calibration menu command.

4 Click on the calibration corridor of interest with the right
mouse button.
- This calibration corridor must be normal to the vessel

track.
A calibration profile window appears. This window is explained
below.

Compass Calibration

This command is used to analyze data in the region around a
calibration line in order to do heading (compass) calibration.

Use the following procedure:

1 Select two separate and parallel lines to use for this
calibration.
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- When you run your multibeam echo sounder according to
these two lines, the covered area must overlap between
the lines. In the commonly covered area, you must also
make sure that you have an easily identified obstacle,
such as a large rock or a wreck on the seabed.

2 Generate a calibration corridor in the same direction as the
two selected lines, covering the overlapped area between
them.

3 Select the Compass calibration command.

4 Click in the calibration corridor with the right mouse button.

A calibration profile window will appear. This window is
explained below.

Calibration profile windows

Both Roll, Pitch and Compass calibration use the same type of
window for calibration data analysis. The window appears when
one of these commands are used.

The purpose of the window is to display the depth data as found
inside the calibration corridor. Data from the two survey lines are
displayed simultaneously using different colour for each line. The
X-axis represents the distance along the calibration corridor, and
goes from the initial point to the end point of the calibration
corridor.

→ The windows are shown in figures 97 and 98 below; one for roll
calibration and one for pitch/time calibration. The compass
calibration window is similar to the roll calibration window.

Figure 97 - Calibration profile window for roll calibration
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Figure 98 - Calibration profile window for pitch/time
calibration

Window elements

Each window contains the following elements:

• Information and tool bar

• Graphic area

• Control area

On the left hand side of the graphic area the profile window
contains the following controls:

Information and tool bar

Dir

This information shows the heading of the two lines. The same
colours as applied for the depth profiles, are used to distinguish the
two lines.

Slide bars

The two slide bars are used to change the sensor offset values used
in the calibration computations.

• The calibration profile window for roll contains one slide bar.
This is used to change the offset value for roll sensor data.

• The calibration profile window for pitch/time contains two
slide bars. One is used for the time offset of the positions, and
the other for the pitch offset.

The current offset values are displayed above each slide bar.
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The slide bars are used to change the offset values by dragging the
slider, clicking on the arrows (the values change in minor steps) or
clicking to either side of the slider (the values change in major
steps). The size of the minor and major steps can be set using the
Setup button described below.

The offset values are added to the recorded data as the profiles are
plotted in the graphic part of the window. The recorded data are not
changed.

Any offset values set in the installation parameter form are added
to the data as they are logged. The calibration module has no
knowledge about these offset values. New offset values found
using the calibration module on data from this survey may be used
to generate new installation offset values by adding them to those
already defined in the installation parameter form.

Corridor

The corridor field is a text input field where the distance from the
calibration line to the border of the region on both sides can be set.

A corridor value of 10 meters generate a rectangle of width 2*10
meters and length as the calibration line.

Note: The corridor field already has a value when the Pitch calibration
or Roll calibration menu commands is selected from the Edit menu.
This value may be too high, resulting in too much data to be
displayed (which takes time). In order to limit the amount of data,
a very short calibration line may be used first, just to bring up the
calibration profile window. Then, the corridor value can be
adjusted. Close the profile window and start over again, this time
using the calibration line length you really wanted to use.

Setup

This button brings up a new window where the range covered by
the slide bars, and minor and major steps used when the arrows or
slide bar is clicked, can be defined.

The following values can be set:

• Min (minimum of range)

• Max (maximum of range)

• Step

• SubStep

Step is the change made to the value when the mouse pointer is
clicked on either side of the slider, and SubStep is the change made
to the value when clicking on the arrows.
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Cancel will close the window without any changes, while OK will
use the new values.

Redraw

This button is used to force a redraw of the data in the graphical part
of the window.

Z Zoom in
z zoom out
R Reset the view to the initial setting
U Undo last zoom

Acceptance

The acceptance area at the bottom of the window holds three
buttons.

OK - This button saves the data to the ASCII file CalibValues on
the processing directory.

Cancel - This button just closes the window without any changes
taking place

Help - This button brings up help information about the profile
window.
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10.4 View

Overview
The View option on the menu bar contains these commands:

• Annotation colour

• Show/Hide

• Lat/long format

• Colour mapping

The Annotation Colours command presents the Annotation
Colours dialogue box, where you can modify the various colours
used in your graphical window presentations.

→ Refer to the description on page 200

The Show/Hide command presents the Show/Hide dialogue box,
which contains a list of items that may exist in the client area of the
geographical window. These items can either be displayed or
hidden.

→ Refer to the description on page 202.

The Lat/long format command allows you to choose the scales
along each of the axes in a geographical window. These represent
geographical latitude and longitude respectively.

→ Refer to the description on page 209.

The Colour mapping command allows you to manipulate with the
colours in the graphical window.

→ Refer to the description on page 204.
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Help
The Help option provides on-line help.
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11 CROSSLINES

11.1 Introduction
The Crosslines application makes it possible to evaluate the data
quality of the multibeam echo sounder inside a corridor generated
in any direction in the survey area.

An arbitrary number of survey lines can be selected, and the depths
in these lines will be visualized inside the corridor as a cross
profile. The depth data can be recalculated for new roll and pitch
offsets and time delay and the depth changes are visualized
directly. The module also recalculates the depth with new sound
speed profiles selected by the user. This module is powerful tool
for analysing the depth errors generated by inaccuracies or
incorrect calibration of the external sensors.

The Crosslines application has in many respects the same
functionality as Calibration. The main differences are that
Crosslines allows re-processing using new sound speed profiles,
and allows simultaneous viewing of data in many corridors. In
addition, Crosslines is much faster because it only processes the
data in and in the near vicinity of the corridors, and it can thus allow
many more survey lines than Calibration.

Crosslines is available from several of the geographical displays
in the Kongsberg Simrad multibeam echo sounders and
postprocessing systems. Crosslines may then be defined and
viewed. The survey lines from which data is to be analyzed are
selected in the survey display and a crossline is also selected.
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11.2 Operational Procedures

To start a new crossline
1 Start the Survey Display.

2 Select Displays.

3 Select Create Grid.

4 Select Displays.

5 Select Grid Display.

6 Select Crosslines.

To save a crossline
1 Select Save Crosslines on the Crosslines menu.

To delete a crossline
1 Position the mouse cursor on top of the line you wish to

delete, and click once.

2 Select Delete Crossline on the Crosslines menu.

To move a crossline
1 Select Move line on the Crosslines menu.

2 Position the mouse cursor on top of the line you wish to
move, click and hold the right mouse button.

3 Move the mouse cursor to where you wish the crossline to
move, and release the mouse button.

To move a point
1 Select Move Point on the Crosslines menu.

2 Position the mouse cursor on top of the point you wish to
move.

3 Click on the selected point, and hold the right mouse button
depressed.

4 Move the mouse cursor to where you wish the point to move,
and release the mouse button.

To change the crossline corridor width
1 Use the mouse and click once on the crossline you wish to

modify.
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2 Select Change Width of Selected Crossline on the
Crosslines menu.

3 Enter the new width value in the dialogue box.
- The width value is entered in meters.

4 Press Ok to apply and close, or Cancel to close the dialogue
box without changing the width.

To assign a sound velocity profile to a
crossline

1 Select Crosslines -> Start displayCrosslines to open the
Crosslines window.

2 In the Crosslines window, select Assign sound velocity
profile to file from the Edit menu.
- The Set SVP correction dialogue box appears.

3 Select a survey line in the left list in the Set SVP correction
dialogue box, and a sound velocity profile in the middle list.

4 Click the Make pairs button.
- The chosen pair of the selected survey line and the sound

speed profile will be displayed in the right list.

5 Click Ok to exit.

Figure 99 - The Set SVP correction dialogue box

To delete a pair

To delete a pair, select that pair in the right list and click the Delete
pair button.

The Ok button commits these pairs to be reprocessed.
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11.3 Crosslines menu

Overview
The Crosslines utility is accessed as a command, and controlled
from a sub-menu. You may find it convenient to “tear off” this
sub-menu to place the Crosslines menu in a separate window.

The menu provides the following options:

• New crossline

• Delete crossline

• Move line

• Move point

• Change width of selected crossline

• Save crosslines

• Start display Crosslines

The majority of these commands are uncomplicated, and they are
briefly explained below. The Start display Crosslines provides a
geographical display.

New Crossline
This command is used to create a new crossline.
→ Refer to page 277 for the procedure.

Delete Crossline
This command is used to delete a selected crossline.
→ Refer to page 277 for the procedure.

Move Line
This command is sued to move a crossline.
→ Refer to page 277 for the procedure.

Move point
This command is used to move one of the end points of a crossline.
→ Refer to page 277 for the procedure.

Change width of selected crosslines
This command is used to change the width of the corridor along
one or more crosslines. Selecting the command presents the
Change Crossline Width dialogue box, where you can enter the
new width.



EM 1002 / Base version

280 850-160977/E

→ Refer to page 277 for the procedure.

Save crosslines
Use this command to save the crossline definitions and the
selection of survey lines to a file for later use in the current or other
geographical displays. This is not required if the crossline display
is entered immediately as the file will then be generated
automatically when exiting that display.

→ Refer to page 277 for the procedure.

Start display Crosslines
You need to select both at least one survey line and a crossline.
Then you must save the crossline selected before you can start the
display Crosslines.

The Crossline display will run faster with fewer survey lines. You
can load maximum 15 crosslines into Crosslines at one time.
However, maximum four -4- crosslines can be displayed
simultaneously.
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11.4 Crosslines window

Overview
In the main geographical window, the crossline number is always
displayed in the beginning of the line. In the Crosslines display, the
selected line(s) are shown with the names and the corresponding
line depths identified using the same colour.
→ Refer to figure 100 for a Crosslines window example.

Note: Note that Crosslines and Planning must never be operated
simultaneously as the system does not then know which module
should receive results from mouse operation in the geographical
windows.

Figure 100 - The Crosslines window

The length of the corridor is shown along the x-axis, and the depth
is shown along the y-axis.

The scrollbars can be used to scroll up and down the y-axis and
along the x-axis (along the crossline). The maximum alongtrack
resolution is 10 centimeters. If the resolution is such that there is
more than one depth value with in a range corresponding to a pixel,
a vertical line between the minimum and the maximum depth is
shown in that pixel.

The Crosslines display provides the following options on the main
menu:

• File

• Edit

• View

• Help
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File
The only command on the File menu is Exit. Use this command
to close the window.

Edit
You can reprocess the data in the crosslines with new offsets in
time, roll and pitch, and he can reprocess the data with new sound
speed profiles. The setup for this processing is controlled in the edit
menu. Offsets affect all lines in all crosslines.

Set time, roll and pitch offset

You can change the time, roll and pitch offsets. Clicking the Apply
button processes the data in the crosslines with the new offsets
immediately. Otherwise the reprocessing is done after clicking
Apply current values.

Assign sound velocity profile to file

Each selected survey line can be reprocessed with a different sound
speed profile than the one used during the survey. Different
profiles may be used for every survey line.

In the left a list all the survey lines selected for this crossline are
shown, and in the middle a list of all available sound speed profile
files is shown. The profiles must be stored in ASCII format
(*.asvp).

→ A procedure is given on page 278.

Sound velocity profile editor

This buttons starts the Sound Speed Profile Editor.

→ This application is described on page 321.

Save values to file

The current offset values for time, roll, pitch and SVP are written
to the file
$PROCHOME/<survey>/crossSettings.dat

This is a readable ASCII file.

Apply current values

This reprocesses the crosslines with the current settings for offsets
and sound speed profiles.

Show current values

Shows the current values.
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View
The view menu is used to control the display.

Assign crosslines to windows

There are four windows defined in displayCrosslines. There can be
15 crosslines at one time. In this interface you can decide which
crossline should be displayed in what window. Each crossline is
listed with four buttons behind it. These buttons are labeled 1
through 4. Clicking the button 1 in the line for Crossline 1 will
display Crossline 1 in window one, and so on. The color of the
button will change from blue to green for the window in use.

Windows

You can choose how many windows he wants to see at one time,
1, 2 or 4. With two windows the screen can be split horizontally or
vertically.

Display crossline number

This toggles on and off the display of the crossline number.

Data about the crosslines

Some information about the crosslines and the survey lines in the
crosslines are available. You are first presented with the interface
above. For each crossline information about the crossline itself or
about the survey lines inside that crossline can be shown. If you
click the Crossline values button the following popup window is
shown with the crossline number, the length, width and the
direction of the crossline. Also the coordinates for the crossline is
shown both in projection coordinates and geographic coordinates
(decimal minutes):

If you click the Crossline values button, a window is shown with
the line name, average direction and average speed. Clicking on the
Lines button displays line name, heading and speed.

Draw lines between depths

This toggles on and off the drawing of lines between depths.

Background black / white

Toggles the background color between white and black.

Noise reduction

Toggles on and off noise reduction. The noise reduction is a low
pass filter on the depths along the corridor.
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Set scales

You can set the desired scale in the x- and y-direction. The
x-direction is centimeters along the crossline and the y-direction
is centimeters depth. The y-scale defines how many centimeters
depth there is per centimeter on the screen. The x-direction defines
how many centimeters along the crosslines there is per centimeter
on the screen.

The length of a crossline may vary very much. Therefore the
maximum value of the scrollbar can be set to 1000, 10000 of
100000 centimeters. This means that displayCrosslines can display
a maximum of 1 kilometer per centimeter on the screen in the
x-direction. Setting the correct maximum value for the x-scale
makes it easier to operate the scrollbar.

Clicking the button ”Factory defaults” will cause
displayCrosslines to calculate a best fit scale in x- and y-direction,
based on the current size of the screen, the minimum and maximum
depth and the maximum crossline length. Note that it is the longest
crossline that defines the scale in the x-direction.

Draw grid

Toggles on and off the drawing of a grid in displayCrosslines.

Line legend

Toggles on and off the drawing of the line name in
displayCrosslines.ping
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12 PLANNING

12.1 Introduction
A survey is seldom performed without any planning being done
beforehand. A comprehensive plan would normally define the
following:

• the area to be surveyed

• the survey lines which the vessel must follow

• the direction and order in which the lines are to be run

• the lines required for system calibration

• the location and timing for sound speed profiles

Figure 101 - Survey Display example with survey lines,
planned lines and a polygon
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The planned lines must take into account islands, coastlines, shoals
or other obstacles within the survey area which may limit a safe and
efficient survey. The achieveable coverage of the multibeam echo
sounder and the overlap required between the neighboring lines is
usually used to determine the line spacing.

A fully comprehensive survey plan is most useful in areas of deep
waters or where the depth and hence coverage is fairly constant. In
shallow waters where the depth changes rapidly and may not even
be known well enough aforehand, a comprehensive plan may not
be as useful, especially if the survey is to be run with a small and
agile vessel. A defined survey area boundary plus a few
pre-planned lines for calibration could then be enough, actual
coverage as obtained on the spot being instead used to determine
where the vessel is to run.

The Planning module allows a survey to be split into sub-surveys
or jobs. The survey area boundary may be defined as a polygon
with any number of corners, as may areas which are not to be
entered. Automatic line clipping at the polygon boundaries and
automatic generation of parallel lines is supported. If the area has
previously been surveyed, it is possible to import shoal depths
from Neptune (BinStat) into the plan.

When the survey is run, planned lines may be activated to generate
steering information on the bridge and helmsman displays.

The purpose of the Planning utility is thus to provide help before
and during the survey.
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12.2 Operational procedures

Introduction

These operational procedures cover the main functions available
in the Planning utility.

To open a job

1 Select Jobs -> Open.
- A small dialogue box appears. It lists the current jobs

available, and allows you to select on.

2 Press OK

3 Select the type of coordinates to use.

To save a job

1 Press Jobs -> Save to save the job.
- The job is automatically saved with the name you defined

when you created it.

To create planning lines

The Planning utility is started from the main menu on the Survey
Grid Display. You may find in convenient to “tear off” the menu,
this allows you much easier access to the commands.

1 Select Jobs -> New.
- A small dialogue box appears to accept your plan name.

2 Type in the job name and the press OK
- A second dialogue box appears to accept the format of the

coordinates, and a short plan description.

3 Select the correct Save coordinates as, enter descriptive text
(if desired) and press OK.

4 Start line creation by selecting Lines -> New.

5 Draw the line holding the right hand mouse button
depressed.

6 Select the line and select Lines -> Parallels.

7 Fill in the values and press OK.
- You can here create any number of parallel lines for your

survey. Enter the the number of lines to port and
starboard, and the distance (in meters) between them.

8 Save the job.
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Figure 102 - Creating parallel lines
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To create a polygon

1 Select Planning -> Polygons.
- A submenu appears. Click on the tear-off line to place the

menu in a separate window.
2 Select New on the submenu.

3 Create the polygon by holding down the right hand mouse
button.
- Establish the lines by pressing the middle mouse button

at the desired points. When the last point is reached
release the mouse button and the program automatically
closes the polygon.

4 Save the job.

→ See page 287 to save the job.

To draw a line through a polygon

1 Select Lines -> New.
- Use the right hand mouse button to draw the line.

2 Save the job once more to keep the changes.

To fill a polygon

1 Select both the line and the poygon.

2 Select Polygon -> Fill.
- Fill in the proper values and press OK. The lines are now

inside the polygon borders.

3 Now save the job once more to keep the changes.
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12.3 Command references

Introduction
The following commands are available from the Planning menu:

• Jobs
• Print
• Lines
• Polygons
• Activate line
• Deactivate line
• Select all lines
• Export selected lines
• Import planned shoals from BinStat
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Jobs

Overview
A “job” is a collection of planned lines and possibly one or more
polygons. Each job is given a unique name. A job must first be
selected as the current job before any other operations can be
performed. The selected job can either be new, or you can continue
to work on an existing job.
Once you select this option, you are prompted with a submenu:
• New...
• Open...
• Delete
• Options...
• Save
During your work, you may find it convenient to “tear off” this
sub-menu to place it in a separate window.

New
Use this command to create a new job. The name of the new job
must be written in the text field in the first dialogue box, the New
job dialogue box. The second dialogue box (Options) is used to
select how to save the coordinates, and to enter additional job
information.

Note: If you create a new job with the same name as an existing job, the
existing job will be deleted and replaced with the new. No warning
will be given.

Figure 103 - The New job first dialogue box

→ A procedure explaining how to define a new job (and to create
planning lines) is given on page 287.

Open
Use this command to open a previously defined job. Select a job
from lists within the current survey, and click Ok to retrieve it.
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Figure 104 - The Options dialogue box

→ Refer to figure 105

Figure 105 - The Open Job window

Delete

Use this command to delete a current job. You are given a warning
before the system allows you to delete the job.

Options

The Options choice on the Jobs submenu allows you to define the
coordinate format, i.e. the decimal degrees, decimal minutes,
decimal seconds or grid (projection) coordinates. The active
settings are displayed in the label on top (”Current job is:...”).
Additional text information may also be attached to the job. It can
be entered and read in the text field labelled Job information.
Click Apply or OK to make the selections active.

→ Refer to figure 104!

Save

Save writes the planned lines and polygons in the current job to
disk. The current job is always saved when you exit the application
or changes the current job.
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The planning module is available in the Survey and the Grid
Display. A plan made in one module will be available in all the
other modules of a system. In case a job is saved in one module
while it is being edited in another module, a warning will be given
if save or exit is chosen in the other module, to allow you to choose
which version is actually to be saved.

Print
This choice allows you to print out the current information in the
graphic window.

Figure 106 - The Print dialogue box

→ This is a common function, and it is described with the operational
procedures. Refer to page 43.
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Lines

Overview

The Lines submenu is used for all line manipulations such as
creation, editing, deletion or selection. The following options are
available on the submenu:

• New

• Edit... ->

• Move

• Reverse direction

• Delete

• Parallels...

• Select...

• Cancel selections

• Keep function

New

A new planned line is created by pressing the right mouse button
down where the line is to start and releasing it where the line is to
end. To create a waypoint in the line, click the middle mouse button
where the waypoint is to be, before releasing the right button at the
endpoint.

The new line is always given a default linename by the system:
_YYYYMMDD_nnn

DD is the day of the month, MM is the month, YYYY is the year,
and nnn is a linenumber which makes the linename unique. Note
that all system generated line names begin with underscore The
name is printed at the end of the line.

Edit...

The Edit command presents a sub-menu with the following
choices:

• Position editor

• Rename...

• Move point

• Extend

Position editor

Selected lines and polygons (at most 10 lines or polygons at a time)
may be edited using the keyboard. The Edit lines dialogue box is
used for this.
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→ Refer to figure 107

Figure 107 - The Edit lines dialogue box

The line or polygon to be edited is selected from list containing all
selected lines and polygons. A new line is also available in the list,
and it may be turned into a new polygon by clicking the toggle
button This is a polygon, not a line. Line names, point
coordinates, and information (text) attached to the line are all
editable in their respective fields.

The coordinate format for the points is as defined for the job, and
the coordinate format is also written right below the text field
containing the line name. When coordinates are entered they
should be terminated by clicking the Enter button on the keyboard
to see that the program interprets the entered value correctly.

Note that decimal minutes usually requires four (or five) digits. i.e.
5903.0 will be read as 59 degrees, 3 minutes (593.0 is 5 degrees,
93 minutes which again is 6 degrees, 33 minutes).

Clicking the New button for a point will add a new waypoint after
that point or new end point if the point is the last. A new start point
in the line may be added by clicking the New first point button.
Points between the first and last point in the list will be waypoints
and may be deleted by clicking Delete.

Any changes will not take effect until one of the buttons Ok or
Apply is clicked. All changes are discarded by clicking one of the
buttons Cancel or Reset.
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Note: A line must have at least two coordinates and a line name. A
polygon must have at least three coordinates. Any changes are only
committed after clicking the button Ok or Apply.

Rename...

This command can be used to rename any of the planned lines. You
can only rename one line at the time.

Move point

Any point on a line may be moved with the mouse by selecting
Move point, and then dragging the point to the desired position
holding down the right mouse button.

Extend

Extend works like Move point, but a new end point is added from
one of the previously selected end points. Any line can be extended
by using this command. The end of this line will become a
waypoint, and a new endpoint is generated.

Move

Any line may be moved with the mouse by selecting Move line,
and then dragging the line to the desired position holding down the
right mouse button.

Reverse direction

Every line has a defined direction. The line name is shown at the
end of the line. You can select any number of lines and change the
direction of these lines.

Delete

The selected lines are deleted. Any selected polygons are not
deleted.

Parallels...

A user defined number of lines parallel to a selected line may be
created by selecting this option. The above popup window is used
to define the number of lines to be created on each side of the
selected line, and their spacing.

→ The Parallel lines dialogue box is shown in figure 102 on page
288.

Select...

Lines can be selected by four different criteria through clicking the
respective toggle buttons in the dialogue box.
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Figure 108 - Select Lines dialogue box

• Select lines from list below: lines are selected by clicking on
their names.

• Select all lines created between these two times: lines are
selected through the date and time the lines were created and the
entered time limits (the time of creation is stored allthough it is
not visible).

• Select all lines with some information attached: all lines that
have attached information are selected.

• Select all lines with non-system defined line names: all lines
with user defined names, i.e. names not starting with underscore
(_), are selected.

You can choose to use some or all of these options. Click the Ok
or Apply button to select the chosen lines. The sensible number of
lines selected at any one time will depend on what is to be done
with them.

Note: Lines can also be selected by standard mouse operations.



EM 1002 / Base version

298 850-160977/E

Cancel selections

Use this option to deselect previously selected lines (not
polygons).

Keep function

Selecting Keep function will allow repetition of the chosen
function many times without clicking in the menu. Selecting Keep
function again allows a new item from the menu to be chosen.

→ The command is also described in general terms on page 195.
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Polygons

Overview

The following options are available from this submenu:

• New

• Edit

• Delete

• Fill

• Clip selected lines

• Keep function

New

Use this command to create a polygon.

Note: A polygon must have at least three points. A line from the last point
to the first point is generated automatically.

The name of a polygon is always ”polygon”. A specific polygon
can thus only be selected by a standard mouse operation, and only
one polygon can be selected at any time.

→ Refer to page 289 for a procedure.

Edit

This command presents two choices:

• Position editor

• Move point

Both of these function as for the Lines->Edit command.

→ Refer to the description on page 294.

Delete

Deletes the selected polygon. Selected lines are not deleted.

Fill

Use this command to fill a polygon.

→ Refer to page 289 for a procedure.

→ Refer to figure 109 for the Fill polygon dialogue box.

The selected polygon will be filled with lines parallel to the
selected line, and all the lines will be clipped so that the start- and
end-point of each line is exactly on the boundary of the selected
polygon.
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Figure 109 - The Fill polygon dialogue box

All the lines which are created in this way are given new linenames
by the system. There is no point in editing this line (changing the
linename or adding information to the line) prior to using it in this
operation sincxe they are also given new linenames by the system.

Note: There is no check on the possibility of creating more than the
maximum of 1000 lines allowed in the planning module.

Clip selected lines

This command presents two choices:

• Keep inside

• Keep outside

Keep inside

The parts of lines which extend outside a polygon’s boundary may
be deleted by this command. Note that the command will not
extend lines to the boundary if they are within the polygon.

All the lines which are changed in this way are given new
linenames by the system. So there is no point in editing these lines
(changing the linename or adding information to the line) prior to
using them in this operation.

Keep outside

The parts of lines which extend inside a polygon’s boundary may
be deleted by this command. Note that the command will not
extend lines to the boundary if they are outside the polygon.

All the lines which are changed in this way are given new
linenames by the system. There is therefore no point in editing
these lines (changing the linename or adding information to the
line) prior to using them in this operation.
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Keep function

This command works the same way as the Lines -> Keep
function.

→ The command is also described in general terms on page 195.
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Activate line
After a line has been selected it can be made active. The active line
is usually the current line to survey. The information on the bridge
and helmsman’s displays will depend on which line is active.

Deactivate line
Deactivates the active line.

Select all lines
Selects all the lines (no polygons are selected).

Export selected lines
You can select any number of lines and polygons and copy these
objects to another job by selecting Export selected lines. The
above popup window is used to select the target job. After the lines
have been copied, they are still selected so they can thus for
example easily be deleted from the current job.

Note: Note that this operation may cause the limit of 1000 lines in a job
to be exceeded.

If there are possible duplicate linenames in a job due to the export
operation, the exported lines are renamed by adding the extension
’_1’ or ’_2’ and so on if the extension already exists(however too
many extensions may finally cause an error).

Import planned points from BinStat
In the Neptune BinStat module it is possible to select individual
depths and put a flag on them. One of these flag types available is
the Manually Planned Shoal. The depth points flagged in this way
can be imported to the Planning module by selecting Import
planned points from BinStat. The dialogue box is used to choose
which survey the depth points are to be imported from (this must
be done on a workstation running Neptune). Clicking the Ok
button causes All Manually Planned Shoals created in Neptune
BinStat for the chosen survey to be read into the current job.

Each planned shoal will be given a planned line in the planning
module. These lines will be approximately 3 meters long and be
oriented North-South. The exact location of the planned shoal in
BinStat is the middle point of these planned lines. There will be
some information attached to each of these lines: the shoal depth,
the text ’BinStat’, and the survey name.
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Figure 110 - The Import form BinStat dialogue box

Importing planned shoals from BinStat from the same survey
several times will only retain the last imported set, but several sets
may be imported from different surveys.

Note: Note that this operation may cause the limit of 1000 lines in a job
to be exceeded.
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13 SONAR IMAGE

13.1 Purpose
The Sonar Image utility displays the seabed image data. For each
ping a straight line is plotted, this covers the swath width. The
darkness of the display at any point represents the reflectivity of the
bottom. The resulting plot (shown below) may be sent to a printer
or shown on the screen.
The sonar image display may be set up for correct scaling in both
directions. The presentation may also be chose to take into account
actual footprint size alongtrack and small heading changes.
This utility may be run in two operational modes:
• Real time mode (on-line while logging of Seabed Image Data

is active)

Note: Data are only drawn in the display while the chosen workspace for
this display is active.

• Replay mode (off-line where data is taken from a previously
logged line). A line selection box is then available.

(JPG017)

Figure 111 - The Sonar Image window

The Sonar Image is shown in the figure above. Black represents
high reflectivity, and white low reflectivity. Time and position is
printed out as annotations at given intervals. The depth of the
centre beam is also printed.
When activated, the Sonar Image utility presents an opening
dialogue box to collect the required parameters. After the
parameters are defined, you press the Continue button to see the
images.

13.2 Sonar Image windows

The parameter window
The Parameter window contains a wide range of settings.
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→ These are described on page 307.

The sidescan window
The Seabed window presents the graphical result of the
processing.
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13.3 Operational procedures

To start the Sonar Image
Select the following command sequence in the Survey Display:

1 Select Processing on the main menu.

2 Select Sonar Image on the drop-down menu.

This opens the Sonar Image dialogue box.

There is one small difference in this dialogue box between the two
operational modes: In replay mode, a push-button to select the line
to be replayed is added to the top of the dialogue box.

The current settings of the dialogue box are used as defaults when
the utility is restarted later on the same survey.

To exit Sonar Image
The dialogue box stays open as long as the Sonar Image utility is
active. To exit from the Sonar Image utility:

1 Press the Exit button at the bottom of the dialogue box.

To select a line in Replay mode
Refer to the Sonar Image utility dialogue box.

1 Identify the Line Name, label and button at the top of the
dialogue box.

2 Press the push- button and a selection box appears.

3 Select the line to be replayed by pointing at it in the list, and
press the left mouse button.

4 Press Ok at the bottom of the box, and the selection box is
closed.

or:

Press Cancel to close the selection box without any changes.

The name of the selected line is written on the line selection
push-button. In this way you will see which line is being replayed.
To select another line, just press the push-button again and the
selection box will appear again.
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13.4 Command references

Overview
As previously described, the Sonar Image opens with the Ss
real-Time dialogue box, while the sidescan window only presents
the graphic result.

The settings to be made in the Ss real-Time dialogue box are
described on the following pages.

Parameter settings

Introduction

The Sonar Image dialogue box contains a number of buttons and
selectors used to generate the image.

(JPG016)

Figure 112 - The Sonar Image parameters

Line selection

This button is used to select a survey line in Replay mode.

Note: This button only appears in Replay mode. It is not shown on the
illustration above.
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The line to be replayed is selected in a similar way as a file is
selected from a file selection box. A procedure is presented in the
previous chapter.

Pixel reduction method

This setting is used to select which method to use for representing
multiple data values by one pixel. Each pixel may cover multiple
data values and the following alternatives exist for deriving the
pixel value:

Average - The average of all samples.

Last - The last sample is displayed.

Max - The maximum sample is displayed.

Min - The minimum sample is displayed.

1D median filter size

This option allows you to set the window size of a filter to replace
the central data value in the window with the median of all values
falling into the window.

You can set up this median filter to filter the samples of a single
ping. The filter moves from port to starboard side, and the filter
length (the number of values in the filter at the same time) can be
selected among the given values.

Distance calculation

This button gives you four ways to calculate the alongtrack scaling,
and you can select one of the options below:

• Pixel steps
• Fixed speed
• Vessel speed
• Position

Pixel steps

The alongtrack movement consists of moving one pixel line
forward in the display buffer. This means that no real geographical
scaling takes place in the alongtrack direction, but just a pixel by
pixel forward movement for each ping. No further scaling is thus
possible, it is only a relative visualisation.

Fixed speed

You can use fixed speed to calculate the position of the pings, and
thus the placement of the pixels in the display. If this option is
selected, you will have to define the fixed speed to be used. The
value should be in meters/second, and it must be entered in the text
input field to the right of the Fixed speed (m/s): label.
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Vessel speed

The vessel speed, as found in the position datagram, is used for
calculation of the alongtrack position (recommended).

Position

The positions, as found in the position datagram, are used for
calculation of the alongtrack scaling.

Jump limits

These settings are used to define the limits which the system will
accept as “jumps” in position and speed. You can set these values
in the text fields to the right of the following labels:

• Min speed (m/s):

• Max speed (m/s):

• Min distance (m):

• Max distance (m):

Heading adjustment

This setting allows you to select how the vessel’s current heading
is obtained.

The vessel’s heading is used to calculate where the Sonar Image
samples are placed on the display as the vessel change its course
and thereby rotates the swath around the line direction. The
following options are available:

• None
• Fixed
• Line
• Average

None

No rotation due to heading changes are used. The swaths are
positioned 90 degrees to the line forward direction.

Fixed

A fixed heading direction is used, and you will have to fill in the
heading direction in decimal degrees in the text field to the right
of the label Fixed (degr.):. The line direction is then given, and
the vessel heading is used to find the rotation of the swaths relative
to this fixed line direction.

Line

The line direction in the multibeam data is used.

This option is not usable in the EM1002.
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Average

The average of the last measured heading values are used as the
line course. The value of the current ping is used to find the rotation
of the swath relative to the average line direction found from the
last measured heading values.

Amplitude adjustment

This setting is used to select how the amplitude strength is
presented in the display.
The displayed data represents the amplitude strength of the Sonar
Image samples. The way to scale the amplitude on the display can
be set by the following methods:
• Fixed
• Average

Fixed

A fixed amplitude scale is used, and you can define the minimum
and maximum of the scale. The scale is in dB.
The Min and Max values are set to the right of the labels Min
amplitude (db): and Max amplitude (db): respectively.

Average

The average of the received amplitude over the latest pings are
used to scale the display automatically. The dynamics of the data
are then kept, but the amplitude level is not possible to read from
the display. This gives a relative picture of the reflectivity.

Footprint scale

This setting is used to define the fraction of the actual alongtrack
footprint of the echo sounder used for the display. You can select
None or a percentage.
The footprint is the area on the bottom covered by the sound pulse.
Since the footprint is larger alongtrack at the outer beams than at
the centre of the swath, the same area may be measured with the
outer beams for several pings. This may blur the display
presentation at the outer part of the swath.
This variation along the swath will also be reflected on the display.
The outer samples will fall into several pixel cells, while at the
centre of the swath some pixel cells may have no data. These
missing data will be shown on the display as white lines between
the swath lines covering the centre area.
You may wish to fill the pixels in between the swath lines to make
the output more homogeneous. It is then possible to increase the
displayed footprint fraction to broaden the fore-and-aft display of
the swath.
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The footprint fraction can be set to be any of the above values.
100% represents the same size as the real alongtrack transmit
beamwidth.

Swath width

The width across the entire display (plot) can be set here. This is
done by entering the desired width in meters to the right of the label
Swath width (m):.

Tic distance

This setting allows you to so set the distance (in meters) between
distance annotations.

The display and the plot has tic marks to indicate distances. The
tic marks shows the distance along as well as across the track, and
the distance between the marks is the same in both directions.

The tic distance is entered as a number to the right of the label Tic
distance (m):.

Relative Y-scale

This option is used to set a factor to compress or stretch the
alongtrack scale.

If the number is 2, the scale in the fore-and-aft direction is 2 times
the scale in the acrosstrack direction. This means that the image is
compressed in the fore-and-aft direction compared with the
acrosstrack direction.

The value 1 is used for 1:1 scaling between along and across
directions.

The scale factor is written in the text field to the right of the label
Relative Yscale:.

Display

This option is used to select the output medium for the Sonar
Image; screen and/or printer.

The Sonar Image will be sent to the screen and optionally to the
printer. Select the screen option if only the screen is wanted. To use
the printer option, a printer and a printer interface must exist. With
this option, both output media will be used.

Paper filling

The paper on the Raytheon grayscale recorder can be used in full
scale, or just in half scale. This means that the pixels are doubled
in size when full scale is used.
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Acceptance

Start - Press this button to start the display or plot. A new window
will be created (if it is not already on the screen) where the Sonar
Image is displayed. If the printer option has been selected, the
image is also sent to the printer.

Stop - Push this button to stop the display or plot.

Continue - Push this button to continue processing after a stop
command. The display continues from the stop position, but new
settings of the dialogue box are applied, if they have been changed.

Exit - Use this button to exit from the Sonar Image utility. This
button closes down the display and the dialogue box.

Help: This button provides on-line help.
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14 SEABED VIEWER

14.1 Purpose and description
The Seabed Viewer is designed to display seabed image data in a
scrolling window. It displays one line per ping, and does not
perform geographical corrections with regard to the vessel’s
heading and speed. The display can be used as a simple quality
check of the data, or it can be used for object detection.

Figure 113 - Seabed Viewer - main window

(CD4369)

The Seabed viewer does not require data logging of seabed image
data to disk to be enabled. It draws data even if the workspace it is
in, is not active. It cannot however be scaled correctly alongtrack,
or take into account footprint size or loading changes. In
comparison to the Sonar Image Display, it is thus better for online
use, esecially to check and set gain effects, and for immediate
views of interesting activity, and object detection in shallow
waters.

14.2 Main window
The Seabed Viewer window contains the following main
elements:

• Menu bar

• Graphic presentation of the seabed image data

• Information bar at the bottom of the display
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The following commands and options are available from the the
Seabed Viewer main menu bar:

• File

• Options

• Help

The menu options and the respective commands attached to them
are explained in the Command References chapter on page 317.
The Seabed Viewer window is shown in figure 113.

14.3 Operational procedures

To start the Seabed Viewer
The Seabed Viewer is started from the EM 1002 Launchpad with
the dedicated icon.

Figure 114 - The Seabed Viewer icon

To exit the Seabed Viewer
The Seabed Viewer is closed as follows:

1 Select File on the main menu bar.
2 Select Exit on the pull-down menu.

To open a file for replay
When you have chosen to operate the Seabed Viewer in playback
mode, you can open a file to view.
→ Refer to description of how to select Playback mode on page 318.

1 Select File on the main menu bar.
2 Select Open on the pull-down menu.
3 Select any *.all file on your system.

Playback control
Once a file has been loaded for replay, you can play, stop or fast
forward through the data.
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1 Select Options on the main menu bar.

2 Select Parameters on the pull-down menu.

3 Use the three buttons “tape recorder” buttons in the lower
section of the dialogue box for play, stop and fast forward.

Replay speed
You can control how fast the data are replayed.

1 Select Options on the main menu bar.

2 Select Parameters on the pull-down menu.

3 Use the Update frequency slider to choose the preferred
speed.

Amplitude control
You can control the amplitude both in playback and realtime mode,
or you can set it to control itself automatically.

1 Select Options on the main menu bar.

2 Select Parameters on the pull-down menu.

3 Set Amplitude to Manual.

4 Use the Minimum amplitude and Maximum amplitude
sliders to choose the preferred minimum and maximum
values.

or

5 Set Amplitude to Automatic.

Swath width control
You can control the swath width both in playback and realtime
mode, or you can set it to control itself automatically.

1 Select Options on the main menu bar.

2 Select Parameters on the pull-down menu.

3 Set Swath Scaling to Manual.

4 Use the Swath Width slider to choose the preferred values.

or

5 Set Swath Scaling to Automatic.

Colour control
You can control the colours used both during playback and
realtime mode.
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1 Select Options on the main menu bar.

2 Select Parameters on the pull-down menu.

3 Set Palette to any of the four options available.
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14.4 Command references

Introduction
This chapter describes the various commands used throughout the
Seabed Viewer application.

The following options are available on the main menu:

• File

• Options

• Help

Each of these menu options have a number of commands available
on pull-down menus.

The Help option provides on-line help, and is not described.

File

Overview

The File option on the main menu bar contains these options:

• Open

• Print

• Exit

Open

Use this to select a file to replay data from. This can only be used
in playback mode. The file selected must be a raw data file (with
extension .all).
→ Refer to page 41 for a description of the File Selection dialogue

box used to open files.

Print

This menu item is used to select which printing device to use. The
choices are:

• Alden 975

• HP DeskJet

• No Hardcopy

A hardcopy is generated while the survey data is displayed on the
screen.
→ Refer to page 43 for a description of the print process.

Exit

When this menu command is selected, the Seabed Viewerprogram
will close.
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14.5 Options

Overview
The Options menu on the main menu bar in the Survey Display
contains these commands:

• Parameters

• Realtime Mode

• Playback Mode

(CD4370)

Figure 115 - The Parameter options

Parameters
When you select Parameters... on the Options menu, a dedicated
window opens to present you the choices. You can control the
following functions:

• Playback speed (Update frequency)

• Amplitude

• Swath width
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• Screen colours

In addition, you have access to the three control buttons for
playback mode:

• Play

• Stop

• Fast forward

Playback speed

Update frequency - This option is only available during playback
mode. It specifies how fast data will be replayed. A higher number
means faster replay of data.

Amplitude

Minimum Amplitude(dB) - Use this slider manually to select the
minimum amplitude to be displayed. This option will not be
available if Automatic Amplitude has been selected.

Maximum Amplitude(dB) - Use this slider to select the
maximum amplitude to be displayed. This option will not be
available if Automatic Amplitude has been selected.

Amplitude - Select Automatic if you want the program to change
the minimum and maximum amplitude levels according to the
current data. Changing this to Manual allows you to use the slider
bars described above to change the mininimum and maximum
levels.

Swath width

Swath scaling - Select Automatic if you prefer automatic scaling
of the swath width. Selecting Manual allows you to use the slider
bar to select the width.

Swath Width (m) - Use this slider to select the swath width. This
is only possible when Swath Scaling has been set to Manual.

Screen colours

Palette - Use this to select which colour coding to use for the
seabed image data.

• Greyscale - Display data with different shades of grey
according to amplitude.

• Continuous Colours - Use a continous palette going from blue
to green to red. Blue is low amplitude and red is highest
amplitude. Only the colour is changed, not the intensity.

• 3 Colours - Split the amplitude range into three regions: blue,
green and red. The colour intensity is changed in each region,
going from light to dark before transition into next region.
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• 6 Colours - Same as 3 Colours, except that six colours are used:
blue, cyan, green, yellow, magenta and red.

Playback control

[PLAY] - Start display of data. This option is only available in
Playback Mode.

[STOP] - Pause display of data. This option is only available in
Playback Mode.

[FF] - Fast forward. Jump forward through the data. This option
is only available in Playback Mode.

Acceptance

OK - Saves the chosen parameters and closes the window.

Help - Provides on-line help.

Realtime Mode
Select this when you want to display realtime data. The data are
then retrieved from the Survey Display application.

Playback Mode
Select this to display raw data from files. In order to achieve this,
you must also select a file with the command File ->Open.
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15 SOUND SPEED PROFILE EDITOR

15.1 Purpose and overview
The purpose of the SSP Editor is to:

• Edit or inspect existing sound speed profiles

• Create new sound speed profiles

The following commands and options are available on the main
menu bar:

• File

• Edit

• Options

• Help

15.2 Main window

Basic window elements
The SSP Editor main window contains the following elements:

• Menu bar

• Edit area (the large area on the right hand side)

• Command area (on the left hand side)

• Information bar at the bottom of the display

The middle mouse button can be used to modify the view in the
Edit area.

The menu bar
The menu bar contains the following options:

• File

• Edit

• Options

• Help

These menu options and the respective commands attached to
them are explained in the Command References chapter.

→ Refer to page 329.
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Figure 116 - The SSP Editor main window

The Edit area

The Edit area is the large area on the right hand side of the window.
It has two axes:

• One horizontal axis along the upper edge of the area with a
sound velocity scale.

• One vertical axis on the left hand side with a depth scale.

The sound velocity profiles are displayed as curves in this
coordinate system.

Each profile is a sequence of points. These have coordinates with
increasing depth values. Straight lines connect the points. The
points are emphasised as small bullets on the curve.

The SSP Editor can operate with a maximum of three sound
velocity profiles at one time:

• One Editable profile

• Two Static profiles
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Only the editable profile can be saved to disk. The two static
profiles are only auxiliary profiles used to create new editable
profiles. They are read in from the hard disk, may be changed
locally in the edit buffers, but can not be saved to disk.

The profiles are identified by their colour. The editable profile is
black. The two static profiles are red and blue respectively. The
profile names (file name if a profile is loaded from the hard disk,
or the text <New SV Profile> if the profile is just created in the
editable buffer) are shown at the bottom of the edit area, using the
same colour codes as for the profile curves.

→ Please remember to save your original sound velocity profile file!
You need this original file if you later want to recalculate the sound
velocity. The SVP Editor uses this original file when doing the
recalculation.

The Command area

Overview

This area on the left hand side contains push buttons for zooming
and for panning up and down in the edit area.

Zoom in

Zoom out

Move up

Move down
(CD3395)

Figure 117 - The Command buttons in the SSP
Editor window

Zoom in

This button is used to zoom in on the Edit area, i.e. to bring the
diagram “closer to” you. The parts of the diagram which are close
to the edges disappear from view. Pushing this button repeatedly
(up to a maximum of 20 times) will each time bring the diagram
closer.
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Zoom out

This button is used to zoom out of the Edit area, i.e. to bring the
diagram “further from” you. This gives the opposite effect as the
Zoom in button.

Move up

This button is used to move the Edit area window upwards relative
to the depth scale. The profiles will correspondingly be adjusted
downwards on the screen.

Move down

This button is used to move the Edit area window downwards
relative to the depth scale. The profiles will correspondingly be
adjusted upwards on the screen.

Communication area
This area at the bottom of the window (yellow background)
presents communication and acknowledge messages from the
system.

Mouse operation
The middle mouse button may be used to pan the edit area in any
direction. Place the mouse pointer anywhere in the edit area and
drag in the wanted direction. The profiles will move in the opposite
direction; the idea being that the edit area is a window limiting the
view on the profiles “below”. This window is “dragged” to a new
position. The shift middle mouse button zooms into an area.

15.3 File formats
The SSP Editor operates on files, and accepts two different file
formats:

1 The Kongsberg Simrad Survey format, identified by the
sfsvp file name extension, is a binary format used for files
generated during logging. These files contain the profiles
actually applied in the real-time computations giving each
sounding depth and position values. These files may only be
loaded into the static buffers, and are consequently protected
against being changed by the editor.

2 The ASCII format, identified by the asvp file name
extension, contains a file header and a sequence of
depth/velocity value pairs in plain ASCII text. These files
may be loaded into both types of buffer.
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15.4 Operational procedures

Windows
The SSP Editor operates with a single window:

• SSP Editor

This window is referred to as the main window in this document.
In this window, you can view the sound speed profiles.

Start and exit

To start the SSP Editor

The SSP Editor is started from EM 1002 as follows:

To exit the SSP Editor

The SSP Editor is closed as follows:

3 Select File on the main menu bar.

4 Select Exit on the roll-down menu.
- The application will close. If you have forgotten to save

the profile in the editable buffer, the editor will present a
warning.

Open, create and save

To open existing sound speed profiles

1 Select File on the main menu bar.

2 Select Open Editable if you wish to open an existing sound
speed profile and put it in the editable buffer.

or:

3 Select Open Static if you wish to open an existing sound
speed profile and put it in one of the static buffers.

4 Select the appropriate profile in the dialogue box.

5 Press OK to retrieve the file.
- The profile is loaded into the buffer, and presented in the

Edit area. The profile in the editable buffer is black, while
the profiles in the static buffers are red and blue.

Note: Profiles in the static buffers can not be saved on disk. Do not
perform any changes in these profiles unless you can copy the
profile to the editable buffer for saving.

To create new a sound speed profile

1 Select File on the main menu bar.
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2 Select New profile if you wish to create a brand new profile
from scratch.

3 Place the mouse pointer in the edit area.
- It will get a cross hair shape. The depth and speed

co-ordinates will be shown as continually updated
numbers following the mouse pointer.

4 Click the left mouse button to create a new point in the sound
speed profile.
- The point is created at the current pointer position.

5 Repeat until a new sound speed profile is created.

To save a sound speed profile

Note: You can only save a profile from the editable buffer. This profile is
identified by its black colour.

1 Select File on the main menu bar.

2 Select Save as on the roll-down menu.

3 Navigate up and down the file structure to select the desired
catalogue.

4 Click OK to save.

Modify and delete

To empty a profile buffer

1 Select File on the main menu bar.

2 Select Quit editable profile to emty the editable buffer

or:

To delete a profile from disk

1 Select File on the main menu bar.

2 Select Delete.

3 Select the appropriate profile in the dialogue box.

4 Press OK to delete the profile.

To modify a profile

To move a point

1 Select Edit -> Move point on the menu bar.

2 Place the circular mouse pointer on the point you want to
move. Press the left mouse button and keep it pressed.

3 Drag the point to a new position.
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4 Release the left mouse button when the new location is
reached.

While the left mouse button is pressed, the mouse pointer will be
shaped as a cross-hair, and the depth and speed co-ordinates will
be shown as continually updated numbers. Rubber lines connect
the point to the neighbouring points on the curve. When the mouse
button is released, the point will get a new position equal to the
current pointer position.

After the move has been finished, the pointer reverts to its circular
shape, and another point may be moved in the same way.

To add a point

1 Select Edit -> Add point on the menu bar.
- The mouse pointer gets a circular shape.

2 Click the left mouse button to select the profile.
- The mouse pointer now takes the shape of a cross-hair,

and the depth and speed co-ordinates will be shown as
continually updated numbers following the mouse
pointer.

3 Click on the position you want for the new point.
- The profile is redrawn to include the new point.

After the point has been added, the mouse again reverts to its
circular shape, and another point may be created in the same way.

To remove a point

1 Select Edit -> Remove point on the menu bar.
- The mouse pointer gets a circular shape.

2 Click the left mouse button on the point you want to delete.
- The point is immediately deleted, and the profile will be

redrawn without it.
After the point has been deleted, the mouse pointer keeps its
circular shape, and other points may be removed in the same way.

3 Reselect Edit -> Remove point on the menu bar to switch
off the function.

To adjust the speed

1 Select Options -> Parameters on the menu bar.

2 Fill in the applicable data in the Parameters dialogue box.
Close the box when all the parameters have been defined.

→ The Parameters dialogue box is described on page 334.

3 Select Edit -> Adjust velocity on the menu bar.
- The mouse pointer gets a circular shape.
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4 Click the left mouse button on the point or profile you want
to adjust.
- The profile is redrawn using the adjusted speed value(s).

The mouse pointer keeps its circular shape, and other points may
be adjusted in the same way, or the adjustment repeated for the
same point or profile.

5 Reselect Edit -> Adjust velocity on the menu bar to switch
off the function.

To combine two profiles

1 Select File -> Quit Editable Profile on the menu bar to
delete the profile in the editable buffer.

2 Make sure that your two static buffers contain the two
profiles to be combined.

3 Click the left mouse button anywhere in the edit area.
- The new editable profile will then be drawn.

To copy a profile

1 Select File -> Quit editable profile on the menu bar to delete
the profile in the editable buffer.

2 Click the left mouse button on the profile you wish to copy.
- The new editable profile will then be drawn.

→ Refer page 333 for further information.
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15.5 Command references

Introduction
This chapter describes the various commands used throughout the
SSP Editor application.

The following options are available on the main menu:

• File

• Edit

• Options

• Help

Each of these menu options have a number of commands available
on pull-down menus.

The Help option provides on-line help, and is not described in
detail

File

Overview

The File option on the main menu bar contains the following
options:

• Open Editable

• Open Static

• New Profile

• Save

• Save As

• Quit Editable Profile

• Quit Static Profile 1

• Quit Static Profile 2

• Delete

• Exit
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Open Editable

This option is used to open a Sound Velocity profile file in order
to make changes to it in the edit buffer.
The Read SV Profile file selection box appears. This box provides
a list of all the available Sound Velocity profile files in the profiles
directory. Select a profile and click the OK button.
The selected profile is loaded into the edit buffer, and presented in
the edit area. Black colour is used both for the line graphics and
annotation values (if turned on). This profile may later be saved to
the hard disk.

Open Static

This option is used to open a Sound Speed profile and load it into
one of the static edit buffers. It brings up a file selection box listing
all the available Sound Speed profile files in the profiles directory.

The File Selection window is explained on page 41. Select a profile
and click the Ok button.

The selected profile is loaded into one of the static edit buffers and
presented in the edit area. Red or blue colour is used both for the
line graphics, and annotation values (if turned on). The colour
depends on which of the two static buffers that contain a profile.

Static profiles can not be saved to the hard disk. An attempt to open
more than two static profiles will automatically result in a warning
message.

New profile

This option allows you to draw a new sound Speed profile in the
Editable buffer.
This menu command allows you to create a completely new sound
Speed profile. After this command has been selected, place the
mouse pointer in the edit area where it will get a cross hair shape.
The depth and Speed co-ordinates will be shown as continually
updated numbers following the mouse pointer.
Each time you click the mouse with the left mouse button, a new
point in the sound Speed profile will be created at the current
pointer position.

Save

This option allows you to save the content of the editable buffer
using the original file name.

Save As

This option allows you to save the content of the editable buffer to
another (new) file.
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This menu command brings up the Save As window which is
basically an ordinary file selection box. Click in the Sound Speed
Profile text input field, and enter the file name from the keyboard.
The asvp file name extension will be appended automatically,
unless entered manually. Select the OK button or push the Enter
button on the keyboard to save. Select Cancel to exit without
saving.

Quit Editable Profile

This option is used to empty the editable profile buffer (identified
by a black colour) without saving it. This must be done before a
new profile can be created or loaded into this buffer.

Quit Static Profile 1

This option is used to empty the first static profile buffer (identified
by a red colour). This must be done before a new profile can be
created or loaded into this buffer.

Quit Static Profile 2

This option is used to empty the second static profile buffer
(identified by a blue colour). This must be done before a new
profile can be created or loaded into this buffer.

Delete

This option allows you to remove a sound Speed profile file from
the hard disk.

This menu command brings up the Delete SV Profile window
which is an ordinary file selection box. Select the file you want to
delete from the Sound Speed Profiles list box, or enter the file
name directly into the Sound Speed Profile text input field. Click
OK to delete the file. This brings up a confirmation dialogue box
where you have to confirm the deletion before it is effectuated.
Cancel closes the Delete SV Profile box without any file being
deleted.

Note: Only profile files in ASCII format may be deleted.

Exit

This option closes the SSP Editor.

A warning is issued if the content of the editable buffer has been
changed, without subsequently having been saved to the hard disk.



EM 1002 / Base version

332 850--160977/E

Edit

Overview
The Edit option on the main menu bar contains two commands:
• Move point
• Add point
• Remove point
• Adjust velocity
• Combine SV profiles
• Copy SV profile
These menu commands allow you to make changes to the profiles
currently existing in one of the three edit buffers. The first four
commands operate on any of the buffers, while the last two
commands creates a new profile in the editable buffer from one or
both of the static buffers. Changes made to the static buffers can not
be saved to the hard disk, and has thus only meaning as a
preparatory step for one of the last two edit commands.
The selection of one of the Edit menu commands makes this
command the current edit command. The current command can be
applied repeatedly until another edit command is selected.

Move point
This option is used to change the position of a point on one of the
three profiles.
→ The procedure is presented on page 326.

Add Point
This option allows you to add a new point to one of the three
profiles.
→ The procedure is presented on page 327.

Remove Point
This option allows you to delete a point from one of the three
profiles.
→ The procedure is presented on page 327.

Adjust Velocity
This option is used to add a preset adjustment value to the velocity
coordinate of a point on one of the profiles, or to the velocity
coordinate of all points in a profile.
The preset adjustment value is set in the Parameters dialogue box
available through the Options -> Parameters menu command.
You must here decide if the adjustment should be applied to a
single point or to all points in a profile.
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→ The Parameters dialogue box and it’s options are described on
page 334.

→ The procedure is presented on page 327.

Combine Sound Velocity Profiles

This option is used to create a new profile in the editable profile
buffer. In order to combine profiles, two static profiles must be
present and the editable buffer must be empty.

If the two static profiles have different sound velocity values at
common depths, the mean sound velocity values will be used in the
new profile. Otherwise, all points in the two static profiles will
move to the new profile unaltered.

→ The procedure is presented on page 328.

Copy Sound Velocity Profiles

This option is used to create a new profile in the editable profile
buffer. This new profile is identical to one of the static profiles,
possibly adjusted by a constant pre-set velocity value for all
depths.

The editable buffer must be empty.

The mouse pointer gets a circular shape. Click, using the left mouse
button, on the static profile you want to copy. The new profile will
then be created in the editable buffer.

If you want this profile to be adjusted by a constant value for all
depths, the Velocity Adjustment option in the Parameters
dialogue box (available through the Options->Parameters menu
command) should be set to All Points.

If this option is set to None, or the adjustment value is zero, the new
profile will be situated on top of the original. To let the system
know which profile is meant when you select one of them, a lock
mechanism may be used which will disallow the selection of
specific profiles. If one of the profiles is locked, the other will be
selected. Profiles are locked using the Parameters dialogue box.
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Options

Overview

Options on the main menu bar contains the choices:

• Parameters

• Reset Windows

• Show Profile

Parameters

Overview

This dialogue box, shown below, is brought up by selecting the
Options->Parameters menu command.

Figure 118 - The Parameters dialogue box

The dialogue box contains the following controls:

Annotation

These settings are used to turn the display annotations for each
profile ON or OFF.

A check button is provided for each profile buffer. If the
annotations for a profile is turned ON, a check-mark with green
background is displayed. Click on the check button to change its
state.



Sound Speed Profile Editor

335850-160977/E

Lock

These settings make it possible to prevent the selection of profile
points or whole profiles by edit commands.

A lock may be set on any of the three profile buffers. A check
button is provided for each edit buffer. A check-mark with green
background indicates a locked buffer. Click on the check button to
change its state.

A lock may be set on an edit buffer if profiles have overlapping (or
nearly overlapping) points. Set a lock on the profile which you
don’t want to select to ensure that the other profile is selected when
clicking on the overlapping points.

Vel.Adjustment

These buttons are used to control how the speed adjustment is
applied when you use one of the Adjust Velocity or Copy SV
Profile commands.

These radio buttons are used together with the Vel. Offset slide bar
contained in the Misc. Parameters part of the dialogue box.

• When the Adjust Profile command is applied, and the Single
Point radio button is ON, the speed for the selected point is
adjusted by the Offset parameter value.

• If the All Points radio button is ON, the adjustment takes place
for all the points on the profile.

• Selecting the None radio button disables the Adjust Velocity
command.

• If speed adjustment is required when the Copy SV Profile
command is applied, the All Points radio button must be
selected.

The selected radio button is emphasised by a green colour.

Misc.Parameters

This setting is used to open or close the lower part of the dialogue
box. This part contains fields for setting the depth range of the edit
area, and a slide bar for the Offset parameter.

Min Depth (m)

Set the lower limit (most shallow) of the depth range for the edit
area.

Max Depth (m)

Set the upper limit (deepest) of the depth range for the edit area.

Vel. Offset (m/s)

Set the speed adjustment value used by the Adjust Velocity and
Copy SV Profile edit commands.
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Apply

Press this button to implement the new parameter settings.

The edit area is redrawn to reflect any changes in the options or
parameter values. The minimum and maximum depths parameters
are checked, and a warning will be issued if they are not accepted.
The dialogue box remains open.

Close

Press this button to close the Parameters dialogue box without
implementing any changes to the options or parameter values
made since last time the Apply was pushed.

Note: If changes are made without using the Apply button before closing
the dialogue box, the changes will not be implemented. However,
the changed settings will remain in memory, and be displayed in
the Parameters dialogue box when it is opened again. The
displayed settings may thus not allways correspond to the actual
situation.

Help

This button is provided to give help on how to use the Parameters
dialogue box.

Reset windows

This option is used to reset the scales along the axes to the original
setting. Any panning and zoom operation since the SSP Editor was
launched is undone.

Show Profile

This option is used to display the whole profile. This will normally
cover all depths from the surface and down to 12000m. The profile
is normally extended down to 12000m by the echo sounders
operator station.
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Help

This opens the online-help system.
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16 REPLAY

16.1 Introduction
Replay is an application used to replay raw data from multibeam
echo sounders and generate new survey data used by Kongsberg
Simrad hydrographic programs.

Replay can convert echo sounder data from both old echo sounders
and new echo sounders. If you want to convert new echo sounder
data, choose the option EMX. EMX is a common term for all new
echo sounders including EM3000, EM2000, EM1002, EM300 and
EM120. It is also possible to select replay from older multibeam
echo sounders, if you so wish, then choose the option
EM1000/EM12/EM950.

The converted data will be placed in a survey of your choice, either
a new or an existing one. If you place the data in a new survey, you
are advised to initiate the survey with a projection of your choice.
If you select an existing survey, you may change the projection
already used in the survey, and will therefore be warned if this is
unwanted.

16.2 Why use replay?
You can specify the name of the raw data directory, and select the
replay speed.You have two modes when using replay. This can
either be slowly, as if the data are arriving in real time from the echo
sounder, or quickly to convert raw data to survey format.

16.3 Operational procedures

How to start Replay
This program is started from the EM 1002 by the following
procedure;

1 Place the cursor in the background part of the display image
in the Common Desktop Environment.

2 Press the middle mouse button.
- A small menu is displayed on the screen.

3 Choose Check/Replay data.

→ The Replay dialogue box can be seen in figure 119 on page 339!



Replay

339850-160977/E

Figure 119 - The Replay dialogue box

The Replay dialogue box options
From Survey - This option lists all surveys found in your
workstation. You may also enter the survey name directly in the
text field.

Select lines - This option lets you select all or some lines. When
you press the ’...’ button, a list of already existing lines will be
shown. When you select your lines, a file selection dialogue box
then opens. You may then choose lines in these files.

→ The File Selection dialogue box can be found on page 41.

How to convert data - This will let you choose how to convert
your data;

- by Replaying them - This option will put all your raw
data onto the network, as if comming from an echo
sounder.

- Directly - This option will convert all raw data files
directly and fast to survey format.
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- Extract Attitude - If an attitude datagram is logged with
the rawdata, this option will extract attitude and heading
information to survey format attitude and heading files.

- Extract EA 500 depths - This option extracts single
beam echo sounder depths from raw data. This will create
survey format data containing only depths from the single
beam echo sounder.

- Print Installation - This option prints out the installation
parameters.

- Print Content - This option writes a start identifier for
each datagram. Print content will also let you know from
which echo sounder the depth datagrams are.

- Print Pos - Outputs date and time of position datagram
plus the complete position input datagrams.

- Print Clock - Outputs content of clock datagram, if
logged.

- Print Heave - If raw range datagrams are available the
output is: Type, time, model, txheave(head2, if
available), txroll, Rolldepth. If no roll range the output is:
type, time, model, head1_depth (head2_depth)

- Print Height - If height datagram is logged, date, time,
height and source are output.

- Print ROV Depth - Reads raw range datagram and depth
datagram and gives time and calculated depth of ROV.

- Print Runtime - Converts and outputs runtime datagram
contents to ASCII. Checks datagram description to
decode each field.

- Replay Realtimetape - If you have logged data to tape
in realtime, you are able to read data from the tape using
this button.

The Raw data is from sounder - This button lets you specify the
echo sounder. This is because there are different programs for old
and new sounders. You must choose either EMX (new sounders)
or EM1000/EM12/EM950 (old sounders).
New sounders include EM3000, EM2000, EM1002, EM952,
EM300, and EM120
Old sounders include EM1000, EM950 and EM12.
To Survey - This field lets you specify the survey name into which
you want to put your data. A list of already existing surveys will
be shown by pressing the ’...’ -button. When writing the survey
name, OK and Cancel buttons will appear. Press OK or enter to
confirm. If the name you selected is already existing, a warning
will appear.

Note: A warning will be given if you select an existing survey!

To be initiated from - Any new survey must be initiated with a
projection. Select your correct projection.
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The following choices/options appear while converting data;

1 Position timetag from This option lets you choose which
timetag to use;
- Default - uses original timetag
- PU Internal - forces timetag to be from Processing Unit

system time.
- Pos System - forces timetag to be found inside incoming

position datagram.
2 Position Filter - This enables the position filter.

- Max Speed (m/s) - This field lets you set the max speed
to limit the maximum possible distance between two
positions. This choice is valid when Position Filter is
turned on.

3 SVP Interpolate - If a SVP Interpolate rule exists in your
destination survey, the raw data will be recalculated with
new sound speed profiles.

Compress Survey Data - This option starts a routine for storing
data in a more compact way. This can be done without loosing any
of the information in the data files.

When all your settings are to your satisfaction, you can start
Replay, or if you may cancel to exit the program.

- When you choose OK, the replay/conversion will start,
and all the .all-files in the raw data survey will be replayed
or converted.
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17 TECHNICAL REFERENCES

17.1 Introduction
This chapter provides basic reference information useful to
understand settings and parameters used throughout the EM 1002
system. In order to understand some of the information, you may
need to have a more technical background than the average EM
1002 user.
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Figure 120 - EM 1002 coverage
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17.2 Bottom Detection

Conventional techniques
A single beam echo sounder obtains depth by measuring the time
a sound pulse takes to propagate to the bottom andmultiplying this
time value by the mean speed of sound in the water column. Good
accuracy depends on:
� small beamwidths in the echo sounder transducer
� a good estimate of sound speed
� a well-designed pulse receiver and detector
A single beam echo sounder normally only measures the depth
vertically. To measure to the side, one could imagine using a
mechanically tiltable transducer or multiple transducers, but
electronic beamforming, i.e. the forming of multiple beams from
a single transducer array, achieves the same results in a more
cost-effective way. For good measurement density, the
beamforming on the receiver side must be fast enough to allow
simultaneous detections in all beams. The transmit transducer in
a multibeam echo sounder must ensonify the area to be measured
within the coverage of the receive transducer, which in principle
does not require the use of multiple transmit beams.
The accuracy of a multibeam echo sounder depends on the same
factors as those of the ordinary echo sounder. In addition, it is not
enoughmerely to know themean sound speed in thewater column,
but a detailed knowledge of how the sound speed varies with depth
is also required. This is because the sound path is usually not
straight when it is not vertical, and the resulting so-called “ray
bending” must be calculated by the use of the actual sound speed
profile to find the correct depth and location of soundings taken to
the side.
Both single beam and simpler multibeam echo sounders use only
amplitude detection to determine the travel timeof the soundpulse.
When the sound has a zero angle of incidence to the seabed, a good
detection principle is to estimate the time of arrival of the leading
edge of the returned echo. As the angle of incidence increaseswith
beams measured to the side or when the seabed directly below the
vessel is not horizontal, the returned echo loses its sharp leading
edge. When the angle of incidence becomes sufficiently large, the
echo will be so smeared out in time that an accurate simple
amplitude detection is no longer possible. One is then required to
use more sophisticated methods, for example using the variation
in echo strength over the beam.
Sidescan sonars provide a ”photographic” image of the seabed,
and this may give an indication of the bathymetry. In some
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sidescan systems, an approximate measurement of depth has been
achieved by using phase detection through an interferometric
principle. By comparing the phase of the returned echo on two or
more physically separated transducers, the angle of arrival may be
estimated in addition to the range. However, this only workswhen
the angle of incidence is large or the seabed is relatively flat, as the
phase information may be destroyed when simultaneous echoes
are received from different parts of the seabed. Note that a similar
phase detection principle is used with success in short or
ultra-short baseline acoustic positioning systems, in radars
(usually calledmonopulse) and in optics (usually called splitbeam,
a term which is also used in connection with ultra-short baseline
positioning systems).

Advanced techniques

Phase detection method

The problem of multiple echoes with the phase detecting sidescan
sonars can to a large extent be overcome by combining phase
detection with the multi-beam principle. For each beam, two
additional so-called halfbeams are formed from different
sub-arrays of the receive transducer, with all three beams having
the same pointing direction. The phase difference between the
halfbeams, which is a measure of the angle of arrival of the
returned echo, is calculated from the complex conjugate product
of the two received signals, usually after some averaging of the
product is done. The degree of averaging needed is determined by
a combination of pulse duration, range and incidence angle, and is
in practice derived from extensive simulations and experimental
verifications. The averaging stabilizes the phase determination,
reducing the effect of glint or random variation in signal strength
due to destructive interference from different parts within the area
producing the echo at any given time.

The distance between the acoustical centre of the two sub-arrays
used to form the halfbeams determines the relationship between
electrical phase and angle of arrival. When the phase is zero, the
returned echo from the bottom comes in the centre of the beam.
The phase as a function of timewill theoretically be a second order
function for a flat bottom, modulated by local changes in bottom
curvature and by noise. A curve fit made to this time series of
phase, fromwhich the zero phase crossing can be determined, will
therefore allow a very accurate determination of the range to the
bottom in the centre of the beam,with amuch higher accuracy than
any method based only on amplitude information can provide.
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Amplitude detection method
To achieve a valid curve fit to the angle of arrival time series, a
minimum number of samples is required, so that the incidence
angle or depth cannot be too small. Thus an amplitude-based
method is required as a backup to the phase detection method. As
noted earlier, at normal incidence the leading edge of the echomay
be used, while at larger angles of incidence, the amplitude series
across the beam is required.
If the bottom is flat or has a constant slope with uniform seabed
composition, the amplitude time series will have a variation which
is determined only by the beam pattern. Then, the maximum
amplitude or, somewhat better, the mean of for example the -3 dB
points, may be used to determine the range at the centre of the
beam. However, with local slopes or variation of backscattering
strength within the beam footprint, these simple detection
principles do not give consistent results. Presently the best
amplitude detection method seems to be the determination of the
centre of gravity of the echowithin the beam, but even this method
is affected by local variations in seabed composition. Its use
should thus be restricted to reasonably short echoes, which
fortunately makes it a good alternative for the cases where the
phase detection method fails.

EM 1002 solution
In the EM 1002, the bottom detection is done as follows:
1 A search in range in each beam is first performed on sample

amplitudes to determine where the bottom echo is.
The search is:

- limited to be within a range window whose extent has been
established from where the bottom has been found in
previous pings

- based on a sliding mean of the sample amplitudes to limit
effects of noise. A minimum amplitude is required based
upon the bottom backscattering strength found in previous
pings.

2 Phase detection is then done, provided that there are more
than 10 range samples within the -3 dB part of the beam
pattern.

- If the curve fit has a sufficiently low variance, the resulting
detection is accepted (both a second and a first order curve
fit are tried, the latter over 3/4 of the samples, and the result
of the one with the lowest variance is retained).

- If phase detection is not accepted an amplitude detection is
done, provided that the number of samples within the
-10 dB points is not too large.
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The first round of detections is performed independently in all
beams. A filtering of the detections is then done to eliminate
spurious detections due to sidelobe echos, echos from fish, noise,
etc. The severity of this filtering is determined bymenu input from
you.
3 Asecond round of detections is then performed on the beams

with missing or rejected detections, but within limited range
intervals as determined fromwhere the bottom is (calculated
from the ranges determined in neighbouring beams with
accepted detections).
As in the first round phase detection is tried first and
amplitude detection only if phase detection fails. Relaxed
acceptance criteria are used in this second round, and a final
filtering is done afterwards. With this procedure, the choice
of detection method is not dependent upon the past history,
but may adapt instantly to changing bottom topography.

After bottom detection the raw ranges and beam angles are
converted to depths and positions relative to thewater level and the
vessel positioning system location respectively. Full account is
taken of:
� sound speed at the transducer depth and through the water
column

� the installation angles and location of the transducer
� vessel attitude at transmit and receive
� any lever arm corrections needed to calculate additional heave
due to pitch and roll not being measured at the transducer
location

� the vessel draft and the location of the positioning system

17.3 Error sources

General
Amultibeamecho sounder has, as any othermeasuring instrument,
an inherent limit in its achievable accuracy. The totalmeasurement
accuracy, i.e. the uncertainty in the depth and location of the
soundings, will in addition depend upon the inherent errors of
additional instruments, i.e. vessel motion and heading sensors and
positioning system, and the sensor(s) used to measure the speed of
sound at the transducer and through the water column. In this
section these error sources are quantified and discussed as far as
possible, thus allowing the user of the multibeam system to judge
the possible accuracy achievable under the specific conditions in
which the system is operating.
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All errors given belowmay be assumed to beRMS errors provided
the sensor errors used are also RMS errors or RMS uncertainties.
With this simplification the total system error can be calculated by
the root mean squared addition of the individual contributions.
Note that because of this, no effort has been made with respect to
the signs of the individual error terms, and as given below the signs
may thus not always be correct.

The coordinate system used assumes the x-axis to point forwards
(alongtrack), the y-axis to point starboard (acrosstrack), and the
z-axis to point vertically downward. A normal installation is
assumed with all beam-steering in the y-z plane

Errors in range �∆R in m) and angle (∆Ô in radians) will translate
into vertical errors (∆z) by simple geometry with Ô as the angle
from the vertical considered:

∆z= ∆R cosÔ

∆z= ∆ÔR sinÔ= ∆ÔD tanÔ

The position error ��x or �y) is also determined by range and
angular errors:

∆x or ∆y= ∆R sinÔ

∆x or ∆y= ∆ÔR cosÔ= ∆ÔD

Echo sounder errors

The error of a multibeam echo sounder is theoretically dependent
upon a signal-to-noise ratio. However, provided that the
signal-to-noise ratio is above 10 dB, the following equations have
been found to model the depth and acrosstrack position errors of
the Kongsberg Simrad multibeam echo sounders very well:

∆ZA= (∆Rs2 )2+ (cτ4 )2 cos2Ô+Ψ
2
yD2 tan2Ô
144


∆ZP= (∆Rs2 )2+ (cτ4 )2 cos2Ô+ 0.04∆RsΨyD sinÔ
∆YA= (∆Rs2 )2+ (cτ4 )2 sin2Ô+Ψ

2
yD2

144


∆YP= (∆Rs2 )2+ (cτ4 )2 sin2Ô+ 0.04∆RsΨyD cosÔtanÔ

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Here, ∆Rs is the range sampling distance, Ψy is the acrosstrack
beamwidth, and the indexes A and P refer to amplitude and phase
detections respectively. The first term in the above equations is due
to range error and the second to angular error. The system will
usually use phase detection for long echoes (oblique beams) and
amplitude detection for short echoes (near-nadir beams).

The alongtrack position error (∆x)

∆x= ψxR
12
≈ 0.3ψxDcosÔ

Here, ψx is the alongtrack beamwidth.

Seabed topography will in principle contribute to vertical error by
the effect it has on echo level and hence signal-to-noise ratio. Local
variations of depth within the beam footprint will cause vertical
errors, with amplitude detection beingmost affected. Seabed slope
will in principle not cause vertical errors, but repeatability will be
affected. As it will not be possible in post-processing to discern
between the two; it is prudent to convert the total position error to
a vertical error by multiplying the total position error by the slope
gradient.

Any errors in system installation measurements larger than
recommended in the Installation Manual and any errors in vessel
draft, tide and datum heights will contribute directly to the total
position system error.

Motion errors
In addition to the inherent errors of the multibeam echo sounder,
the errors in motion sensor and gyrocompass measurements of
heave, roll, pitch and heading errors contribute to total
measurement accuracy.

Heave

Errors in heave will contribute directly to the total vertical error.

Roll errors

Errors in roll will contribute to depth and acrosstrack position
errors:

∆z= D∆r tanÔ

∆y= D∆r

Note that with older motion sensors there may be dynamic errors
additional to the manufacturer’s stated inaccuracy due to vessel
horizontal accelerations, for example resulting from vessel turns.
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Pitch errors

Errors in pitch will cause depth and alongtrack errors given by:

∆z=
D∆p2

2
∆x= D∆p

Heading errors

Errors in headingwill cause alongtrack errors (∆x) and acrosstrack
errors (∆y) given by:
∆x= D∆h tanÔ

∆y=
D∆h2 tanÔ

2
Note that the heading error of a gyrocompass is latitude-dependent
and also usually influenced by horizontal accelerations.
In practice only roll error will be significant with regard to depth
error and heading error in a gyrocompass with regard to alongtrack
position error, while othermotion and heading sensor angular error
effects can usually be ignored. However the pitch error may be
significant if the fore-and-aft distance between the motion sensor
and the transducers is very large. Note also that while the dynamic
pitch and roll accuracy of high performance motion sensors are in
the order of 0.05�, theremay bemuch larger static offset errors due
to incorrect alignment of the motion sensor which may be
significant. If the heading is from a system where two GPS
receivers are used to derive heading, the heading accuracy may
approach 0.05�, making the heading error contribution to total
system accuracy insignificant.

Sound speed errors
Errors in sound speedwill cause different errors depending on their
nature and on the transducer configuration of the multibeam echo
sounder. Sound speed errors may be due to sensor errors which can
be modelled as an offset or bias plus noise. Especially the offset
may be temperature- and depth-dependent. Sound speed errors
may also be due to unmeasured changes in the water column with
time and position. Sound speed errors are difficult to quantify in
practice and the problems with temporal and positional variations
may sometimes be so large that the only practical solution is to
limit angular coverage.

Sensor-related errors

Noise in the measurement of the sound speed profile will not lead
to any significant depth or position errors if it has a zero mean
through the water column.
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A fixed offset in the sound speed sensor will always give a range
error and, if beam electronic steering is used (in which case the
beam pointing angle will be in error), also an angular error:

∆R= R∆cc

∆Ô=
∆c tan(Ô− β− r)

c only with electronic beam steering

Here, β is the installation tilt angle of the transducer array and the
roll angle.

Without electronic beam steering, the resulting depth and
acrosstrack position errors are:

∆z= ∆cDc

∆y= ∆cD tanÔc

With electronic beam steering, the resulting depth and acrosstrack
position errors are:

∆z= ∆cDc 1− tanÔ tanÔ− β− r

∆y= ∆cDc tanÔ+ tan(Ô− β− r)

To keep the sound speed sensor-related error to a nearly negligible
magnitude, the sensor offset should be less than 1.5 m/s for a
non-steered transducer, and less than 0.25 m/s for a horizontally
mounted linear array with 140� coverage.
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Sea surface related errors

Temporal and position-dependent sound speed variations may be
modelled as for sensor errors, except when the sound speed
variation is at the surface, or more correctly, at the transducer
depth. The resulting error then depends upon transducer
configuration, or on howmuch electronic beam steering is applied.
For a curved or semi-circular transducer array, no or only a limited
amount of steering is required, depending on the angular extent of
the transducer with respect to angular coverage capability. For a
linear or flat array, electronic beam steering is always applied
except for the beam normal to the array, but the amount of steering
applied for a particular beam pointing angle with respect to the
vertical will depend upon the installation tilt angle of the array and
also on the amount of roll.

The following equations assume that the sound speed error at the
surface is modelled as a change in value from that actually used in
the calculation of beam pointing angles and raybending. It is
assumed that the change takes place at the transducer depth only,
inwhich case there is no range error, but an angular error regardless
of whether electronic beam steering is applied or not.

∆Ô= ∆cc tanÔ without electronic beam steering

∆Ô= ∆cc tanÔ− tanÔ− β− r with electronic beam steering

Without electronic beam steering, the resulting depth and
acrosstrack position errors are:

∆z= ∆cc D tan
2Ô

∆y= ∆cc D tanÔ

With electronic beam steering, the resulting depth and acrosstrack
position errors are:

∆z= ∆cc D tanÔtanÔ− tan(Ô− β− r)

∆y= ∆cc DtanÔ− tan(Ô− β− r)

If the change in sound speed at the transducer depth extends
deeper, there will be an additional range error, but the angular error
remains unchanged. This range error is usually too small to be
significant, however, unless the change in sound speed is very
large or is effective over a large depth range, in which case the
sound speed profile should be re-measured.
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Implications

Note that with a horizontally mounted linear (and thus
electronically steered) transducer the total error due to varying
sound speed at the transducer depth is zero except for a small
roll-dependent term. This is because there are two errors involved:

1) the beam pointing angle error

2) the error in the first step of the ray bending calculations

Each of these errors has the same magnitude but opposite signs,
thus cancelling each other when roll is zero. Inmarked contrast, no
such error cancellation takes place with a curved non-steered array
and very little with a linear array which is tilted much from the
horizontal.

As sound speed variations at the surface are oftenmuch larger than
sound speed sensor errors, it can be concluded that the curved
non-steered array is significantly more sensitive to sound speed
errors than the horizontally mounted steered linear array. That this
somewhat surprising conclusion is the opposite of that drawn for
sonars, is due to the fact that sonars are usually used looking
horizontally while a multibeam echo sounder looks vertically.

For both a curved transducer and a flat transducer tilted say 40�, the
sound speed at the transducer should be known to within 0.1 m/s
if the resulting depth error is to be negligible within a 150� angular
measurement sector. For a horizontally mounted flat transducer an
uncertainty of up to 2 m/s is not significant assuming 130�
coverage and 5� of roll. With more roll and larger coverage the
sound speed uncertainty must be less for its effect to be
insignificant, for example within 0.5 m/s with 140� coverage and
10� roll. In areas where one can expect larger surface sound speed
changes than this, it is advisable to include a real-time sound speed
sensor at the transducer depth with the system, otherwise a
reduction in usable coverage or a reduced depth accuracy must be
accepted. Note that in addition to correcting for surfaced-induced
sound speed errors, the measured transducer depth sound speed
can also be used as an indicator for when a new sound speed profile
should be measured.
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Bottom-related errors

It may sometimes not be practical to measure the sound speed
profile all the way to the bottom and there will usually be an error
in the necessary extension of the profile.
Another type of bottom-related sound speed problem that can be
significant in not too deep waters occurs when a layer near the
bottom with significantly different sound speed than the layer
above moves upwards or downwards with changing depth due to
current, and the change is not taken into account. The resulting
vertical errors and acrosstrack position errors may in both cases be
modelled as an error due a constant sound speed error from a
particular depth (DE) and all the way to the bottom:

∆z= ∆cc (D− DE)(1− tan
2Ô)

∆y= 2∆cc (D− DE) tanÔ

This is a “worst-case” model, and a more realistic assumption
could be to assume an error in sound speed linearly increasing from
zero at a particular depth (DE) to ∆c at the bottom, in which case
the depth and position errors are half of those assuming a constant
sound speed error.

Other sound speed related errors

There are areas in the world where the sound speed changes very
much over a short depth interval, and where the depth at which this
change takes place shifts with time and position. Such an
unaccounted shift gives a range error but no angular errors,
resulting in the following vertical and acrosstrack position errors:

∆z= ∆c∆Dc

∆y= 2∆c∆D tanÔc

Finally, it should be noted that how ray bending calculations are
performed (with regard to transducer depth in relation to the depths
in the measured sound speed profile) may cause heave-induced
errors if the sound speed changes much through the profile.
For example, if the calculations are done through a table look-up,
this implies that the sound speed profile is anchored at the
transducer, and may cause errors due to heave. This error is
avoided if the calculations assume the transducer to move with
heave relative to the sound speed profile.On the other hand, if there
is a significant change in sound speed around the nominal
transducer depth, there is in practice no way of knowing how the
transducer moves relative to the sound speed profile with heave,
although intuitively it would seem most correct to assume that the
transducer moves with heave while the profile remains fixed.
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It may also be noted that an inherent limitation in ray bending
calculations is that one is usually forced to assume that the sound
speed changes only with depth and that any change with position
is negligible, at least for a particular beam.

17.4 Range capability
The fundamental equation for determining the range capability of
an echo sounder is the sonar equation:
EL= SL− 2TL+ BS

Here, EL is the received echo level, SL is the transmitter source
level, 2TL is the two-way transmission loss, and BS is the
backscattering strength of the target.

The two-way transmission loss is:
2TL= 2αR+ 40 logR

Here, α is the absorption coefficient and R is the range. The
absorption coefficient may be calculated from actual water
temperature, salinity, depth and sounder frequency.
The backscattering strength will depend on seabed conditions and
on the area (A) of the seabed seen by the echo sounder at each
sample time:

BS= BSB+ 10 logA

A= ψTψRR2around normal incidence ( Ô≈ 0)

A= cτψTR
2 sinÔ

elsewhere

Here, c is the sound speed, τ is the pulse length, and ψT and ψR are
the transmitter and receiver beamwidths respectively. The first
equation for the area is valid until the bottom incidence angle is
larger than the largest of the following two angles, given by:

cosÔL1= 1+ cτ2D
−1

sinÔL2=−
ΨRD
cτ + ΨRDcτ 

2

+ 1
The intrinsic backscattering strength of the seabed (BSB) is usually
very dependent upon the incidence angle, with the largest variation
around normal incidence, and typically a Lambert’s law
dependence at larger incidence angles. It seems natural to define:
BSB= BSN at normal incidence (Ô= 0). . . . . . . . . . . . . . . . .
BSB= BSO cos2Ô for Ô > about 10-25�. . . . . . . . . . . . . . . . . . .
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From0� and to an incidence angle of about 10-25�, it can be judged
from the literature that the backscattering strength to a good
approximation varies linearly with angle. The angle at which the
cross-over between the two regions takes place, in effect defining
the sharpness of the normal incidence peak, is very dependent upon
seabed material type.

Typically, BSN will be about -15 dB, BSO (O for oblique) about
-35 dB, but the values may change within �10 dB or even more
depending upon seabed material type and roughness.

Putting all the above into a single equation, the result is:

EL= SL− 2αR− 20 logR+ 10 logψTψR+ BSN (Ô= 0˚�. . . . . . . . .

EL= SL− 2αR− 30 logR+ 10 log cτψT cos Ô2 tanÔ + BSo (Ô> 10− 25˚�. .

The echo level has to be above the noise level (NL) by a certain
amount, typically 10 dB when using phase detection and 20 dB
with amplitude detection, if the detections are to be reliable. At
high sonar frequencies, the noise level is usually determined by the
electronic self-noise of the preamplifiers, while at low frequencies,
the sea noise level will usually dominate if the vessel is quiet.
Vessel noise will vary with speed and often propeller revolution
rate, and may be the dominant noise source even at high sonar
frequencies if the vessel is small and is travelling at a high speed.
The noise level is given by:

NL= NSL+ 10 logBW− DIR

Here, NSL is the noise spectral level, DIR is the receive transducer
directivity index and BW is the receiver bandwidth.

DIR= 46.2− 10 logΨxΨy with the beamwidth given in degrees.

The source level SL for EM 1002, is 226 dB.
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17.5 Time Varied Gain (TVG)
The longer it takes for the sound pulse to return, the weaker will
be the returning echo. To compensate for this, the received signal
will be amplified to a varying degree depending on the time since
the signal was emitted. This is called Time Varied Gain (TVG).

The strength of the returned echo from a particular area on the
bottom will depend upon many parameters:

� Range

� Angle of incidence

� Bottom backscatter strength

� Water column absorption coefficient

� Echo sounder inherent parameters

The TVG is applied to use the dynamic range of the receiver
efficiently, and to have a fairly constant echo level on which to
perform the bottom detection. The amount of gain applied as a
function of time is derived from a model of the echo strength
depending on the various parameters. As some of these are bottom
dependent, they will be estimated and updated by the EM 1002
system based upon data from previous pings, unless automatic
bottom tracking is manually disabled.

The amount of TVG that may be applied during a ping is limited,
and a fixed gain level is thus additionally defined to put the average
signal level at the optimum level in the receiver.
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17.6 The vessel coordinate system
Amain function of the parameters required for system installation
is to inform the systemof the relative positions between the various
sensors and the angular orientation of the sensors with respect to
the vessel. A reference point somewhere on the vessel has to be
selected, and a Cartesian right-handed coordinate system - as
shown in the figure below - must be defined with its origin in the
reference point. The location of this reference point has no physical
significance - it may be anywhere on the vessel. The placement of
the various instruments must be identified with forward, starboard
and downward coordinates in this coordinate system.

Starboard
(+Y)

(-Y)

Downward
(+Z)

Reference point
(origo)

(-Z)

(CD3274)

Forward
(+X)

(-X)

Figure 121 - The Vessel Coordinate system

The forward axis (X) must be parallel to the vessel keel, and the
downward axis (Z) must be vertical when the vessel is trimmed
normally. The plane defined by the forward and starboard axeswill
then be horizontal, and the attitude sensor should then, if properly
installed and calibrated, measure zero roll and pitch with a
normally trimmed vessel lying still.

Forward position (X)
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Forward position is defined on the X-axis (refer to the
illustration below). Locations further forward than the
reference point are positive.

(CD3514)

Figure 122 - Sensor locations (example)

Downward position (Z)

Downward position is defined on the Z-axis (refer to the
illustration above). Locations below the reference point are
positive.

Starboard position (Y)

If a sensor location is on the starboard side of the reference
point, the value will be positive.
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17.7 Timing

Introduction
Time synchronization between the echo sounder, the motion
sensors and the positioning system is vital in order to achieve the
best possible accuracy. The required time synchronization
accuracy is better than 5 ms for attitude with roll being the most
critical parameter. For the positioning, the required timing
accuracy depends upon required position accuracy and the vessel’s
speed.
Example: With a vessel speed of 10 knots or 5 m/s, 100 ms timing
accuracy is required for 0.5 m position accuracy.

Internal clock
An internal clock in the Transceiver Unit is used to time stamp all
time critical data. It is a software clock with 1 millisecond
resolution, and it is synchronized to an internal hardware counter.
An interrupt is generated in the Transceiver Unit at each ping as a
reference for the time of ping, and the clock is read at the reception
of external sensor data. The internal clock is stable and jitter free,
excepting a long-term drift of the hardware counter (typically a
few seconds per 24 hours), and possible 1-2millisecond jumps due
to the internal counter not operating at exactly 1 kHz.
The software clock may be synchronized to an external 1 PPS
(pulse per second) signal. This signal is normally available from
aGPS receiver, and this is the preferred method to synchronize the
echo sounder to an external clock. At the reception of a 1 PPS pulse
the millisecond field of the internal clock is set to zero. If it was
larger than 200 ms, the second is incremented (with a possible
incrementation of time and date if required). Note that thismethod
of synchronization implies that loss of a few 1 PPS pulses has no
significance.

The internal clock’s time and date is adjustable to that given by an
external clock, the positioning system or the operator station.
However, this is only possible if the system is not logging data.
Adjustment of the internal clock during data logging is not
recommended as it would cause loss of synchronization between
depth and attitude data.
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If an external clock is connected on a serial line the input data is
time stamped and logged as any other external sensor data. This
allows a continuous estimation of any drifts between the two
clocks. The setting of the internal clock will be to the time and date
from the source, including milliseconds as available. Note that the
GGApositioning datagramdoes not contain anydate entry. Setting
from the operator station allows a manual setting of the clock.

Time stamping
For each datagram of attitudes (roll, pitch, heave and possibly
heading), a time stamp is generated at the reception of the first byte
of the datagram. As the attitude data may be delayed due to
processing time in themotion sensor, an adjustable time delaymay
be applied. The attitude data are applied to the acquired ranges and
beam angles to derive xyz coordinates of the soundings after
bottom detection.

The only significant uncertainty in the time synchronization of
attitude and depths will thus be due to possible variations in the
time delay or a wrong estimation of it. However, with mostmotion
sensors the risk of errors is small. The manufacturer’s estimate of
delay should be used, and a possible prediction facility in the
sensor should not be employed. As the attitude datamay be logged
as a continuous time record, it is possible to postprocess the data
to determine and correct for any error in applied time delay.
As for the attitude data, a time stamp is generated at the reception
of the first byte of each position datagram, and an adjustable time
delaymay be applied to this time stamp. If the real variation in this
time delay is sufficiently small with respect to the position
accuracy and vessel speed, the internal time stamp will give
sufficiently accurate time synchronization. The time delaymust of
course be determined to a sufficient accuracy which is done by
comparing data from survey lines run at different vessel speeds in
the same direction up or down bottom slopes or over significantly
distinctive bottom features. Any necessary correction of the
applied time delay may be done in the postprocessing.
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If the variation in the time delay of the positions is too large with
respect to the desired accuracy, even after position filtering during
postprocessing, an alternative satisfactory solution will require
two things: that the positioning system’s own time stamp in the
position datagram has a sufficient accuracy; and that the clocks of
the echo sounder and the positioning system are synchronized.
When postprocessing the positioning system’s time stamp must be
used which is possible as both time stamps are retained in the
logged data. If the positioning time stamp is not good enough, the
positionswill have to be filtered during postprocessing to diminish
the effect of the variable timing. The inertia of the vessel will set
the limit of accuracy achievable by such filtering.

The conclusion and recommendations are as follows:
� The delay in the data from the motion sensor must be constant
and known to within 5 ms.

� If the delay in the position data is known within an accuracy
commensurate with the position accuracy and vessel speed, no
synchronization of clocks is required, but it is recommended to
synchronize the echo sounder to a 1 PPS signal if it is available.

� If the delay in the position data is variable and cannot be filtered
to a sufficient accuracy in postprocessing or the positioning is
required to also be accurate for real-time displays, the echo
sounder and positioning system clocks must be synchronized:
The synchronization of the two clocks should be done from a
common 1 PPS signal (which may be contained in the
positioning system). The echo sounder should be set up to use
thepositioning system time stamp (datagram time) towhich any
position time delay will be applied. The postprocessing system
must also be set up to use the positioning system time stamp (a
time delaymay have to be applied to either the position or depth
data).

The absolute setting of time in the echo sounder is usually not
critical with respect to other sensors. However it would be
advisable to synchronize the echo sounder to a 1 PPS signal if it
is available, and not to reset the echo sounder clock except at the
start of a survey. This will ensure that any time delays remain
constant during a survey. If an external clock is additionally
connected on serial line and logged, thiswill allow a check of clock
consistency during postprocessing, but this would usually not be
worth the effort.
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17.8 Sound speed formulas
The echo sounder computes bottom depth, taking full account of
the raybending caused by the variation of sound speed in the water
column. The Sound speed profile is entered manually,
automatically from a sound speed profile probe, from an external
computer, or by a combination of these methods.

If measured sound speed values are not available, they may be
derived from tables, or, if the temperature and salinity profiles are
known or estimated, calculated from a formula. While many
formulae exist, the one from UNESCO Technical Paper in Marine
Science, No. 44, is usually regarded as being authoritative.
However, it is cumbersome and recent experiments showed that it
has errors in the 1000-4000 m depth range. Therefore, a simpler
formula with adequate accuracy is as follows (from Coppens,
JASA March 1981, with a modified very deep water correction
which follows the recent experimental data).

� For the surface:
c(0,T, S)= 1449.05+ T(4.57− T(0.0521− 0.00023T))

+ (1.333− T(0.0126− 0.00009T)(S− 35)

where: T is temperature in _C
S is salinity in ppt

� For depths to 200 m in fresh water and 1000 m in the ocean:

c(Z,T, S)= c(0,T, S)+ 16.5Z

where: T is temperature in _C
S is salinity in ppt
Z is depth in km

� For depths to 2000m in freshwater and to 11000 m in the ocean
(assuming that the water is very cold at great depths):

c(Z,T, S)= c(0,T, S)+ Z(16.3+ Z(0.22− 0.003Z T+ 2 ))

where: T is temperature in _C
S is salinity in ppt
Z is depth in km
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� For depths greater than 5000 m, a latitude correction should be
applied:

c(Z,T, S)= c(0,T, S)+ Z′(16.3+ Z(0.22− 0.003Z T+ 2 ))

where: Z’ = Z(1 - 0.0026 cos2Ô)
Ô is latitude in degrees
T is temperature in _C
S is salinity in ppt
Z is depth in km
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17.9 Absorption coefficient
Themean absorption coefficient of the water column is used in the
gain setting in the receiver.
A typical value is 30 dB/km (Frequency 95 kHz, surface
temperature = 20C and salinity = 30 ppt)
The absorption coefficient is important in determining the correct
backscattering strength of the seabed used in the seabed imaging.
Setting a correct value is therefore always recommended if the
backscatter data are to be used, especially if the results are to be
compared with those from other areas.
The absorption coefficient α is given by the following equation:

α =
A1 f1 f2

f2 + f21
+
A2 P2 f2 f2

f2 + f22
+ A3 P3 f2

where

A1 =
8.86 ⋅ 10 (0.78 pH − 5)

c

A2 =
21.44 S(1 + 0.025T)

c

A3= 4.937 ⋅ 10−4− T(2.59 ⋅ 10−5− T(9.11 ⋅ 10−7− 1.5 ⋅ 10−8 ⋅ T)),T≤ 20˚C

A3= 3.964 ⋅ 10−4− T(1.146 ⋅ 10−5− T(1.45 ⋅ 10−7− 6.5 ⋅ 10−10 ⋅ T)),T≥ 20˚C

P2 = 1 − Z(0.137 − 0.0062 Z)

P3 = 1 − Z(0.0383 − 4.9 ⋅ 10−4 Z)

f1 = 2.8 S
35
 ⋅ 10

4 − 1245
273 + T


f2 =
8.17 ⋅ 10

8 − 1990
273 + T


1 + 0.0018(S − 35)
Here, α is given in dB/km, the sound speed c in m/s, the
temperature T in _C, the depth Z in km, the salinity S in ppt, and
the frequency f in kHz. The pH of the ocean is in the order of
7.6-8.2.
The mean values are the mean absorption coefficient from the
surface to the depth indicated, and is the value to be entered in the
menu.
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The absorption coefficient equation is from R. E. Francois and G.
R.Garrison, ¨Sound absorption based on oceanmeasurements: Part
II: Boric acid contribution and equation for total absorption,¨ J. of
Acoust. Soc. Am. 72(6), Dec. 1982, p 1886.
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18 MAIN INDEX
The next pages present the main index of this manual.
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A
Across, status, 105

AML Smart Probe, 154

Auto Logging Interval, 96

Auto Mode Actual Parameters, 103

B
Backup All files, 82

Backup files, 82

Baud rate, 128

Beams, status, 105

BIST
Execute All, 145
options, 146

BIST at Startup, 146

Books, indexes in, 1---1

Bottom detection, 346

Bridge Display, purpose, 244

BSP OK, status, 105

Built---In Self Test. See BIST

C
Clock

description, 135
setting, 27
Synchronize, 76

Coverage, status, 103

CPU load, status, 107

Current profile, status, 105

Current time, 108

D
Data bits, 128

Datagram Dispatch Period, 96

Datagram subscriptions, 99

Default layout, 92

Delete file, 82

Depth
maximum, 116
minimum, 116
status, 105

Depth to normal incidence, status, 103

Disk space, status, 107

E
Echo sounder, Launchpad, 68

Edit enable, 125

Enable auto restart, 75

Error sources
attitude sensors, 349
echo sounder errors, 348
general, 347
sound speed errors, 350

Execute All, BIST, 145

Exit, 91

Extended profile depth alarm, 97

F
File Admin, 80

Storage Location, 89

File type, File Admin, 80

Files
backup, 82
restore, 82
Storage Location, 89

Fixed gain, 142
status, 104

Force depth, 116

Free memory, status, 107

Free swap, status, 107

G
Go to program, 74

Green border, 107

H
Heading, status, 108

Heave, status, 108
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How to
access installation parameters, 24
calculate, sound speed profile, 363
change password, 25
define position delay, 26
define sensor offsets, 27
define TRU interfaces, 27
log in, 8
set the clock, 27
switch on power, 8
update software, 24

I
I/O Interfaces

AML Smart Probe, 154
Overview, 149
Setup, 152

Indexes, about, 1---1

Initial setup, 24

Input formats, 128

Installation setup
Purpose, 111
Runtime menu, 113
Simulator, 143
Start---up, 110
View, 85

L
Latitude, status, 109

Launchpad
Echo sounder, 68
Exit, 91
File, 79
File Admin, 80
Introduction, 65
Operator Station, 67
Print/View, 85
Sensors, 70
Sounder, 71
Survey field, 76
Window layout, 92
Workspace, 72

Line parameters, view, 86

Line statistics, view, 86

List tape, 83

Load, 67
status, 105

Logging
media, 98
parameters, 98
start button, 71
stop button, 71

Logging selections, status, 106

Login, 8

Logout, 91

Longitude, status, 109

M
Manual Control, 140

Maximize, 75

Maximize all, 75

Maximum depth, setting, 116

Message field, BIST, 146

Minimize, 74

Minimize all, 75

Minimum depth, setting, 116

N
New operator, 77

Normal incidence backscatter, status, 103

O
Oblique backscatter, status, 103

Off--- line, 6

On--- line, 6

Operation, File Admin, 81

Operational procedures, 6

Operator, identification, 77

Operator layout, 92

Operator Station, launchpad field, 67

P
Parity, 128

Password, changing, 25

Ping no
counter, 105
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status, 105

Ping rate, status, 105

Pinging
off button, 71
start button, 71

Pitch, status, 108

Position delay, 26

Position quality, status, 109

Power, switch, 8

Power Admin, 91

Print, BIST message field, 146

Print/View, 85

Probe depth, status, 109

Programs, status, 107

Q
Quality, position, 109

R
Range capability, 355

Raw data, disk space monitor, 67

Raw to disk, status, 106

Read default layout, 92

Read factory default layout, 92

Read operator’s layout, 92

Red border, 107

Reset, BIST message field, 146

Restore complete tape, 82

Restore files, 82

Restore layout, 75

Restore source, 83

Restore tape, 83

Restore tape TOC, 83

Roll, status, 108

Runtime menu, 113

Runtime setup, View, 85

S
Seabed Viewer, Purpose, 313

Sensor, offsets, 27

Sensor Audio Alarm, 97

Sensor data, status, 108

Sensor inputs, status, 109

Sensors
launchpad field, 70
status, 108

Serial line
baud rate, 128
input formats, 128
parity, 128
stop bits, 128

Serial line --- data bits, 128

Serial lines, 149

Show Line Statistics, 97

Simulator, 143
start button, 71

Smart SV&P Probe, 154

Software
initialization, 8
updates, 24

Sound Speed, 117
probe depth, 109

Sound speed, status, 105

Sound speed max offset, 96

Sound Speed Profile, selector, 117

Sound speed, calculating, 363

Sounder active, status, 104

Sounder inactive, status, 104

Sounder Main, 114

Sounder mode, status, 104

Status, Operator Station, 67

Status Display, 103
Echo sounder, 103
Operator Station, 105

Stop bits, 128

Storage Location, 89

Subscriber, 99

Survey, launchpad field, 76

Survey Data, disk space monitor, 67
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Survey file, View, 86
Survey format to disk, status, 106
Survey logfile, view, 86
Survey name, 76
Survey parameters, view, 86
Survey Predefined Setups, 76
Survey Setup, procedure, 15
Swath width, status, 105
Synchronize clock, 76
System, status, 107
System status, 104
System test, 145

T
Tape

File Admin, 83
list, 83
restore, 82, 83
restore source, 83
terminate operation, 83
TOC, 83

Terminate, 75
Terminate tape operation, 83
Tide, status, 109
Time, status, 108
Transceiver Unit, interfaces, 27
TRU OK, status, 104
TX Power Attenuation, status, 104

U
Use current, 74
User Preferences, 96

Lat/Long Display Format, 96

V
View

Installation setup, 85
Line parameters, 86
Line statistics, 86
Runtime setup, 85
Survey file, 86

Survey logfile, 86
Survey parameters, 86

W
Window layout, 92

Workspace, 72
launchpad field, 72

Workstation, Interfaces, 149

Write to file, BIST message field, 146
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